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WARNING

To REDUCE THE RISK OF FIRE OR ELECTRIC
SHOCK DO NOT EXPOSE THIS EQUIPMENT
TO RAIN OR MOISTURE.

Do not attempt to service the equipment. There are no
user-serviceable parts inside. Please refer all servicing to authorized
Digidesign personnel.

Any attempt to service the equipment will expose you to a risk of
shock and will void the manufacturer’s warranty.

SPECIAL WARNING REGARDING VENTILATION:

Do not install D-Command anywhere or in any way that blocks free
air flow at any time around the back panel of the unit.

SPECIAL WARNING REGARDING AMBIENT TEMPERATURE:

Before powering on the D-Command unit, be sure to allow it to reach
room temperature. The unit includes some components that are
senstive to cold temperatures, so it is recommended that you
unpack the unit and allow it to acclimate before turning it on for the
first time.






Contents

Part | Introduction

Chapter 1. Introduction to D-Command . . ... .. .. ... .. . . . . . . 3
D-Command Features . . . . . . . .. .. ... e e e e e e 3
D-Command System CompPONENtS. . . . . .. ...ttt e et e e e e e e e e 3
System EXpansion OptioNns . . . . .. ... e e e e e e e 3
Operational RequIremMeNnts . . . . . ... ... e e e e e e e 4
Connection ReqUITEMENtS . . . . . ... .. e e e e e e e e 4
System ReqUIrEMENES . . . . . . . e e e e e e e 4
Mechanical Specifications . . . . . .. ... . e e e e e e 5

Chapter 2. D-Command OVervieW. . .. ... ... .. . 7
D-Command Main Unit. . . . . . ... e e e e 7
D-Command Fader Module. . . . . .. ... e 10
D-Command XMON Interface . . . . . ... ... et e e e e e e e e e e 11

Part Il Installation

Chapter 3. Setting Up the Fader Module . . . ......... .. ... .. .. . . . . e 15
Assembling an Expanded System . . . . . . . .. e e e e 15

Chapter 4. Connecting D-Command . . ... ... ... . .. . . . . 17
D-Command CONNECLIONS. . . . . . . .. .ottt e e e e e e e e e e e e e e 17
Audio CONNECIONS . . . . . ..t e e e e e e e e e 19

Chapter 5. Configuring D-Command . . ... ... ... .. . . . . . . 23
Starting Up and Shutting Down the System . . . . . . ... . . . e e e 23
Software Configuration . . . ... ... . ... e e e e e 23
Setting D-Command PreferenCes . . . . .. . it e e e e e e e e 24
System Calibration . .. ... ... . e e e e 28

Part 1l Reference

Chapter 6. Channel Strip Controls. . . ... . .. . . 31
Channel StriPS . . . .. o e e e e e e 31
Global Controls Section . . . . . . . .. . e e 38
Miscellaneous CONtrols . . . . . .. .. .. e e 45

Contents v



Chapter 7. Plug-in Controls. . .. ... ... .. . . 49

Plug-ins and D-Command . . . . . ... ... e e e e e e e e 49
DYNamIiCs SECtION. . . . . . .. e e e e e e e e e e e 53
EQ SeCltioN. . . . . . e e e e e e e e e e e e e e e 60
Chapter 8. Transport and Navigation Controls. . . ....... ... ... ... .. . . . . . . . . . . . 67
TranspPOrt SECHION . . . . . .. e e e e e e e e e 67
Zoom/Navigate SeCtioN . . . .. ... ... e e e e e 72
Nudge/Bank SeCtion . . . . .. ... . e e e e e e 72
Chapter 9. Management Sections . ........ .. .. .. .. . . . . 73
Window Management SeCtion . . . . . .. ... it e e e e e e 73
Session Management SeCtioNn . . . . . .. ... e e e e e e 74
Soft KEYS S CtION . . . . o o e e e e e e e 75
Chapter 10. Monitor and Meter Sections . . . ... ... .. ... . . e 85
Monitor Section Controls. . . . .. .. ... e 85
Meter and Time Code Displays (Main Unit) . . . . .. ... .. e e e e e e e e e e e e e 93
Setting D-Command Meters for Different Reference Levels. . . . . . ... .. .. i e e e et e e 94
Chapter 11. Operating Modes . . ... ... .. . 95
Normal Mode. . . . .. e e 95
Custom Fader Modes . . . . ... ... e e e 100
Working with Automation . . . . .. ... .. e e e e e 107
Appendix A. Utility Mode. . ... ... ... 111
Entering Utility MOde. . . . . . . .. o e e e e e e e 111
Navigating Utility Mode . . . . . .. ..t e e e e e e e e 111
EXiting Utility Mode. . . . .. .. e e e e e 112
D-Command System INfo Page . . . . .. ... . e e e e e e 112
D-Command Name Page. . . . .. .. ... i e e e e e e e 112
D-Command Test Pages . . . . .. ..ottt e e e 113
Resetting D-Command to Factory Defaults . . . ... ... .. e e e e 116
D-Command Preferences . . . .. ... ... ... e e 116
Appendix B. Audio Connections and Pinouts . . ........ ... ... ... ... . ... .. . . ... 119
25-Pin Female Connector PINOUtS . . . . . ... ... . e 119
15-Pin Connector PiNOULS . . . . . . .. o e 121

vi Tech Pubs Style Guide



Part I: Introduction







Chapter 1: Introduction to D-Command

Welcome to the D-Command™ worksurface for Digidesign®
ICON systems.

D-Command provides hands-on control of Pro Tools®, and
offers powerful options for customizing the Pro Tools mix
environment.

D-Command Features

The D-Command system provides controls for most Pro Tools
recording, editing and mixing tasks, and a versatile re-
mote-controlled audio monitoring system.

Control Features
¢ Touch-sensitive, motorized 100mm faders
¢ Touch-sensitive, multi-purpose rotary controls

e Dedicated controls for assignment and activation of inputs,
outputs, inserts and sends

¢ Flexible display of pan, insert, send, plug-in and mic pre
controls

¢ Dedicated EQ and dynamics plug-in control sections

e Dedicated controls for all channel strip functions including
recording and input monitoring modes, mute, solo, and
channel select

¢ Dedicated controls for automation mode, enable and safe
status

e Custom Fader Mode for flexible channel and parameter
mapping

e Full transport and navigation controls, including location
commands and scrub/shuttle capability

Monitoring Features

e 6-channel control room monitoring system supports mono
through 5.1 surround monitoring, with up to 5 possible in-
put sources and 3 selectable output paths

e 2-channel cue system with 4 separate outputs and selectable
talkback feed

e Built-in talkback microphone and external talkback mic
input

e Standalone mode for monitoring without Pro Tools

¢ External source metering

D-Command System Components

The following components are included in a D-Command
8-channel or 24-channel system:

Main Unit

e D-Command Main Unit
e AC power cord
¢ Ethernet cable

e Ethernet “crossover” cable (for direct connection to CPU
without a hub)

e Ethernet loopback plug (for Ethernet testing)
* 9/64-inch hex driver (for removing side panels)

e 5/32-inch hex driver (for connecting Main Unit and
Fader Module)

Fader Module
(Required for 24-Channel System)

e D-Command Fader Module unit
e AC power cord
e Ethernet cable

XMON Monitoring System
e XMON Interface

e AC power cord
¢ XMON cable

System Expansion Options

An additional 16-channel Fader Module can be added to
D-Command, for a total of 24 faders. For details on
D-Command expansion and customization options, visit the
Digidesign website (www.digidesign.com).
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Operational Requirements

Temperature and Ventilation

D-Command should be installed and operated in a cli-
mate-controlled environment, away from heat sources, and
with adequate ventilation. D-Command should be operated at
an ambient temperature that does not exceed 100 degrees F
(35 degrees C).

The back panel and the front half of the bottom panel of each
unit should be exposed to ambient air. Blocking or partially
blocking the back panel or bottom panel of a D-Command
unit may cause the unit to malfunction and may void your
warranty.

Water and Moisture

D-Command units should be operated away from sources of
moisture or humidity and should be protected from liquid
spills.

Cleaning and Maintenance

If you need to clean the D-Command top surface, apply a
non-chlorine bleach based cleaning solution to a cloth or
paper towel, then carefully wipe the surface. Do not use
abrasives, cleaning solutions with chlorine bleach, or spray
cleaners.
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Connection Requirements

Power Connections

Each unit (D-Command Main Unit, Fader Module, and
XMON Monitor Interface) requires its own power connection.

Make sure your power source is correctly rated for the number
of units you are connecting. A surge protected power source
(not included) is highly recommended.

Ethernet Connections

Each D-Command unit communicates with Pro Tools using
Ethernet. A single Main Unit can be connected to the host
computer without an Ethernet hub. To connect multiple
D-Command units to the host computer, an Ethernet hub
(not included) is required.

Audio Connections

All external analog audio inputs and outputs for control room
monitoring and studio communication are connected to the
XMON interface. D-Command connects to the XMON inter-
face with a single 15-pin cable (included). All analog inputs
and outputs on the XMON use DB-25 connectors.

Audio Cables for D-Command Monitoring

Digidesign offers a range of DigiSnake cabling options for con-
necting Digidesign interfaces and external sources to the
XMON monitoring system. For details, visit the Digidesign
website (www.digidesign.com).

System Requirements

D-Command requires the following system components:

e Pro Tools|HD® system (which includes at least one
Pro Tools|HD audio interface)

An expanded Pro Tools|HD system is required for higher track
counts.

For complete system requirements, visit the Digidesign
website (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and provide support
for hardware and software it has tested and approved.

For a list of Digidesign-qualified computers, operating sys-
tems, and third-party devices, visit the Digidesign website
(www.digidesign.com).



Mechanical Specifications
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Chapter 2: D-Command Overview

D-Command Main Unit

Main Unit Top Panel

Talkback Microphone  Main Time Scale display

Meter
section

Miscellaneous
controls
Rotary Encoder
section
Channel Strip
Display controls
Channel Strip
Mode controls =
| Soft Keys
section
Session
= Management
Channel =~ section
faders =
z ‘ mpo o - | Zoom/Navigation
” Section section
keys -

Global Automation Mode  Custom Fader Window Nudge/Bank
controls controls controls Management section
section

Figure 1. D-Command Main Unit top panel
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Meter Display

The Meter display on the D-Command Main Unit can be set to
show the output levels, or levels associated with a track or
plug-in. See “Meter and Time Code Displays (Main Unit)” on
page 93.

Main Time Scale Display and Location Indicator

The Main Time Scale display and Location indicator mirrors
the Main Time Scale in Pro Tools. See “Meter and Time Code
Displays (Main Unit)” on page 93.

Dynamics and EQ Sections

The D-Command Main Unit provides dedicated Dynamics
and EQ sections for plug-ins that support Dynamics and EQ

plug-in mapping. See “Plug-ins and D-Command” on page 49.

Monitor Section

The Monitor section on the D-Command Main Unit includes
a full set of controls for the control room, headphone/cue,
and talkback/listenback sections of D-Command. See “Moni-
tor Section Controls” on page 85.

Zoom/Navigation Section

The Zoom/Navigate section on the D-Command Main Unit is
used to control navigation, display, and selections in the

Pro Tools Edit window. See “Zoom/Navigate Section” on
page 72.

Nudge/Bank Section

The Nudge/Bank section on the D-Command Main Unit is
used to control the display of Pro Tools tracks on the control
surface. See “Nudge/Bank Section” on page 72.

Window Management and Session Management
Sections

The Window Management and Session Management sections
on the D-Command Main Unit include controls for opening
and closing Pro Tools windows, and managing and saving
Pro Tools sessions. See “Window Management Section” on
page 73 and “Session Management Section” on page 74.
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Soft Keys Section

The Soft Keys section on the D-Command Main Unit provides
access to a wide range of Pro Tools commands directly from
the control surface. It also provides access to preferences and
settings specific to D-Command. See “Soft Keys Section” on
page 73.

Transport Section

The Transport section on the D-Command Main Unit in-
cludes a full set of transport controls, switches for setting the
transport mode, scrub/shuttle controls, as well as advanced
audition and locate controls. See “Transport Section” on
page 67.

Global Controls

The Global controls are a set of channel-related controls in the
center of the D-Command Main Unit, allowing easy access to
powerful assignment, display, and channel function controls.
See “Global Controls Section” on page 38.

Custom Fader Controls

The Custom Fader mode switches on the D-Command Main
Unit invoke a special set of D-Command modes, called Custom
Fader modes, which let you set aside and customize channel
strips for display and editing of a variety of functions. See
“Custom Fader Controls” on page 42.

Automation Mode Controls

The Automation Mode controls mirror the function of the
on-screen Automation Mode selector for each track, and let
you change automation modes during playback. See “Auto-
mation Mode Controls” on page 44.



Main Unit Back Panel

Power switch

—I‘-

o

AC Power

Figure 2. D-Command Main Unit back panel connectors

AC Power

The AC Power connector accepts a standard AC power cable.
The D-Command Main Unit is auto power-selecting (100V to
240V) and automatically works with a standard modular
power cord when connected to an AC receptacle in any
country.

Power Switch
The Power switch applies power to the D-Command Main
Unit.

Footswitch Jack

The footswitch jack on the back panel of the D-Command
Main Unit is a 1/4-inch TRS jack that supports two footswitch
connections. See “Footswitch Connections” on page 18.

XMON Monitoring System

Footswitch jack
connector

Ethernet connector

Ethernet Connector

The Ethernet connector on the back panel of the D-Command
Main Unit provides communication to Pro Tools. See “Ether-
net Connections” on page 17.

XMON Monitoring System Connector

The 15-pin connector on the back panel of the D-Command
Main Unit provides remote control of all audio monitoring
functions from the D-Command Monitoring section. See
“XMON Monitoring System Connection” on page 19.
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D-Command Fader Module

Fader Module Top Panel

Meter
section

Rotary Encoder
section

Channel Strip
Mode controls

Channel Strip
Function controls

Channel Strip

Channel faders

Modifier keys

Figure 3. D-Command Fader Module top panel

Meter Section

The Meter section on the D-Command Fader Module can dis-

play track levels, plug-in meters, and other parameters de-
pending on D-Command metering preferences.

Channel Strip

Each channel strip on the D-Command Fader Module has
identical channel controls, including two touch-sensitive ro-
tary encoders, display and mode controls, and a touch-sensi-
tive fader. See “Channel Strips” on page 31.

Modifier Keys

Each D-Command Fader Module has a set of four switches in
its lower left corner that duplicate the function of the

Pro Tools computer keyboard modifiers. See “Modifier Key
Switches” on page 37.
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Fader Module Back Panel

AC Power

The AC Power connector accepts a standard AC power cable.
The D-Command Fader Module is auto power-selecting (100V
to 240V) and automatically works with a standard modular
power cord when connected to an AC receptacle in any
country.

Power Switch

The Power switch applies power to the Fader Module.

Ethernet Connector

The Ethernet connector on the back panel of the D-Command
Fader Module provides communication to Pro Tools. See
“Ethernet Connections” on page 17.



D-Command XMON Interface

D-Command monitoring is based on the XMON analog interface, which is remotely controlled from the D-Command
monitoring section.

XMON Front Panel

@ WUTE ALL
MUTE 0 DI RX

| i

Power
switch

q
\ digidesign

Mute MIDI Receive
indicator indicator

Mute button

Figure 4. XMON front panel

Power Switch MIDI Receive Indicator

The Power switch applies power to the XMON Interface. The MIDI Receive indicator shows MIDI activity between
XMON and D-Command.

Mute Indicator

Mute Button
The Mute indicator shows the mute status of XMON.

The Mute button mutes all XMON outputs. It is not possible
to unmute XMON with this button. The XMON mute state
can only be cleared from the D-Command Monitor section
(see “Monitor Section Controls” on page 85).
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XMON Back Panel

The back panel of the XMON interface includes connectors for all external analog audio inputs and outputs for D-Command. See

“Audio Connections” on page 19.

Cue Inputs Main Inputs Surround Inputs Stereo Inputs

STERE(| INPUTS

cuE I[iputs MAIN [VPUTS SURROUI|D INPUTS

C ) N e P Lo )P Dasgiaesion T T

SERAL WUMBER

C([( AAAAAAAAAAAAA )])3 C([( AAAAAAAAAAAAA )])3 C([( AAAAAAAAAAAAA )])3 C([( ............. )J)D @ é é é é é é é @

Cue Outputs Main Outputs Alt Outputs Talkback/ Meter Calibration ~ Control Surface AC Power
Listenback/ Screws
Utility

Figure 5. XMON back panel

12 D-Command Guide



Part II: Installation







Chapter 3: Setting Up the Fader Module

This chapter explains how to add the Fader Module to the
D-Command Main Unit.

Placement of D-Command Fader Module

When placing the D-Command Fader Module in studio furni-
ture or on a table top, make sure to account for the dimen-
sions of the assembled system, allowing for at least 1 inch
(2.5 cm) of open space behind the finished unit. This meets
the ventilation requirements for the D-Command units.

When bracketing together your system, you will need addi-
tional clearance on either side of the unit to push the Fader
Module and the Main Unit together, as well as sufficient clear-
ance in front and behind the units to allow you to attach the
brackets. You will also need access to the rear of the unit to
make cable connections.

The Fader Module is designed to be attached to the left of the
D-Command Main Unit.

Assembling an Expanded System

The D-Command Main Unit can be attached to the D-Com-
mand Fader Module, using the front, middle, and rear brack-
ets included with the D-Command Fader Module.

R s

Front bracket Center bracket Rear bracket

Figure 1. D-Command with Fade Module (bottom view)

Assembly Hardware

The following hardware is provided with the D-Command
Fader Module (spare pieces may be included).

Brackets
¢ Front Bracket
e Center Bracket
e Rear Bracket

942013869
02-0% Mass

Front bracket Center bracket Rear bracket

Figure 2. D-Command expanded system connecting brackets

Screws

e (10) 10-32 x 3/4-inch socket cap screw
® (4) 6-32 x 3/8-inch Pnilips pan head screw

6-32 x 3/8-inch
Philips pan head screw

10-32 x 3/4-inch
socket cap screw

Figure 3. Screws for D-Command connecting brackets
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Attaching the Units

To attach the D-Command Fader Module to the Main Unit:

1 Remove the plastic end cap from the left end of the Main
Unit.

2 Place the Fader Module to the left of the Main Unit, and
press the D-Command units together.

3 Slide both units forward far enough to have complete access
to the front bracket screw holes.

4 Attach the front bracket, using four 10-32 3/4-inch socket
cap screws.

A When bracketing together a D-Command system, leave all
screws on the Fader Module loose enough to allow you to ad-
just the position of the units relative to each other. After all
three brackets are installed, and the units are pressed fully
together, you will fully tighten the Fader Module screws.

5 Slide the connected units backwards far enough to have
complete access to the rear screws.

6 Remove the four Philips head screws indicated in Figure 4.

Remove screws

Figure 4. Rear view of D-Command and Fader Module

7 Attach the rear bracket, using four 10-32 3/4-inch socket cap
screws and four 6-32 x 3/8-inch Philips pan head screws.

8 Carefully slide the connected units forwards far enough to
have complete access to the center bracket screw holes.

9 Attach the center bracket, using two 10-32 3/4-inch socket
cap screws.

10 Press the D-Command units together. If necessary, use a
ratcheting nylon strap to press the units together by running
the strap around the two units. Make sure the nylon strap does
not contact any switches or encoders on the surface.

11 Tighten the bracket screws on the Fader Module.

12 Attach the plastic end cap to the Fader Module.

16 D-Command Guide



Chapter 4: Connecting D-Command

D-Command Connections

D-Command units require power and Ethernet connections to operate with Pro Tools. An optional footswitch connection is also
available on the Main Unit. The connectors on the back panel of the D-Command Main Unit are shown in Figure 5.

Be sure to make all connections with your D-Command units and computer turned off.

Ethernet connector

Footswitch jack ‘ @ o B ©W XMON Monitoring System connector

Figure 5. D-Command Main Unit back panel connectors

Power Connections Ethernet Connections
Each D-Command unit (Main Unit and Fader Module) and Each D-Command unit communicates with Pro Tools using
the XMON Monitor Interface requires its own power connec- Ethernet. An Ethernet cable is included with each D-Com-

tion. D-Command Main Units, Fader Modules, and XMON In- mand unit.

terfaces are auto power-selecting (100V to 240V) and automat-

ically work with a standard modular power cord when If you are connecting only one D-Command unit to your computer:
connected to an AC receptacle in any country. A power cable
is provided with each D-Command unit and the XMON
interface.

1 Connect one end of the supplied Ethernet cable to the
Ethernet port on the back panel of D-Command.

2 Connect the other end of the cable to the appropriate Ether-
To make D-Command power connections: net port on the computer.
» For each D-Command unit and the XMON Interface, con-

nect the included AC power cord the unit and to a power
source.

If you are connecting more than one D-Command unit to your
computer:

1 Install an Ethernet hub (not included) according to its in-
structions, apply power to it, and verify that it is functioning

propetly.

2 Connect the Ethernet hub to the Ethernet port on your
computer.

3 For each D-Command unit, connect one end of the supplied
Ethernet cable to a port on the Ethernet hub (do not use any
port labeled for LAN connection), and connect the other end
of the Ethernet cable to the Ethernet port on the back of the
unit.
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Using D-Command on an Ethernet Network

You can purchase a combined 10/100-BaseT Ethernet hub that
can simultaneously support D-Command over 10-BaseT and
other network traffic over 100-BaseT. This will let you use
D-Command over a local area network.

Moderate network traffic (such as e-mail) should not affect
communication between D-Command and the computer. If
your network experiences heavy traffic, you may want to cre-
ate a dedicated Ethernet network for D-Command.

Controlling Pro Tools Systems Over a Network

When D-Command is connected to an Ethernet network, it
will be available to be declared by any Pro Tools system on
that network. This lets you control different Pro Tools systems
on the network with a single D-Command console. (You can
only control one Pro Tools system at a time.)

Footswitch Connections

You can connect two SPST (single-pole, single-throw) foot-
switch units to the D-Command Main Unit to control any of
the following functions:

e Starting and stopping Pro Tools playback
e Starting Pro Tools recording

e Toggling Talkback on and off

The footswitch connector is a single 1/4-inch TRS jack on the
back panel of the D-Command Main Unit.

To wire a TRS connector for the D-Command footswitch jack:

= Use the following wiring convention: Tip = Footswitch 1,
Ring = Footswitch 2, Sleeve = Ground.
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Audio Connections

D-Command monitoring is based on the XMON analog interface, which is remotely controlled from the D-Command monitor-
ing section. All external analog audio inputs and outputs for control room monitoring and studio communication are connected
to the XMON interface.

XMON provides 18V phantom for its three external mic inputs (External Talkback Mic, Listen Mic 1, Listen Mic 2).

All audio connections are made with standard DB-25 connectors. The back panel of the XMON is shown in Figure 6.

Cue Inputs Main Inputs Surround Inputs Stereo Inputs
cue ifiputs AN [veuTs SuRROUI|D INPUTS steneq| inpuTs
C([( ‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘ )])D c([( ......................... )]):) C([( ......................... )])3 9d_igidesign Iy

nnnnnnnnnnn

ACIO020150.60HZ, 54 45W

T T T TP possssos X @

Cue Outputs Main Outputs Alt Outputs Talkback/ Meter Calibration Control Surface AC Power
Listenback/ Screws
Utility

Figure 6. XMON back panel

XMON Monitoring System Connection

D-Command connects to XMON with a single 15-pin XMON cable. A 50-foot (15.25 m) cable is included with the D-Command
Main Unit. The system supports up to an 80-foot (24.5 m) cable.

To connect the XMON to D-Command:

1 Connect the included AC power cord to the back panel of the XMON and to a power source. A surge protected power source
is highly recommended.

2 Connect one end of the included XMON cable to the Control Surface port on your XMON unit, and the other end to the 15-pin
XMON Monitoring System connector on the back panel of the D-Command Unit.
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Control Room Monitoring Connections

AFL/PFL
Input
(2 channels)

Main
Input
(6 channels)

Surround
Input
(6 channels)

Stereo 1
Input
(2 channels)

Stereo 2
Input
(2 channels)

Stereo 3
Input
(2 channels)

Listen
Mic 1

Listen
Mic 2

AFL/PFL Pro Tools
Solo
Level $5 / Command
o
1
1
1
| === =s=mag 1
1 1 1
1 1 1
' 1 1
’—,—/‘- ' '
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
1 1 1
P_I_/.- 1 1
1 1 1
1 1 1
1 1 1
1 1 1
' : : Level, Dim,
, . 1 Solo, Mute,
La ! Trim + Cal
' : : -
1 1
: *—0 Mono
: Summing
}—;—/.—

Control Room '

Output Select

Figure 7. Control room monitoring system block diagram

Inputs

e Main Inputs (6 channels), balanced, +4 dBu (from Pro Tools)

e Surround Inputs (6 channels), balanced, +4 dBu

e Stereo 1 Inputs (2 channels), balanced, +4 dBu/-10dBV

e Stereo 2 Inputs (2 channels), balanced, +4 dBu/-10dBV

e Stereo 3 Inputs (2 channels), balanced, +4 dBu/-10dBV

e AFL/PFL Inputs (2 channels), balanced, +4 dBu

e Listen Mic 1 (external), mic level (XMON provides 18V phantom power)

e Listen Mic 2 (external), mic level (XMON provides 18V phantom power)

Outputs

¢ Main Control

Room Outputs (6 channels), balanced or unbalanced, +4 dBu

e Alt Control Room Outputs (6 channels), balanced or unbalanced, +4 dBu

e Mini Control Room Outputs (2 channels), balanced or unbalanced, +4 dBu
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Headphone/Cue System Connections

Main Monitor

Input %
(2 channels)
[from Control Room System]
Cue 1 % ——
Input } ®
(2 channels)
Cue 2 %]
Input } O
(2 channels)
—e
:&._
—0
Internal -
Talkback
Internal Level
Talkback }7%2
Talkback
Input switch
External 1
Talkback —— o
External Level
Talkback
Input

Talkback/Slate Out

(1 channel)

Cue 1 Out
(2 channels)

Cue 2 Out
(2 channels)

HP Out
(2 channels)

Studio LS
(2 channels)

Talkback
Assign

Figure 8. Headphone/Cue system block diagram

Inputs

e Main Monitor Input (2 channels)

e Cue 1 Input (2 channels), balanced, +4 dBu

e Cue 2 Input (2 channels), balanced, +4 dBu

¢ Internal Talkback Mic (from internal mic)

e External Talkback Mic, mic level (XMON provides 18V phantom power)

Outputs

e Cue 1 (2 channels), +4 dBu
e Cue 2 (2 channels), +4 dBu

e Headphone (2 channels), to internal headphone jack

e Studio Loudspeaker (2 channels)

Talkback/Slate Output (1 channel)

YU 7Y

Chapter 4: Connecting D-Command 21



Example XMON Wiring Diagram

The following diagram shows basic XMON connections for a Pro Tools|HD system with a Digidesign 192 I/O with 16 analog out-
puts (with a 192 AD card installed).

ANALOG INPUT DIGITAL /0
+4 dBu BALANCED. 10 dBY BALANCED.

AES/EBU VO TOIF VO ADAT  ADAT

[O]0)

0000000000000 00O

192 1/0 W B % 2 3 e s s e e A TR m s
ANALOG OUTPUT T ANALOG OUTPUT s
©00POOOOPOOOOOOO|(|0OOOOOOPOOOOOOOO

Analog Outputs 1-8 Analog Outputs 9-16
DB-25 to DB-25
connectors

Cue Inputs Main Inputs I

CUE NPUTS MAIN NPUTS 'SURROUND INPUTS STEREO INPUTS
Daigiaesion g ff . Pp

SERIAL nUMBER

AC100:240, 50 60KZ, 5A. 45U

XMON
C(( ........... ’)3 C(( ........ ’)3 C(( 4444444444444444444444 ,)3 <( '''''''''''''''''' ’)3 |é é é é é é é él (m) @

Cue Outputs Main Outputs Alt Outputs  Talkback/Listenback

To To To To
Cue System Main Alternate Various
Amplifiers Speakers Speakers Inputs
and
Outputs
DB-25 to XLR
snakes

1-2: Studio 1=L 1=L 1 = Ext Talkback Mic Input
3-4: Cue 1 2 = (Lc*) 2 = (Lc*) 2 = Listen Mic 1 Input
5-6: Cue 2 3=C 3=C 3 = Listen Mic 2 Input
4 = (Rc*) 4 = (Rc*) 4 = AFL Input 1
5=R 5=R 5 = AFL Input 2
6=Ls 6=1Ls 6 = Mini Speaker Out 1 (L)
7=Rs 7=Rs 7 = Mini Speaker Out 2 (R)
8 =LFE 8 = LFE 8 = Talkback/Slate (Out)

* Main Speaker Outputs 2 and 4 are active on XMON, but Lc and Rc outputs cannot be controlled independently from the
D-Command monitor section. Global Volume, Solo, and Mute controls affect all outputs.

Figure 9. Wiring diagram for 192 /0 and XMON
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Chapter 5: Configuring D-Command

Starting Up and Shutting Down the
System

Your D-Command-based system must be started up and shut

down in a specific order.

Start your D-Command-based system in this order:

1 Turn on external hard drives first. Wait 10 to 15 seconds for
them to come up to speed.

2 Turn on the D-Command units.

3 If you plan to work with MIDI equipment, turn on MIDI in-
terfaces and other MIDI devices.

4 Turn on all Pro Tools audio interfaces.
5 Turn on the computer.
6 Turn on the XMON interface.

7 Turn on monitor amplifiers or self-powered speakers.

Shut down your D-Command-based system in this order:

1 Turn off monitor amplifiers or self-powered speakers.
2 Turn off the XMON interface.

3 Turn off all Pro Tools audio interfaces.

4 Shut down the computer.

5 If using MIDI equipment, turn off MIDI interfaces or con-
trollers.

6 Turn off the D-Command units.

7 Turn off external hard drives.

Software Configuration

All D-Command software is included when Pro Tools software
is installed. The Pro Tools software installer places the D-Com-
mand Personality folder on the system drive.

Refer to the Getting Started Guide that came with your system
for instructions on installing or updating Pro Tools software.

Updating System Firmware

Each release of Pro Tools software includes the most current
D-Command firmware. When you declare a D-Command unit
in the Pro Tools Peripherals dialog, Pro Tools compares the
firmware of all connected units to the version available in
Pro Tools software, and prompts you if an update is available.

If you are prompted to update firmware, follow the on-screen
instructions to load the latest firmware to each D-Command
unit.

Declaring D-Command Units in Pro Tools

Communication between D-Command and Pro Tools is con-
figured from Pro Tools.

To declare D-Command units in Pro Tools:

1 Choose Setups > Peripherals, and click Ethernet Controllers.

Peripherals

Synchronization Machine Control MIDI Controllers | Ethernet Controllers | Mic Preamps

Ethernet Port
™ Enable [eno B

€ wame Uiy
#2 Main

#3 Il | none [
#4 "nane ]
#5 [l [ none ]
#6 [ | none !
#7 [ | none |

an| A | ] (4] o] |4

a

( cancel ) (—EN(—)

Ethernet Controllers display in the Peripherals dialog

2 Select Enable. Pro Tools scans the Ethernet connection for
any Ethernet controllers connected to the system.
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3 Select the units in the order you want them arranged left to
right.

Q It is not necessary to declare units in the same sequence
" as they are physically arranged.

As each unit is selected, Pro Tools scans it and brings it online.
The current status of each unit is indicated in the Peripherals
dialog in the following ways:

¢ Bold indicates a connected unit.
e [talics indicate an offline or disconnected unit.

e Underlining indicates that the selected unit is in use by
another Pro Tools system.

4 After declaring one or both units, click OK to close the Pe-
ripherals window.

When communication is established, Pro Tools displays col-
ored outlines identifying each bank of Pro Tools tracks.

The colors in each unit row are used to identify controller fo-

cus on-screen in Pro Tools. The bank, track, insert, send, or
other element currently the focus of D-Command is outlined
in the color associated with each unit.

Naming D-Command Units in Pro Tools

You can set the names for D-Command units from Pro Tools.

To name D-Command units in Pro Tools:

1 Choose Setup > Peripherals, and click Ethernet Controllers.

2 Click Name Units.

Ethernet Controller Units

Name Ethernet Controller Units

#1  Fader

#2 Main
# none
# none
#5  none
#6  none

#7 none

(" Cancel ) ( OK )

Naming D-Command units

3 Enter the names for the units and click OK.
You can also set the names for D-Command Main Units and
Fader Modules directly from the units themselves, by using

Utility mode. For details on naming D-Command units in
Utility mode, see “D-Command Name Page” on page 112.
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Setting D-Command Preferences

This section describes the settings and preferences for D-Com-
mand that are set directly from the control surface. For details
on preferences that are set from Pro Tools, refer to the

Pro Tools Reference Guide.

Fader and Switch Preferences

The following settings and preferences affect operation of the
faders and switches on D-Command.

Fader Bank Justification

The Bank Justification preference determines whether banks
of channels in Normal mode are left-, center-, or right-justified
on the control surface.

To set bank justification:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes the Bank
Justification preference (“BnkJus”).

2 Press the Soft Key that corresponds to “BnkJus” to choose
between the “Left,” “CentrL,” “CentrR,” and “Right” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Faders On/Off

The Faders On/Off preference lets you temporarily turn off
D-Command faders to prevent fader movement when moni-
toring a mix.

To toggle D-Command faders on and off:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes the Faders
On/Off preference (“Faders”).

2 Press the Soft Key that corresponds to “Faders” to toggle all
faders on and off.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.



Touch Value

The Touch Value preference determines whether faders and
encoders, when touched, temporarily show the value of the
parameter they are controlling.

To toggle display of values on or off:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Touch
Value (“TchVal”).

2 Press the Soft Key that corresponds to “TchVal” to cycle dis-
play of all values On, all values Off or just fader values off
(“NoVol”).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Select Switch Latch Mode

The Select Switch Latch mode determines whether channel
Select buttons follow latching or non-latching (exclusive-or)
behavior when in Select mode.

To set the Select switch mode:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Select
Switch Latch mode (“Select”).

2 Press the Soft Key that corresponds to “Select” to toggle the
setting between the “Latch” and “ExclOr” (non-latching) set-
tings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Custom Fader Preferences

Custom Fader Justification

The Custom Fader Justification preference determines
whether channels in Custom Fader mode are left-, center-, or
right-justified on the control surface.

To set Custom Fader justification:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Custom
Fader Justification (“CFJus”).

2 Press the Soft Key that corresponds to “CF Jus” to choose be-
tween the “Left,” “CentrL,” “CentrR,” and “Right” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Maximum Custom Fader Bank Size

The Maximum Custom Fader Bank Size preference determines
the number of channels to be used when displaying channels
in the Custom Fader modes. Options are 4 and 8 faders for a

Main Unit, and 4, 8, 16 and 24 faders for an expanded system.

You can choose settings for each of these sizes (indicated by

the prefix “Min”) that use the minimum number of channels
necessary, so that the Custom Fader section dynamically re-

sizes to match the number of channels in the group.

To set the maximum Custom Fader bank size:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes the follow-
ing Custom Fader Bank Size preferences:

CFPlug (CF Bank Size for Plug-ins) Determines the number of
channels allocated for Custom Fader Plug-in mode.

CFGrp (CF Bank Size for Custom and Mix/Edit Groups) Deter-
mines the number of channels allocated for Custom Groups
mode.

CFTyp (CF Bank Size for Track Type) Determines the number
of channels allocated for Custom Fader Tracks mode.

2 Do one of the following:

e Toincrement the number of channel strips, press the Soft
Key that corresponds to the preference setting you want
to change.

e To decrement the number of channel strips, hold Shift

and press the Soft Key that corresponds to the preference
setting you want to change.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Display of Hidden Tracks in Custom Faders

You can set D-Command to show hidden tracks in the Cus-
tom Fader views. You can then mix those hidden tracks, but
you cannot select or record-enable them. Hidden track names
are displayed in yellow in the Custom Faders.

To make hidden tracks visible in Custom Fader views:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Custom
Fader Tracks (“CFTrks”).

2 Press the Soft Key that corresponds to “CFIrks” to toggle the
setting between Show Hidden Tracks (“ShwHdn"”) and Hide
Hidden Tracks (“HidHdn”).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.
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Custom Fader Plug-In Mode View Definition

There are three view options available for display of plug-in
parameters in the channel displays of the Custom Faders.
These options, or view definitions, are accessible from the
D-Command operation preferences.

To set the Custom Fader Plug-In Mode view:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Plug-In
View Definition (“PIDef”).

2 Repeatedly press the Soft key that corresponds to “PIDef” to
choose between the following settings for the Plug-In Mode
view:

Name View Shows the track name, plug-in name and channel
format of the currently focused plug-in in the channel dis-
plays of the Custom Faders.

Expanded View Shows additional plug-in controls in the chan-
nel displays of the Custom Faders. This view can also be seen
at any time by pressing and holding the Plug-In switch in the
Custom Fader section until the switch flashes. See “Expanded
Plug-In View” on page 105.

Fader View Maintains track names on channel displays and
fader control of track volume while Custom Fader plug-in pa-
rameters are displayed in the channel encoders. Entering Ex-
panded view or Plug-In Map mode automatically exits Fader
view.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Encoder Preferences

The following preferences affect operation of the rotary en-
coders on D-Command.

Rotary Encoder Mode

The Rotary Encoder mode affects responsiveness of rotary en-
coder knobs. Fixed mode is at normal resolution. The velocity
modes set different rates of encoder acceleration. In Fine
mode, response is fixed and at fine resolution.

To set the Rotary Encoder mode:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Rotary En-
coder mode (“Rotary”).

2 Press the upper Soft Key that corresponds to “Rotary” to step
through the “Fixed,” “Vel-S1” (velocity-sensitive, slow),
“Vel-Md"” (velocity-sensitive, medium), “Vel-Fa” (veloc-
ity-sensitive, Fast), and “Fine” settings.

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.
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Encoder Order

The Encoder Order preference determines whether inserts,
sends, and pan controls will be displayed in order from
top-to-bottom or bottom-to-top on D-Command rotary en-
coders.

To set the Encoder Order preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Encoder
Order (“Encod”).

2 Press the Soft Key that corresponds to “Encod” to toggle the
setting between “Bot-Tp” (bottom-to-top ordering) and
“Tp-Bot” (top-to-bottom ordering).

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Display Preferences

The following preferences affect the interaction of D-Com-
mand with on-screen display of elements in Pro Tools.

Target Track from Application

The Target Track from Application preference determines
whether selecting an Insert or Send on-screen makes its track
the focused track on the D-Command Main Unit. For details
on focusing a track on D-Command, see “Focusing a Track”
on page 97.

To set the Target Track from Application preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Target
Track (“ApTrgt”).

2 Press the Soft Key that corresponds to “ApTrgt” to toggle the
setting between “Yes” and “No.”

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Channel Window Display

The Channel Window display preference determines whether
displaying plug-in or send pan parameters (by pressing an en-
coder Select switch) on D-Command opens the corresponding
plug-in or send window on-screen in Pro Tools.

This preference also determines whether the Channel Select
switches in the Dynamics or EQ sections change the channel
display of multi-mono plug-ins.

¢ When this preference is set to “Yes,” the on-screen display
of plug-in and send windows changes to reflect the state of the
control surface.



¢ When this preference is set to “No,” the on-screen display of
plug-in and send windows does not change to reflect the state
of the control surface.

To set the Channel Window display preference:

1 In the Console Prefs Soft Keys section, press the Operation
switch repeatedly to display the page that includes Channel
Window (“ChanWn”).

2 Press the Soft Key that corresponds to “ChanWn” to toggle
this setting between “Yes” and “No.”

3 Hold Control (Windows) or Command (Mac) and press the
Operation switch to exit.

Meter Preferences

The following preferences affect operation of the meters on
D-Command.

Send Meters On/Off

The Send Meters On/Off preference toggles send metering on
and off. Send levels are displayed on the LED rings surround-
ing the D-Command rotary encoders. This metering follows
Send pre- or post-metering settings in Pro Tools.

To toggle send meters on and off:

1 Press the Meter switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “SndMtr” to toggle
the setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.

Insert Meter On/Off

The Insert Meters On/Off preference toggles insert metering
on and off. This preference applies when inserts are displayed
on the LED rings surrounding the D-Command rotary encod-
ers.

To toggle insert meters on and off:

1 Press the Meter switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “InsMtr” to toggle the
setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.

Meters Pre/Post Fader

The Meters Pre/Post Fader preference toggles channel meter-
ing between pre- and post-fader modes.

To toggle channel meters between pre- and post-fader metering:

1 Press the Meters switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “Meters” to toggle the
setting between “PreFad” (pre-fader metering) and “PostFd”
(post-fader metering).

3 Press the Meters Console Prefs Soft Key switch to exit.

Center Meters Track/Output

The Center Meters Track/Output preference toggles the
8-channel meter display on the Main Unit meter bridge be-
tween main output levels and the focused track.

When set to meter the focused track, you can view levels for
multichannel tracks up to 6 channels (5.1 surround).

To toggle the center meters between output and track metering:

1 Press the Meters switch in the Console Prefs Soft Keys sec-
tion.

2 Press the Soft Key that corresponds to “CtrMtr” to toggle the
setting between “Output” and “Track.”

3 Press the Meters Console Prefs Soft Key switch to exit.

VCA Slave Metering On/Off
The VCA Meters On/Off preference toggles metering of VCA

slave track levels on VCA channel rotary encoders on and off.

To toggle VCA slave track metering on and off:

1 In the Soft Keys section, press the Meter switch repeatedly to
display the page that includes the VCA Meters On/Off prefer-
ence (“VCAMtr”).

2 Press the Soft Key that corresponds to “VCAMtr” to toggle
the setting On and Off.

3 Press the Meters Console Prefs Soft Key switch to exit.
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System Calibration

Recalibrating D-Command Faders

If a fader on a D-Command Unit shows response problems,
you can recalibrate the faders with the Recal command in Util-
ity mode. See “Recal” on page 115 for details.

Calibrating the Output Meters

You can calibrate the output meters on the Main Unit meter
bridge from XMON, in order to match metering levels in

Pro Tools with metering levels of external sources. The exam-
ple below uses a Digidesign 192 I/O as the reference source.

To calibrate the D-Command output meters:

1 Set the reference level of your 192 I/O according to the in-
structions in the 192 I/O Guide.

2 With the 192 I/O analog output connected to the XMON
Main Input, send a calibration tone to the D-Command Main
Outputs, and note the output level on the D-Command
meters.

3 Disconnect the 192 I/O analog output from the XMON
Main Input and connect it to an XMON Stereo Input.

4 Activate the corresponding Alt Output.

5 Adjust the trim pots on the back panel of the XMON until
the output level for each channel on the D-Command
matches the level displayed for the Main Output.

6 When you are finished, reconnect the 192 I/O analog out-
put to the XMON Main Input.

Calibrating SPL Indication on the Monitor Section

The D-Command Monitor section lets you display output
level in dB or dB SPL. You can calibrate the SPL display to re-
flect the sound pressure level at the mix position. See “Calibra-
tion Mode Switch” on page 91.
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Chapter 6: Channel Strip Controls

Channel Strips

The D-Command Main Unit has 8 channel strips, and the
D-Command Fader Module has 16 channel strips. Each chan-
nel strip (Figure 1) has identical controls, including two
touch-sensitive rotary encoders, display and mode controls,
and a touch-sensitive fader.

ClipFiip MutePre
. )

Rotary Encoders

ClipFlip MutePre
' v

Select  BMP

()

PageDn Page Up

G)

BypMte Sends

Channel Strip
Mode controls

@O

Auto/Inpt Record

©

Sel

Solo | Channel Strip
@ Function controls

Automation Mode

an
Channel Status
indicators

Channel Fader

Figure 1. D-Command Channel Strip

Rotary Encoder Section

Each channel strip has two touch-sensitive rotary encoders
with LED ring, alphanumeric display, mode switches, and sta-
tus indicators. Rotary encoders control channel input, send,
pan, and mic pre parameters.

Encoder — — _—=15
LED ring e 2
O @ — Encoder knob
Encoder € a0 Y
Automation Mode
indicator

Encoder display

Clip/Flip indicators Mute/Pre indicators

0 0
Select switch —(D ‘\’ @ Bypass/Mute/Pre
Select BMP switch

Channel Strip Rotary Encoder
Encoder Knob

The encoder knobs on D-Command channel strips are

touch-sensitive. When you touch the encoder, the encoder
display switches from the parameter name to the parameter
value. Touch display of parameter values can be turned off.

When you are automating a parameter controlled by an en-
coder, touching the encoder knob starts writing automation.

When assigning a channel input or output, or an insert or
send, the encoder knob is used to scroll through available in-
puts, outputs, inserts, or sends.

Inputs, Outputs, Inserts and Sends

When assigning a channel input or output, or an insert or
send, the encoder knob is used to scroll through available in-
puts, outputs, inserts, or sends. When adjusting the phantom
power on a remote-controlled mic preamplifier (such as the
Digidesign PRE), the encoder knob can be used to toggle phan-
tom power on and off.

Instrument Tracks

On Instrument tracks, the bottom encoder knob is used to
control MIDI Volume.

VCA Master Tracks

On VCA Master tracks, the encoder knobs are used to control
the Volume of slave tracks.
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Encoder LED Ring

Each encoder has a ring of 15 LEDs. Discrete or stepped infor-
mation is shown by single LEDs, and continuously variable in-
formation is shown by an expanding series of LEDs.

In Normal mode, encoder LED rings can show send level, pan
position, plug-in parameter values, and mic pre settings. In
Flip mode, they show track level.

Instrument Tracks

On Instrument tracks, the bottom encoder LED ring shows
MIDI Velocity.

VCA Master Tracks

On VCA Master tracks, encoder LED rings show levels of slave
tracks.

Encoder Automation Mode Indicator

Below each encoder knob is an LED marked “auto,” which
lights when the corresponding parameter is enabled for auto-
mation. The indicator lights green for Read mode, yellow
when armed for automation in any of the Write modes, and
red when writing automation in any of the Write modes.

Encoder Display

Each encoder has a six-character display that shows parameter
names. When the corresponding encoder knob is touched or
moved, the display shows parameter values.

Encoder displays use color inversion to indicate the following:
e Green: Default color for input, insert, send, pan, and mic
pre parameter names and values
e Inverted green: Inactive input, inactive output, inactive
plug-in or inactive send names

Clip and Flip Indicators

When viewing inserts on an encoder, these LEDs light to indi-
cate the send or insert has clipped (red LED) or has been
flipped to the fader (yellow LED).

Mute and Pre Indicators

When viewing sends on an encoder, these LEDs light to indi-
cate that the send is muted (red LED) or set to pre-fader oper-
ation (green LED).

Encoder Select Switch

Each encoder has a Select switch that is used to assign an in-
sert or send to that encoder, or to display send parameters for
editing.
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Inserts

When assigning an insert, the encoder Select switch is used to
confirm the selection of the following elements on each level:
¢ Insert type (TDM plug-in, RTAS plug-in, Multi-Mono
TDM plug-in, Multi-Mono RTAS plug-in, or Hardware
Insert)
e Plug-in subfolder (such as EQ, Dynamics, Pitch Shift,
Reverb, or Delay)
¢ Individual insert or plug-in

Sends

When assigning a send, the encoder Select switch is used to
confirm the selection of the following:
¢ Send type (interface or bus)

e Send assignment

When viewing a send, the encoder adjusts level. In Send Pan
mode, the fader adjusts level and the encoder adjusts Pan.

VCA Master Tracks

On VCA Master tracks, encoder Select switches focus the cor-
responding slave tracks in the Focus Channel section.

Bypass/Mute/Pre Switch

Each encoder has a Bypass/Mute/Pre (B/M/P) switch whose
function depends on what is currently displayed on the en-
coder. With Sends, the function of the B/M/P switch also de-
pends on the current Switch Mode setting.

See “Switch Mode Switch” on page 40 for more information
on changing the Switch mode and viewing the current func-
tion of the B/M/P switch.

Inserts

When a plug-in name is displayed on an encoder (in the top
level Inserts display), the B/M/P switch bypasses the corre-
sponding plug-in. The B/M/P switch lights when the plug-in is
bypassed.

Sends

When a send name is displayed on an encoder, the B/M/P
switch does one of the following:

e [f the Switch Mode is set to Mute, the B/M/P switch
mutes the corresponding send. The red Mute LED lights
to indicate that the send is muted.

e If the Switch Mode is set to Pre, the B/M/P switch toggles
the corresponding send between pre- and post-fader op-
eration. The green Pre LED lights to indicate that the
send is set for pre-fader operation.



Mic Pre

In Mic Pre mode, mic pre parameters are displayed on a chan-
nel strip’s encoders. In addition, the B/M/P switches do the
following:

e Top encoder, page 1: toggles phantom power on and off
e Bottom encoder page 1: toggles mic pre Pad on and off
e Top encoder, page 2: toggles mic pre HPF on and off

e Bottom encoder page 2: toggles mic pre Polarity

e Top encoder, page 3: toggles phantom power on and off

e Bottom encoder, page 3: toggles mic pre Insert on and off

Instrument Tracks

On Instrument Tracks, the bottom B/M/P switch is used to
control MIDI Mute state.

VCA Master Tracks

On VCA Master tracks, B/M/P switches are used to control the
Mute state of slave tracks.

MIDI Controls on Instrument Tracks

The Instruments View in Pro Tools contains MIDI controls
that can be displayed on the encoders of D-Command chan-
nel strips.

To display MIDI controls on an Instrument track:

= In the Channel Strip Mode controls section of the Instru-
ment channel strip, press the Inserts switch and the Sends
switch simultaneously.

The MIDI controls appear on the encoders as follows:
e Top encoder: MIDi Pan
¢ Bottom encoder: MIDI Volume
e Bottom B/M/P switch: MIDI Mute
¢ Bottom encoder LED ring: MIDI Velocity meter

To exit display of MIDI controls:

= Press another switch in the Channel Strip Mode section.

Slave Track Display on VCA Master Tracks

In normal Mode, VCA Master tracks show their slave tracks in
their rotary encoders, as follows:

¢ Encoder knob: Slave track Volume control
e Encoder LED ring: Slave track meter level
¢ Encoder B/M/P switch: Slave track mute

¢ Encoder Select switch: Focuses slave track in Focus Chan-
nel Strip

If there are more than two slave tracks for a VCA Master, you
can the press the channel Page Up/Page Down switches to dis-
play the additional slave tracks on the rotary encoders.

Channel Strip Mode Controls

Each channel strip has a set of Channel Strip Mode controls
for displaying and editing pan, plug-in, mic pre, insert, or
send parameters on the encoder section of the D-Command
channel strip.

Page Down switch —E)) ()7 Page Up switch

Page Dn Page Up

Inserts switch 7() ()7 Pan switch

Inserts Pan

Bypass/Mute [ , ‘ W sends switch
switch — =

Byp-Mute Sends

Channel Strip Mode controls

Page Up and Page Down Switches

Control parameters are arranged on channel strip rotary en-
coders in pages, or groups of up to two parameters at a time.

The Page Up and Page Down switches light to indicate the
presence of additional pages of pan, plug-in, mic pre parame-
ters, or (for VCA Master tracks) slave tracks, in the correspond-
ing direction on each channel strip. If no additional pages are
available, neither switch is lit.

To move the page display of parameters on the encoders up or
down:

= Press a lit Page Up or Page Down switch.

Inserts Switch

When you press the Inserts switch, you enter Inserts mode,
and the plug-in names for the first two plug-ins on that chan-
nel strip are displayed on the encoder displays. If there are ad-
ditional plug-ins on the channel, the channel’s Page Up
switch lights.

To open a plug-in window from any channel on D-Command:

= Hold Start (Windows) or Control (Mac) and press the Select
switch for the plug-in.

To close the plug-in window:

= Hold Start (Windows) or Control (Mac) and press the Select
switch again.

The Inserts switch flashes when a plug-in on that channel has
clipped. To clear a clip, press the Clear Clip switch in the Ses-
sion Management section. See “Clear Clip Switch and Plug-in
Clip Indicator” on page 74 for more information.
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Pan Switch

When you press the Pan switch, you enter Pan mode, and the
pan controls for the channel strip are displayed on the en-
coder displays.

If the track is a multichannel track, its Page Up switch lights to
indicate that there are multiple pages of pan controls. Multi-
channel pan controls are arranged as follows:

Surround Pan Display, Page 1

Display Pan Control
LFE LFE channel
Cntr% Center Speaker Percentage

Surround Pan Display, Page 2

Display Pan Control
F Div Front Divergence
Rear Rear Pan

Surround Pan Display, Page 3

Display Pan Control
F/R Front/Rear Balance
Front Front Pan

Surround Pan Display, Page 4

Display Pan Control
R Div Rear Divergence
Rear Rear Pan

Surround Pan Display, Page 5

Display Pan Control
F/R Div Front/Rear Divergence
F/R Front/Rear Balance

Surround Pan Display, Page 6

Display Pan Control
F Div Front Divergence
Front Front Pan
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To open/close the Output window on-screen for a track:

1 Press the Pan switch on the channel.

2 Hold Start (Windows) or Control (Mac) and press the chan-
nel’s encoder switch.

Two-Knob Surround Panning

When working in surround, you can link the front and rear
pan controls on D-Command to facilitate X-axis motion in
the sound field.

To link front and rear surround panners:

1 Press the Operation switch in Console Prefs section until
“2KbPan” appears in the Soft Keys.

2 Press the Soft Key that corresponds to “2KbPan” to toggle
the preference on or off.

Mic Pre Mode

When you press a channel strip’s Inserts switch and Pan
switch simultaneously, you enter Mic Pre mode. In Mic Pre
mode, the controls for an available remote-controlled micro-
phone preamplifier (such as the Digidesign PRE) are displayed
on the channel strip’s rotary encoders for editing. The Page Up
switch lights to indicate more available parameter pages.

Microphone preamplifiers are declared in the Pro Tools pe-
ripherals dialog, and assigned to channels in the Pro Tools I/O
Setup dialog.

Bypass/Mute Switch

The function of the Bypass/Mute switch depends on what is
currently displayed on the channel strip’s encoders.

Inserts

< In the top level Inserts view (when plug-in names are dis-
played on a channel strip’s encoders), the Bypass/Mute switch
bypasses all plug-ins on that channel.

Sends

# In the top level Sends view (when send names are displayed
on a channel strip’s encoders), the Bypass/Mute switch mutes
all sends on that channel.

VCA Master Tracks

¢ On VCA Master tracks, the Bypass/Mute switch uses
Mix/Edit Groups mode to display (or “spill”) the slave tracks
for the VCA in Custom Faders.



Sends Switch

When you press the Sends switch, you enter Sends mode, and
the send names for the first two sends on that channel strip
are displayed on the encoder displays. If there are additional
sends on the channel, the channel’s Page Up switch lights.
The 10 available sends are displayed in five pairs (A-B, C-D,
E-F, G-H, ).

Send Pan Mode

Send Pan mode allows you to adjust send panning and level at
the same time. Send Level is controlled by the channel fader
and Send Pan is controlled by the encoder.

To enter Send Pan mode:

1 Press the Sends switch to display sends on the channel'’s en-
coders.

2 Press the encoder Select switch that corresponds to the send
you want to display.

To return to the top level display of sends on the channel strip:

= Press the Sends switch again.

To link a Send’s Pan controls to the Main Pan controls of a track:

1 Put the track in Send Pan mode for the Send you want to
link.

2 Press the B/M/P switch on any of the active encoders on the
track to toggle the FMP status of the send.

Channel Strip Function Controls

Each channel strip has a set of Channel Strip Function con-

trols for controlling channel selection and focus, mute, solo,
and record enable status, input monitor mode, and automa-
tion mode.

Input Monitor Mode Record Enable
switch (‘ )) (G) switch

Auto/Inpt Record

Channel Select 7()
switch -
Sel
Solo switch
Solo
Mute switch

— <D

Mute

ok

Channel display

Automation Mode Automation Trim
switch switch

Auto Trim

Channel Strip Function controls

Input Monitor Mode Switch

The Input Monitor Mode switch toggles the input monitoring
mode for that channel between Auto Input and Input Only
mode. The switch lights when the channel is in Input Only
mode.

Record Enable Switch

The Record Enable switch toggles record enable status for the
channel. When the channel is record-enabled and the

Pro Tools transport is stopped, the switch flashes. During re-
cording, the switch lights continuously.

Record Safe Mode To record safe a track from D-Command,
hold Control (Windows) or Command (Mac) and press the
track’s Record Enable switch.

Channel Select Switch

The function of the Channel Select switch depends on the Se-
lect/Focus Mode setting. See “Select/Focus Mode Switch and
Indicators” on page 41 for more information on changing the
Select/Focus mode.

Select Mode If the Select/Focus Mode is set to Select, the
Channel Select switch selects the channel in Pro Tools. The
switch lights when the channel is selected. In this mode, the
Channel Select switch can be set to follow latching or exclu-
sive-or (non-latching) behavior.
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Focus Mode If the Select/Focus Mode is set to Focus, the Chan-
nel Select switch brings that channel’s Dynamics and EQ con-
trols into the Dynamics and EQ sections of the Main Unit for
editing. In this mode, because only one track can be focused at
a time, the Select switch follows exclusive-or (non-latching)
behavior only.

In Focus mode, if the D-Command Focus Channel Strip Oper-
ations preference is set to Yes, the Channel Select switch also
places a duplicate of the focused channel in the channel strip
to the immediate left of the Global Controls section.

Solo Switch

The Solo switch toggles solo status for the channel. When a
channel is soloed, the Solo switch lights, and the Mute
switches on other channels in the session flash to indicate im-
plicit mute. The Solo switch function follows the Pro Tools
Operation preference for latched operation.

Solo Safe Mode To solo safe a track, hold Control (Windows)
or Command (Mac) and press the track’s Solo switch.

When a track is solo safed, its Solo switch flashes once.

Mute Switch

The Mute switch toggles mute status for the channel.
¢ When a track is muted, its Mute switch lights solid.

¢ When a track is implicitly muted (when another track is so-
loed), its Mute switch flashes.

Channel Display

Each channel display shows the channel information in the
following display modes. In each mode, when the channel
fader is touched, the display shows the channel volume in dB.

Track Name Mode Shows the track name only.

Group/Name Mode Shows the group membership of the track
(by group letter) and an abbreviated track name.

Track Position Number/Name Mode Shows the track position
number and an abbreviated track name.

Headroom Mode Shows the abbreviation “HR” followed by the
remaining headroom in dB.

Level Mode Shows the track volume level in dB only.

Channel displays use colors and backlighting to indicate the
following:

¢ Green: Channel names and values

e Inverted green: Inactive channel
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Automation Mode Switch

The Automation Mode switch cycles the channel through the
Pro Tools automation modes (Write, Touch, Latch, Read and
Off). The active mode is shown by the Automation Mode LED
indicators to the left of each channel’s fader. When in Off
mode, none of the indicators is lit.

The Automation Mode switch lets you cycle the channel
through Touch, Latch, and Read modes during playback, but
it prevents you from entering Write of Off mode during play-
back. To directly enter Write or Off mode during playback, use
the Automation Mode controls in the lower left of the Main
Unit. (See “Automation Mode Controls” on page 44.)

Automation Trim Switch

The Automation Trim switch toggles the channel into the cor-
responding Trim mode for Write, Latch, Touch, and Read
modes. Active Trim mode is shown by the yellow Trim mode
LED indicator to the left of each channel’s fader. The Automa-
tion Trim switch has no effect while the channel is in Off
mode.

Fader Section

ow @
Automation Mode oTC +12

indicators o .
™| —*6  Channel
| Fader

ORD
Group Status Po_

L — N
indicator 0 GRP
Custom Fader Mode _______——®cF -5
indicator —_
A -10
AutoMatch A 4 .
indicators
15
20
-30
-40
-60
-90
oo

Channel Strip Fader section
Fader

The touch-sensitive faders on D-Command channel strips
control channel volume in Normal mode, and a wide range of
parameters in Flip mode or the Custom Fader modes. When
you touch a fader, its channel strip display changes from track
name to track volume level (in Normal mode), or from param-
eter name to parameter value (in Flip modes or Custom Fader
modes). When you are automating a parameter on a fader,
touching the fader starts writing automation.



Automation Mode Indicators

The Automation Mode indicators, located to the left of each
channel’s fader, indicate the active automation mode.

WR (Write), TC (Touch) and LT (Latch) are red LEDs; T™M
(Trim) is a yellow LED; and RD (Read) is a green LED.

¢ When in Write mode, the Write indicator flashes at all
times.

¢ When in Touch or Latch modes, the corresponding indica-
tor lights solid until automation writing begins.

¢ When a track in Latch mode is primed for writing automa-
tion, its Latch mode indicator flashes.

¢ When automation writing begins, the appropriate indicator
flashes.

# If automation is turned off for the channel (Off), none of
the indicators is lit.

Group Status Indicator

The Group Status indicator (a green LED marked GRP), located
to the left of each channel’s fader, lights to indicate that the
channel is a member of an active Mix or Edit group in

Pro Tools. If the channel is a member of an inactive group, or
if groups are suspended, this indicator is off.

Custom Fader Mode Indicator

The Custom Fader Mode indicator (a blue LED marked CF), lo-
cated to the left of each channel’s fader, lights to indicate that
the channel is currently in Custom Fader Mode.

AutoMatch Indicators

The AutoMatch indicators (green arrow-shaped LEDs), located
to the left of each channel’s fader, light to indicate the direc-
tion you need to move the fader in order to match the auto-
mation level previously written for that track. This is espe-
cially useful when editing fader automation.

Modifier Key Switches

Each D-Command Main Unit and Fader Module has a set of
four switches in its lower left corner that duplicate the func-
tion of the Pro Tools computer keyboard modifiers.

oy oy
-90 -90
=S =S

(5

(4
Shift/Shift  Cti/Ctl  Opt/Win /,

(o5 e9)

Shift Control  Start/Win (Windows) /é:lgt(Windows)

Option (Mac) (Command) (Mac)

Modifier Keys (Fader Module)
Shift Switch (Windows and Mac)

The Shift switch duplicates the function of the Shift key on
your computer keyboard.

Control Switch (Windows and Mac)

The Control switch duplicates the function of the Control key
on your computer keyboard.

Win Switch (Windows) or Option Switch (Mac)

The Win/Option switch duplicates the function of the Win-
dows key (also called the Start key) or the Option key (Mac) on
your computer keyboard.

Alt Switch (Windows) or Command Switch (Mac)

The Alt/Command switch duplicates the function of the Alt
key (Windows) or the Command key (Mac) on your computer
keyboard.

Q The order of the modifier keys on the D-Command
" reflects the order of the corresponding keys on a
Windows or Mac keyboard, from left to right.
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Global Controls Section

The Global Controls section (Figure 2) is a set of channel-re-
lated controls in the center of the D-Command Main Unit.

Flip
Auto Write

@

S Flip

Automation Write Em—————
controls @ @ switches

Flip
AutoEnable

Automation Enable @ @

Vol  Send Lvl

controls @ @

Pan_ SendPan

(D)

Mute SendMute

Switch Information

GI) controls

Solo Clear ——  Global Modifier

@ @ controls

Disp Mode Default

Susp GrpAuto Susp

Focus Channel
08

Custom Faders

Custom Fader

controls Groups| Map
(%)
Type Lock

@@

Plug-in/ Window

L Bank/Cycle

Auto Mode

Automation Mode Wite  Trim

controls © ©

Touch  Read

[ Latch Off

Talkback switch

Talkback
Dbl PresstoLatch

@)

Figure 2. Global Controls section
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Flip Switches

The two yellow Flip switches in the Global Controls section
correspond to the two rotary encoders on the D-Command
channel strips.

Flip Mode

The Flip switches invoke Flip mode, which transfers controls
from the corresponding rotary encoder to the fader on each
channel strip, allowing convenient editing and automation of
send, pan, plug-in, and mic pre parameters directly from the
channel faders.

In Flip mode, the rotary encoder control swaps with the chan-
nel fader; the encoder Select switch swaps with the channel
Select switch; the encoder Bypass/Mute/Pre switch swaps with
the channel Mute switch; and the encoder display swaps with
the channel display.

In Flip mode, the Flip switch lights for the affected row of en-
coders, and the yellow Flip LED below each affected encoder is
lit.

Instrument Tracks and Flip Mode

When MIDI controls for Instrument tracks are displayed on
the encoders, they can be transferred (or “flipped”) to the
channel faders, allowing control of MIDI Volume or MIDI Pan
from the channel faders.

In Flip mode, Instrument track controls are transferred as fol-
lows:

e The fader on each channel controls the parameter (MIDI
Volume or MIDI Pan) that was assigned to the encoder, and
the encoder controls track Volume.

¢ The channel Mute switch controls the MIDI Mute function,
and the B/M/P switch on the encoder controls channel
mute.

To transfer controls from a row of rotary encoders to the channel
faders:

= Press the Flip switch that corresponds to the encoder row.

To exit Flip mode:

= DPress a lighted Flip switch.

Q When D-Command is in Flip mode and you enter Make
Inactive mode or Assign mode, it is temporarily taken out
of Flip mode, but the Flip switch remains lit. When you
exit Make Inactive mode or Assign mode, controls return
to their flipped positions.



Automation Write Controls

The Automation Write controls invoke the manual “Write to
Start/End/All” commands, the automatic “Write to
Start/End/All on Stop” automation commands, and the
“Write to Current Parameter” and “Write to All Enabled Pa-
rameters” snapshot automation commands in Pro Tools.

Auto Write
Automation
( A Write to Start
- switch
Start

Automation . ) Write to Current
Write to All 7‘) ( ) Parameter
switch switch
All Current
Automation - ) Write to All Enabled
Write to End © ) ( D Parameters
switch switch
End  AllEnab

Automation Write controls

Start Switch

The Start switch writes the current automation value of all
write-enabled parameters to the start of a selection or track
when performing an automation pass.

To manually Write to Start:

= Press the Start switch during playback.

To enable automatic Write to Start on Stop:

= Hold the Start key (Windows) or the Control key (Mac) and
press the Start switch.

To disable automatic Write to Start on Stop:

= Press the flashing Start switch.

All Switch

The All switch writes the current automation value of all
write-enabled parameters to an entire selection or track when
performing an automation pass.

To manually Write to All:
= Press the All switch during playback.

To enable automatic Write to All on Stop:

= Hold the Start key (Windows) or the Control key (Mac) and
press the All switch.

To disable automatic Write to All on Stop:

= Press the flashing All switch.

End Switch

The End switch writes the current automation value of all
write-enabled parameters to the end of a selection or track
when performing an automation pass.

To manually Write to End:
= Press the End switch during playback.

To enable automatic Write to End on Stop:

= Hold the Start key (Windows) or the Control key (Mac) and
press the End switch.

To disable automatic Write to End on Stop:

= Press the flashing End switch.

Current Switch

The Current switch writes a snapshot of the current parameter
value to the currently displayed automation parameter.

All Enabled Switch

The All Enabled switch writes a snapshot of all current param-
eter values to all enabled automation parameters.

Automation Enable Controls

The Automation Enable controls are used to enable or suspend
writing of each type of automation on all channels. When
writing is enabled for a type of automation, its corresponding
switch is lit.

These Automation Enable controls mirror the function of the
corresponding buttons in the Pro Tools Automation Enable
window.

Auto Enable
) Enable Plug-in
( /e Automation
switch
Plug-in
Enable Volume e D) Enable Send Level
Automation ) ( Automation
switch C\ C’ switch
Vol  Send Lvl
Enable Pan Enable Send Pan

[ L)
switch @ @ switch

Automation Automation
Pan SendPan

Enable Mute o D) Enable Send Mute
Automation = ) ( — Automation
switch switch

Mute Send Mute

Automation Enable controls
Plug-in Switch

The Plug-in switch enables and suspends writing of automa-
tion for any automation-enabled plug-in parameters on all
tracks in the session.
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Volume Switch

The Volume switch enables and suspends writing of channel
volume automation on all tracks in the session.

Pan Switch

The Pan switch enables and suspends writing of channel pan
automation on all tracks in the session.

Mute Switch

The Mute switch enables and suspends writing of channel
mute automation on all tracks in the session.

Send Level Switch

The Send Level switch enables and suspends writing of send
level automation on all tracks in the session.

Send Pan Switch

The Send Pan switch enables and suspends writing of send
pan automation on all tracks in the session.

Send Mute Switch

The Send Mute switch enables and suspends writing of send
mute automation on all channels.

Switch Information Controls

The Switch Information controls are used to change the mode
and display of encoder Bypass/Mute/Pre switches, and glo-
bally show encoder parameter values.

Switch Mode switch

7Mtite @ P.re

SwMode

SwitchInfo __ | /&% b ) Show Values
switch \ b switch

Swinfo Show Val

Mute Mode
indicator

Pre-Fader Mode
indicator

Switch Information controls

Switch Mode Switch

The Switch Mode switch toggles the function of encoder By-
pass/Mute/Pre switches between Mute and Pre-Fader func-
tions when displaying sends on the encoders.

e When the Switch Mode is set to Bypass, the encoder B/M/P
switch mutes the corresponding send.

e When the Switch Mode is set to Pre, the encoder B/M/P
switch toggles the corresponding send between pre- or
post-fader operation.

A The Transport must be stopped to toggle sends between
pre- and post-fader operation.
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To set the Switch Mode:

= Press the Switch mode switch until the appropriate indica-
tor lights (Mute or Pre).

Switch Info Switch

The Switch Info switch can follow toggling or momentary be-
havior. If pressed briefly, it toggles the encoder display to
show the function assigned to the Bypass/Mute/Pre switch on
each rotary encoder. If held, the function is shown until the
switch is released.

Show Values Switch

The Show Values switch can follow toggling or momentary
behavior. If pressed briefly, it toggles the encoder display be-
tween parameter name and parameter value. If held, parame-
ter value is shown until the switch is released.

A\ The operation of the Show Values switch is not affected by
the Touch Display of Parameter Values setting in the Oper-
ations Soft Key Section.

Global Modifier Controls

The Global Modifier controls are used to change modes for the
channel Select switches, channel displays, clear Solo and Mute
states, and globally suspend automation.

@

Escape

eI Foc
Select/Focus Mode
Switch and indicators
Mode
( 2
)

Solo Clear
Do to Selected

Do to Sel Do to All
Display Mode Set to Default

switch <( )) (( )> switch

Disp Mode Default

Suspend Groups [ ) 0 Suspend Automation
switch — = W @, | Switch

Susp GrpAuto Susp

Escape switch

Solo Clear switch

Do to All switch

Global Modifier controls
Escape Switch

The Escape switch is used to exit modes and to cancel opera-
tions or on-screen dialogs. When an action has occurred that
can be exited or canceled with the Escape switch, the switch
flashes.



Select/Focus Mode Switch and Indicators

The Select/Focus Mode switch toggles the function of channel
Select switches between Select and Focus mode. The LEDs on
either side of this switch indicate the current mode.

¢ In Select mode, channel Select switches are used to select
channels in Pro Tools.

¢ In Focus mode, channel Select switches are used to focus a
channel in the Focus Channel section on the Main Unit.

Do To All and Do To Selected Switches

The Do To All and the Do To Selected switches on D-Com-
mand can be used in two different ways: to apply actions to
multiple tracks in a Pro Tools session, and to change the dis-
play mode of multiple channel strips on D-Command.

The Do To All and Do To Selected switches can follow mo-
mentary or latching behavior.

¢ When single-pressed, their effect applies only to the next
operation.

¢ When held, they apply to all operations carried out while
being held.

¢ When double-pressed, they latch on and flash until pressed
a second time.

Applying Actions to Multiple Tracks in Pro Tools

The Do To All and Do To Selected switches are convenient for
performing tasks such as muting, soloing, assigning sends, or
assigning the same plug-in across multiple tracks in a session.

To apply actions to multiple tracks in a Pro Tools Session:

1 Do one of the following:
e Press the Do To All or the Do To Selected switch to apply
the action to one parameter.
—or-
¢ Double-press the Do To All or the Do To Selected switch

to latch the corresponding action and apply it to multi-
ple parameters.

2 Press any of the following switches to apply the correspond-
ing action to all tracks or all selected tracks in the session:

e Channel Mute switch
e Channel Solo switch

e Channel Solo Safe: Control (Windows) or Command
(Mac) + Solo switch

e Automation Mode switch

e Automation Trim switch

e Channel Select switch (in Select mode)
® Record Enable switch

e Record Safe: Control (Windows) or Command (Mac) +
Record Enable switch

e Input Monitor Mode switch

3 Depending on the current channel strip display mode, you
can apply the following across all tracks or all selected tracks
in the session:

e Mic Pre Controls: Polarity, Pad, Impedance, Source, Gain
e Send Pre/Post: B/M/P switch in Send Pre/Post mode

e Send Mute: B/M/P switch in Send Mute mode

e Plug-in Bypass: B/M/P switch in Inserts mode

4 You can also carry out any of the following tasks across all
tracks or all selected tracks in the session:

e Assigning Inputs, Outputs, Inserts and Sends

e Activating/deactivating Inputs, Outputs, Inserts, Sends
and Tracks

e Resetting controls with the Set to Default switch
¢ Changing panner linkage

e Changing panner editor choice

5 When you are finished, if Do To all or Do To Selected are
latched on, press the flashing Do To All or Do To Selected
switch to exit the corresponding mode.

Changing Parameter Display on D-Command Channel Strips

The Do To All and Do To Selected switches can be used to dis-
play and edit pan, mic pre, insert, or send parameters across all
tracks or all selected tracks in a session.

The Do To All and Do To Selected switches are applied inde-
pendently to channel strips in Normal mode and Custom
Fader mode. This independent operation lets you put banks of
channels in several display modes at once (for example, pan
on channels in Normal mode, and plug-ins on channels in
Custom Fader mode).

To change the display mode of D-Command channel strips:

1 Press the Do To All or the Do To Selected switch.

2 Press any of the following Channel Strip Mode switches on
any individual channel to apply the corresponding action to
all channels or to all selected channels on D-Command:

¢ Inserts switch

e Pan switch

e Bypass/Mute switch

¢ Sends switch

e Inserts + Pan switches (Mic Pre mode)

e Inserts + Sends (Instrument mode)

Page Down switch —() ()— Page Up switch

Page Dn Page Up

Inserts switch 7() ()— Pan switch

Inserts Pan

Bypass/Mute @, ‘ D sends switch
switch = =

Byp-Mute Sends
Channel Strip Mode controls
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3 When you are finished, if Do To All or Do To Selected are
latched on, press the flashing Do To All or Do To Selected
switch to exit the corresponding mode.

Display Mode Switch

The Display Mode switch toggles the channel display between
the five display modes: Track Name, Group/ Name, Channel
Number/Name, Headroom Value, and Level modes. See
“Channel Display” on page 36 for more information.

Set To Default Switch

The Set to Default switch lets you reset parameters that are
currently visible on the D-Command surface to their default
values. This switch works in both Normal and Custom Fader
modes.

The Set to Default switch can follow momentary or latching
behavior.

¢ When single-pressed, its effect applies only to the next op-
eration.

¢ When double-pressed, it latches on and flashes until pressed

a second time.

Q You can also use the Set to Default switch to remove plug-in
" assignments from channels. See “Assign Inserts Switch” on
page 46.

While the Set to Default switch is pressed or latched on, the
following parameters can be reset:

To reset a channel’s track volume to 0 dB:
» Press Set to Default + the channel Select switch.

= Hold Alt (Windows) or Option (Mac) and touch the channel
fader.

To reset a channel’s pan control to 0 (center)

= Press Set to Default + the pan encoder Select switch.

To reset a send’s level to 0 dB:

= Press Set to Default + the send encoder Select switch. This
sets the send level to 0 dB, regardless of the Send default set-
ting in Pro Tools Operation preferences.

To reset a channel’s mic pre gain to 0 dB:

= Press Set to Default + the mic pre gain encoder Select switch

To set a plug-in’s parameters to their default values:

= Press Set to Default + the Compare switch for the plug-in.
(The Compare switch appears in the D-Command Dynamics
and EQ sections, and in Custom Fader Expanded Plug-In
view.)
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Suspend Groups Switch
The Suspend Groups switch suspends all groups in the session.

The Suspend Groups switch follows latching behavior, and
flashes to indicate groups are suspended. To exit Suspend
Groups mode, press the Suspend Groups switch again.

Automation Suspend Switch

The Automation Suspend switch suspends reading and writ-
ing of all automation on all tracks in the session. All channels
are left in their current automation mode, but automation op-
erations are temporarily suspended.

The Automation Suspend switch flashes while automation is
suspended.

Solo Clear Switch

The Solo Clear switch clears all latched Solo switches in the
session. This switch flashes when any channel is soloed.

Custom Fader Controls

The Custom Fader controls invoke a special set of D-Com-
mand modes, called Custom Fader modes, which let you set
aside and customize channel strips for display and editing of a
variety of functions. The Custom Fader modes are Groups
mode, Tracks mode, and Plug-in mode. See “Custom Fader
Modes” on page 100 for complete information on Custom
Fader modes.

Focus Channel
Custom Faders

Groups switch —() ()— Map switch

Groups . Map

Tracks switch —CQ ()7 Lock switch

Tracks = Lock

Plug-in switch 7(_) ()7 Window switch

Plug-In /Window

@17

Bank/Cycle

Focus Channel
display

Bank/Cycle switch

Custom Fader controls



Focus Channel Display

¢ When a Custom Fader mode is active, the Focus Channel
display shows the name of the Custom Group, Mix/Edit
Group, or the plug-in displayed on the Custom Fader chan-
nels.

¢ When no Custom Fader mode is active, the Focus Channel
display shows the name of the focused channel.

Groups Switch

The Groups switch invokes Groups mode, which lets you se-
lect either Mix/Edit Groups or Custom Groups. Invoking
Mix/Edit Groups let you create, edit, and recall Pro Tools Mix
and Edit groups to the Custom Fader channels.

Invoking Custom Groups lets you create a custom collection
of channels and arrange them in any order in the Custom
Fader channels. Custom Groups are a D-Command feature,
and are not reflected on-screen in Pro Tools.

For more information about Custom Groups, see”Custom
Groups Mode” on page 101.

To toggle between Custom Groups and Mix/Edit Groups:

= Press the Bank/Cycle switch repeatedly until the appropri-
ate mode is displayed in the Focus Channel display (Custom
or Groups).

Tracks Switch

The Tracks switch invokes Track Type mode, which lets you
bring all Pro Tools tracks of a certain type (Audio tracks, Aux-
iliary Inputs, MIDI tracks, Instrument tracks, VCA Master
tracks, or Master Faders) to the Custom Fader channels.

Plug-in Switch

The Plug-in switch invokes Plug-in mode, which lets you
bring the plug-in controls from the first insert of the currently
focused channel to the Custom Fader channels.

To cycle through the available inserts:

= In Plug-in mode, press the Bank/Cycle switch repeatedly
until the desired insert is brought into the Custom Fader
channels.

Map Switch

The Map switch works with Custom Groups mode, Mix/Edit
Groups mode, and Plug-in mode. While in these modes, the
Map switch lets you further customize the control layout by
mapping individual rotary encoder controls to faders within
the Custom Fader channels.

The Map switch has no effect on other D-Command channels
in Normal mode.

Lock Switch

The Lock switch applies to Custom Fader Plug-in mode only.
This switch locks the plug-in that is currently displayed in the
Focus Channel display, so that it does not change when you
focus a different channel in the duplicate Focus Channel strip.
The Lock switch lights when the plug-in is locked.

¢ When Custom Fader Plug-in mode is active, the locked
plug-in appears in the Custom Fader channels, so you can fo-
cus a different channel in the Focus Channel section and keep
the locked plug-in in the Custom Fader channels.

¢ When Custom Fader Plug-in mode is not active, the locked
plug-in appears in the Focus Channel display, so you can fo-
cus a different channel on the duplicate Focus Channel Strip
and keep the locked plug-in in the Focus Channel section.
(When you enter Custom Fader Plug-in mode, the locked
plug-in will be displayed on the Custom Fader channels.)

Window Switch

The Window switch opens and closes the plug-in window
on-screen for any plug-in whose name is displayed in the Cus-
tom Faders display.

Bank/Cycle Switch

& While in Custom Groups or Mix/Edit Groups mode, the
Bank/Cycle switch is used to bank faders within the Custom
Fader channels, if there are more channels than can be dis-
played at one time.

¢ While in Custom Fader Plug-in mode, the Bank/Cycle
switch cycles through the plug-ins on the focused channel,
displaying their controls on the Custom Fader channels.

¢ When no Custom Fader mode is active, the Bank/Cycle
switch cycles through the plug-ins on the focused channel,
displaying their names in the Custom Faders display.
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Automation Mode Controls

The Automation Mode controls are used to display and set au-
tomation modes. These switches light to indicate that at least
one channel is in that automation mode. If multiple channels
are selected and set to different automation modes, all appli-

cable mode switches are lit.

These Automation Mode controls let you change automation
modes during playback, and mirror the function of the
on-screen Automation Mode selector for each track.

Auto Mode
Automation Write Automation Trim
Mode switch Mode switch
Write Trim
Automation Touch Automation Read
Mode switch b Mode switch
Touch  Read
Automation Latch Automation Off
Mode switch J switch
Latch Off

Automation Mode controls

To set the automation mode of one or more channels:

1 Hold an Automation Mode switch (Write, Touch, Latch,
Trim, Read, or Off).

2 Press the Select switches on the channels whose automation

mode you want to set.

To set the automation mode of one or more selected channels:

1 Press the Do To Selected switch.

2 Press the Select switches on the channels whose automation
mode you want to set.

3 Press an Automation Mode switch.

To set the automation mode on all channels:

1 Press the Do To All switch.

2 Press an Automation Mode switch.

Write Switch

The Write switch indicates or sets the automation mode for
the selected tracks to Write mode.

Touch Switch

The Touch switch indicates or sets the automation mode for
the selected tracks to Touch mode.

Latch Switch

The Latch switch indicates or sets the automation mode for
the selected tracks to Latch mode.
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Trim Switch

The Trim switch indicates or sets the automation mode for the
selected tracks to Trim mode.

Read Switch

The Read switch indicates or sets the automation mode for the
selected tracks to Read mode.

Off Switch

The Off switch indicates or sets the automation mode for the
selected tracks to Off.

Talkback Switch

The Talkback switch, located at the bottom of the Global Con-
trols section on the Main Unit, provides control of the
D-Command Talkback function.

Auto Mode

@O

Write  Trim

()

Touch  Read

(e (%)

Latch Off

Talkback switch

Talkback
Dbl PresstoLatch

Talkback switch

The Talkback switch can follow momentary or latched behav-
ior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to
indicate that talkback is active. Press the switch again to turn
off talkback.

Talkback can be activated automatically. See “Auto Talkback
Switch” on page 90 for more information.

Talkback level is set with the Talkback controls in the Monitor
section. See “Talkback/Listen System” on page 90 for more in-
formation.



N Assign Controls
Miscellaneous Controls g

The Assign controls are used to assign inputs, outputs, inserts,
and sends to channels. Each switch puts D-Command into a

temporary Assign mode in which elements are assigned or re-
moved from channels. The switch flashes while Assign mode
is in effect.

The Miscellaneous Controls section includes Timeline, Assign,
Make Inactive, and Plug-in Automation controls.

Timeline Assign
controls controls

Make Inactive Plug-in Automation
controls controls

You can enter Assign mode while Pro Tools is playing back. To

Timeline Assign Make Inactive Plug-in Auto Enable

Counter g 9 Inputs Qutputs nputs  Output Enab Para  Safe

Link__Edit/T-Line Sends  Inserts Sends  Inserts

confirm the assignment of inputs, outputs, and sends, the
transport must be stopped. You can, however, confirm the as-
signment of inserts during playback.

Assign

Assign Inputs ( ) ( ) Assign Outputs
switch O O switch
Inputs Outputs

Assign Sends (l )) (( \) Assign Inserts
switch = 7 switch

Sends Inserts

Miscellaneous controls

Timeline Controls

Assign controls

Timeline
Main Counter
switch (O) Assign Inputs Switch
L Eait and Conter 9 0 Edit/Timeline
ink Edit an 7 Selection i i i i i
Timeline switch o ) e The Inputs switch invokes Assign Inputs mode, in which the
Link Edit/T-Line indicators

bottom row of encoders shows channel inputs.

R e When assigning an input, the Select switch on the bottom en-

coder is used to navigate down through Input menu levels,
and the encoder knob is used to scroll through available
choices at each level:

Main Counter Switch

The Main Counter switch cycles through the time code dis-
play modes (Bars:Beats, Min.Secs, Time Code, Feet+Frames
and Samples) on the Main Time Scale display.

¢ Input type (Interface or Bus)

¢ Individual inputs

The Bypass/Mute/Pre switch on the bottom encoder is used to
navigate back up the Input menu levels.

Link Edit and Timeline Switch

The Link Edit and Timeline switch toggles the Link Edit and
Timeline Select1.on com@and on and off. The switch is lit Assign Outputs Switch
when the selections are linked.

The Outputs switch invokes Assign Outputs mode, in which

Edit/Timeline Switch and Indicators the bottom row of encoders shows channel outputs.

The Edit/Timeline switch toggles the D-Command transport
function between the edit selection and the timeline selec-
tion. The indicators above the switch light to show which is

When assigning an output, the Select switch on the bottom
encoder is used to navigate down through Output menu lev-
els, and the encoder knob is used to scroll through available

displayed. If Edit and Timeline Selections are linked, these val- choices at each level:

ues will be the same. e Output type (Interface or Bus)

¢ Individual outputs

The Bypass/Mute/Pre switch on the bottom encoder is used to
navigate back up the Output menu levels.
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Assign Sends Switch

The Sends switch invokes Assign Sends mode, in which the
channel encoders shows the sends on a channel.

When assigning a send, the encoder Select switch is used to

navigate down through Send menu levels, and the encoder

knob is used to scroll through available choices at each level:
e Send type (Interface or Bus)

¢ Individual sends

The Bypass/Mute/Pre switch on each encoder is used to navi-
gate back up the Send menu levels.

Assign Inserts Switch

The Inserts switch invokes Assign Inserts mode, in which the
channel encoders show the inserts on a channel. When as-
signing an insert, the encoder Select switch is used to navigate
down through Insert menu levels, and the encoder knob is
used to scroll through available choices. The Bypass/Mute/Pre
switch on the bottom encoder is used to navigate back up the
Insert menu levels.

The order in which plug-ins appear in the Insert menu is de-
termined by the Pro Tools Display preference for plug-in orga-
nization.

If the Organize Plug-in Menus by Category option is selected,
menu levels and choices include:

e Insert type (TDM plug-in, RTAS plug-in, Multi-Mono
TDM plug-in, Multi-Mono RTAS plug-in, or Hardware In-
sert)

e Plug-in category sub-folders (such as EQ, Dynamics, Pitch
Shift, Reverb, and Delay)

¢ Individual insert or plug-in

If the Organize Plug-in Menus by Category option is not se-
lected, the Plug-in subfolder level is not present.
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To assign an input, output, send or insert:

1 Press an Assign switch to enter the corresponding Assign
mode.

2 On the channel where you want to make the assignment,
turn an encoder knob to select from the first level of menu
choices.

3 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.
4 Do one of the following:
e DPress the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignment.
e Press the flashing Escape switch to cancel the assign-
ment.

To assign multiple inputs, outputs, sends, or inserts:

1 Press an Assign switch to enter the corresponding Assign
mode.

2 Turn the encoder knobs and use the encoder Select and By-
pass/Mute/Pre switches to select each assignment.
3 Do one of the following:
e DPress the flashing Assign switch to confirm all the assign-
ments at once.
e Press the flashing Escape switch to cancel all the assign-
ments.

To remove an input, output, send or insert:

1 Press an Assign switch to enter the corresponding Assign
mode.

2 For the assignment you want to remove, press the encoder
Bypass/Mute/Pre switch repeatedly until you reach top level
menu for the assignment.

3 Turn the encoder knob counter-clockwise until no assign-
ment is visible.
4 Do one of the following:
e Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the removal.
e Press the flashing Escape switch to cancel the removal
and restore the assignment.



MIDI Inputs and Outputs on Instrument Tracks

The Assign Inputs and Assign Outputs switches can be used to
assign the MIDI Inputs and Outputs on Instrument tracks.

To assign a MIDI Input or Output on an Instrument track:

1 Press the Assign Inputs or Assign Outputs switch to enter the
corresponding Assign mode. Encoder row #1 shows MIDI in-
puts/outputs.

Assign

Assign Inputs (s ) ( A Assign Outputs
switch @ @ switch

Inputs  Outputs

Sends Inserts

Assignment controls

2 On each channel where you want to make an assignment,
turn the encoder knob in encoder row #1 to select from the
first level of MIDI menu choices.

3 Press the encoder’s Select switch to move down and the By-
pass/Mute/Pre switch to move up through MIDI menu levels.
4 Do one of the following:

e Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignments.

— Or —

e Press the flashing Escape switch to cancel the assign-
ments.

Make Inactive Controls

The Make Inactive controls are used to make tracks, inputs,
outputs, sends, or plug-ins inactive. Each switch puts D-Com-
mand into a temporary Make Inactive mode in which ele-
ments are made inactive or reactivated. The switch flashes
while Make Inactive mode is in effect.

Make Inactive

Inputs Inactive (l )) (( \) QOutputs Inactive
switch - __7 switch

Inputs ~ Output

Sends Inactive (l ) ( A Inserts Inactive
switch S— —

Sends Inserts switch

Make Inactive Controls

Making a Track Inactive

Tracks can be made inactive in any Make Inactive mode.

To toggle a track inactive/active:

1 Press any of the Make Inactive switches.

2 Press channel strip Select buttons to deactivate or reactivate
the corresponding tracks.

3 Press the flashing Make Inactive switch to exit Inactive
mode

Inputs Inactive Switch

The Inputs switch invokes Inputs Inactive mode and displays
channel inputs in the bottom row of encoders. The By-
pass/Mute/Pre switch on the bottom encoder toggles the in-
put inactive and active.

Outputs Inactive Switch

The Outputs switch invokes Outputs inactive mode and dis-
plays the main channel outputs in the bottom row of encod-
ers. The Bypass/Mute/Pre switch on the bottom encoder tog-
gles the output inactive and active.

Sends Inactive Switch

The Sends switch invokes Sends Inactive mode and displays
the channel’s sends on its encoders. The Bypass/Mute/Pre
switch on each encoder toggles the corresponding send inac-
tive and active.

Inserts Inactive Switch

The Inserts switch invokes Plug-ins Inactive mode and dis-
plays a channel’s inserts on its encoders. The Bypass/Mute/Pre
switch on each encoder toggles the corresponding insert inac-
tive and active.

To toggle an input, output, send, or insert active/inactive:

1 Make sure the channel is showing the top-level view for the
element you want to make active/inactive.

2 Press a Make Inactive switch to enter the appropriate Make
Inactive mode.

3 Press the Bypass/Mute/Pre switches on encoders to deacti-
vate or reactivate their corresponding track elements.

4 Press the flashing Make Inactive switch to exit Inactive
mode.
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Plug-in Automation Controls

The Plug-in Automation controls are used to enable parame-
ters for automation and to place them in automation safe
mode.

Plug-in Auto Enable
Enable Parameter ( ) Automation Safe
switch —O) O_ switch

Enab Para ~ Safe

Plug-in Automation controls

Enable Parameters Switch

The Enable Parameters switch lets you enable parameters for
automation by touching or pressing their controls.

In Enable Parameters mode, the Enable Parameters switch is
lit. While in this mode, the Auto LED for any rotary encoder
enabled for automation is lit red, and the switch for any pa-
rameter enabled for automation is lit.

To toggle automation on and off for plug-in parameters:

1 Press the Enable Parameter switch.

2 Touch the rotary encoders or press the switches for the con-
trols for which you want to toggle automation on or off.

3 Press the Enable Parameter switch again to exit Enable Pa-
rameters mode.

Q You can also toggle automation for a plug-in parameter by
holding Control+Start+Alt (Windows) or Command+Con-
trol+Option (Mac) and touching the rotary encoder for the
parameter.
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Automation Safe Switch

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each plug-in or send and the chan-
nel Select switch for each track become Safe switches.

Plug-ins and Sends

While in Automation Safe mode, pressing a Bypass/Mute/Pre
switch on a plug-in or send protects any automation on that
plug-in or send from being overwritten. The Bypass/Mute/Pre
switch for any protected plug-in or send is lit, reflecting the
state of the Safe button in the on-screen plug-in or send out-
put window.

Tracks

While in Automation Safe mode, pressing a channel Select
switch protects volume, pan and mute parameters on that
track from being overwritten. The channel Select switch for
any protected track is lit, reflecting the state of the Safe button
in the on-screen track output window.

To toggle automation safe on and off:

1 Press the Automation Safe switch.

2 Press the channel Select switch on the tracks for which you
want to toggle automation safe status. The automation safe
status of the track is reflected by the Safe button in the track’s
on-screen output window.

3 Press the Bypass/Mute/Pre switch for the plug-ins or sends
for which you want to toggle automation safe status.

4 Press the Automation Safe switch again to exit Automation
Safe mode.



Chapter 7: Plug-in Controls

Plug-ins and D-Command

D-Command provides dedicated Dynamics and EQ sections
for plug-ins that support dynamics and EQ plug-in mapping.
These sections include encoders and switches that map to
standard controls for each plug-in type.

Plug-ins of all types can be focused across multiple D-Com-
mand channels using Custom Fader Plug-ins mode. See
“Plug-In Mode” on page 104.

Plug-in Channel Formats

D-Command supports mono, stereo, multichannel and
multi-mono plug-in channel formats up to six channels wide.

With D-Command, you can display, edit, and link specific
channels of multi-mono dynamics and EQ plug-ins directly
from the Channel Select switches in the corresponding sec-
tion.

Assigning and Removing Plug-ins

You can make plug-in assignments directly from D-Command
in several ways. In Inserts mode, plug-ins can be added on an
insert-by-insert basis. In Assign Inserts mode you can assign
plug-ins to insert positions on multiple tracks.

To assign a plug-in in Inserts mode:

1 Press the Inserts switch to display inserts on the channel
where you want to assign the plug-in.

2 If the insert location where you want to assign a plug-in is

not showing, press the Page Up or Page Down switches on the
channel where you want to make the assignment until the ap-
propriate location is displayed.

3 Do one of the following:

e If the insert location you want to use is empty, press the
corresponding encoder Select switch.

e If a plug-in is already present in the insert location you
want to use, press and hold the corresponding encoder
Select switch.

4 At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of
menu choices.

5 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

6 When the plug-in you want to assign is displayed, press the
encoder Select switch to confirm your selection.

To assign plug-ins to multiple tracks:

1 Press the Assign Inserts switch to enter Inserts Assign mode.
The first two send or insert positions will show on the encoder
displays by default.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to
make the assignment.

3 At the insert position where you want to make the assign-
ment, turn the encoder knob to select from the first level of
menu choices.

4 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

5 When the plug-in you want to assign is displayed, press the
encoder Select switch to confirm your selection.

6 Repeat steps 2-5 to make additional insert assignments.
7 Press the flashing Assign switch to confirm the assignments

and exit Inserts Assign mode.

To remove a plug-in:

1 Press the Set to Default switch.

2 Press the encoder Select switch for each plug-in you want to
remove.

3 Press the flashing Set to Default switch to exit Set to Default
mode.

Default Plug-in Preferences

You can set a default EQ plug-in and default Dynamics plug-in
in Pro Tools, which makes them available for quick assign-
ment from D-Command.

To set a default EQ or Dynamics plug-in:

1 In Pro Tools, choose Setup > Preferences and click Mixing.

2 Under Setup, choose a plug-in from the Default EQ or De-
fault Dynamics pop-up menu.

3 Click OK to close the Preferences window.
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Focusing Plug-ins on D-Command

A plug-in is focused when its controls are mapped to the knobs,
switches or faders on D-Command. Its parameters can then be
edited and automated from the control surface. D-Command
lets you focus a plug-in with or without displaying its window
on-screen.

You can focus plug-ins in multiple locations on D-Command:
in the Dynamics section, in the EQ section, and in the Custom
Faders section.

When a plug-in is focused on D-Command and displayed
on-screen in Pro Tools, a colored outline appears in the
plug-in window header.

To focus a plug-in in the Dynamics or EQ section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The first dynamics and EQ
plug-ins on that track are automatically focused in the corre-
sponding D-Command section.

2 Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The
No Insert option is always available.)

To focus a plug-in in the Custom Faders section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The name of the first plug-in
that is not a dynamics or EQ plug-in appears in the Focus
Channel display.

2 Press the Plug-in switch in the Custom Faders section. The
switch lights to indicate the mode is active. The plug-in name
and channel format appear in the Custom Fader channel dis-
plays, and the plug-in’s parameters appear in the Custom
Fader channel encoders.

3 In the Custom Faders section, press the Bank/Cycle switch
to cycle through the plug-ins on the focused channel. (The No
Insert option is always available.)

The plug-in whose name appears in the Custom Faders display
is focused in Custom Fader mode. See “Plug-In Mode” on
page 104.

Q When plug-in names are shown on the encoder displays, a
" plug-in can be quickly brought into Custom Fader mode by
pressing its associated encoder Select switch.
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Opening Plug-in Windows On-Screen

There are several ways to open plug-in windows on-screen
from D-Command.

To open a plug-in window from any channel on D-Command:

= Hold Start (Windows) or Control (Mac) and press the en-
coder Select switch for the plug-in.

To open a plug-in window on a focused track:

1 Focus a track in the Focus Channel section by pressing its Se-
lect switch.

2 In the Custom Faders section, press the Bank/Cycle switch
to cycle through the plug-ins on the focused track. Plug-in
names are shown in the Custom Faders display.

3 In the Custom Faders section, press the Win switch to open
the plug-in whose name is displayed.

To open a focused dynamics or EQ plug-in window:

= Press the Window switch in the Dynamics or EQ section of
D-Command.

To open or close all focused plug-in windows:

= Press the Plug-in switch in the Window Management sec-
tion.

To close all open plug-in windows:

= Hold Alt (Windows) or Option (Mac) and press the Plug-in
switch in the Window Management section. This closes all
real-time and AudioSuite plug-in windows.

To set D-Command to automatically open plug-in windows:

1 Press the Operations switch in the D-Command Soft Keys
section twice.

2 Press the Soft Key that corresponds to “ChanWn” until its
value is “Yes.”

With this preference set to “Yes,” when you insert a new
plug-in, press an encoder Select switch to edit a plug-in, or cy-
cle through plug-ins on the focused track, the plug-in window
will automatically open on-screen.



Managing Multiple Plug-in Windows

D-Command lets you open and swap multiple plug-in win-
dows on-screen. This makes it possible keep multiple plug-in
windows open while focusing on different tracks (for exam-
ple, in a session where several tracks have dynamics and EQ
plug-ins).

Targeting Plug-ins

A plug-in is said to be targeted on-screen when its target icon in
the plug-in window header is lit red. The first plug-in window
to be opened is automatically targeted.

¢ When a plug-in window is targeted, it is replaced when you
open any new plug-in window.

¢ When a plug-in window is not targeted (when its target icon
is grey) the plug-in window will remain on-screen.

To open multiple plug-in windows:

= Hold Shift while opening each new window. The new
plug-in windows are not targeted.

To swap multiple plug-in windows while changing track focus:

1 Focus a track with multiple plug-ins (for example, dynam-
ics, EQ and pitch shift plug-ins) by pressing the track’s Select
switch.

2 Open multiple plug-in windows on the focused track while
holding the Shift modifier.

3 Hold Alt (Windows) or Option (Mac) while changing focus
to another track with multiple plug-ins by pressing that track’s
Select switch.

Focused plug-ins with open windows swap into new plug-in
windows on-screen, wherever plug-ins are present in the new
track.

Making Plug-ins Inactive or Active

You can toggle the active/inactive status of a plug-in directly
from a channel strip without putting D-Command into Make
Inactive mode.

To toggle a plug-in active/inactive directly from a channel strip:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on the channel’s encoders.

2 If the insert location for the plug-in that you want to make
active/inactive is not showing, press the Page Up or Page
Down switches on the channel until the appropriate location
is displayed.

3 Hold Control+Start (Windows) or Control+ Command
(Mac) and press the encoder Select switch for the plug-in.

Copying and Pasting Plug-in Settings

You can copy plug-in settings from a plug-in and paste them
into another copy of the same plug-in directly from a channel
strip on D-Command.

To copy and paste plug-in settings:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on that channel’s encoders.

2 If the insert location for the plug-in whose settings you want
to copy is not showing, press the Page Up or Page Down
switches on the channel until the appropriate location is dis-
played.

3 Copy the settings of a plug-in by holding Shift+Control
(Windows) or Shift+Command (Mac) and pressing the Select
switch under the name of the plug-in.

4 Paste the settings into another instance of the same plug-in
by pressing the B/M/P switch under the name of that plug-in.
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Enabling Plug-in Automation

When plug-in names are displayed in top-level view on a
D-Command channel strip, you can quickly enable all param-
eters of a plug-in for automation.

You can also use the Do To All or Do To Selected switches on
D-Command to automate multiple plug-ins in the same insert
position in a session.

To toggle automation on and off for a parameter of a plug-in:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top level Inserts display. Plug-in names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the name
of the plug-in you want to automate.

3 Press an encoder Select switch to display that plug-in’s pa-
rameters on the Custom Fader encoders.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the
plug-in parameters you want to enable for automation.

To toggle automation on and off for all parameters of a plug-in:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top level Inserts display. Plug-in names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the name
of the plug-in you want to automate.

3 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for the
plug-in whose parameters you want to enable for automation.
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To toggle automation on and off for all plug-ins in a given Insert
position:

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top level Inserts display. Plug-in names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the insert
position for the plug-ins you want to automate.

3 Press the Do To All switch in the Global controls section.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any
plug-in at the insert position (Insert 1-5) where you want to
enable plug-in automation.

To toggle automation on and off for plug-ins in a given Insert
position on all selected tracks:

1 Select the tracks containing the plug-ins you want to enable
for automation.

1 Press the Inserts switch in the Channel Strip Mode controls
of a track to show the top level Inserts display. Plug-in names
appear in the encoder displays of that track.

2 Press the Page Up or Page Down switch to display the insert
position for the plug-ins you want to automate.

3 Press the Do To Selected switch in the Global controls sec-
tion.

4 Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and touch the rotary encoder for any
plug-in at the insert position (Insert 1-5) where you want to
enable plug-in automation.



Dynamics Section

The Dynamics section includes standard controls for compressor, gate, and limiter plug-ins, an array of controls for managing the
display and editing of plug-in parameters, and for selecting or linking channels in multi-mono plug-ins.
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D-Command Dynamics section

Dynamics Plug-in Support

Dynamics processing plug-ins may have widely varying con-
trols, depending on their applications. The D-Command Dy-
namics Section provides dedicated knobs and switches to ac-
commodate a wide range of possible plug-ins. Not all plug-ins
will require all the Dynamics controls, while others may have
more parameters than can be displayed in the Dynamics sec-
tion at one time. To display all controls in any plug-in, use
Custom Fader Plug-ins mode. (See “Plug-In Mode” on

page 104.)

Threshold/Output Level

Dynamics Edit/Display/Page controls

Displaying Dynamics Plug-ins

The D-Command Dynamics section automatically focuses the
first dynamics plug-in on the channel displayed in the Focus
Channel section on the Main Unit.

To display successive dynamics plug-ins that are on the fo-
cused channel, press the Cycle switch in the Dynamics sec-
tion.
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Knee/Hysteresis/Q and
Ratio/Range/Frequency Controls
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Knee/Hysteresis/Q and Ratio/Range/Frequency controls in the
Dynamics section

Knee/Hysteresis/Q Control

The top encoder in this section controls the knee shape, the
hysteresis value, or the Q value for the current plug-in page,
depending on which indicator is lit. The Auto indicator under
the encoder knob lights when the displayed parameter is en-
abled for automation.

Ratio/Range/Frequency Control

The bottom encoder in this section controls the compression
ratio, the range value, or the filter frequency for the current
plug-in page, depending on which indicator is lit. The Auto
indicator under the encoder knob lights when the displayed
parameter is enabled for automation.
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Attack/Q and Release/Frequency Controls
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Attack/Q and Release/Frequency controls in the Dynamics section

Attack/Q Control

The top encoder in this section controls the attack value, or
the Q value for the current plug-in, depending on which indi-
cator is lit. The Auto indicator under the encoder knob lights
when the displayed parameter is enabled for automation.

Release/Frequency Control

The bottom encoder in this section controls the release value
for the current plug-in, or the filter frequency for the current
plug-in page, depending on which indicator is lit. The Auto
indicator under the encoder knob lights when the displayed
parameter is enabled for automation.



Gain/Hold and Threshold Controls
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Gain/Hold and Threshold controls in the Dynamics section

Gain/Hold/Input Control

The top encoder in this section controls the gain (make-up
gain), the hold value for the current plug-in page, or the input
gain for the current plug-in, depending on which indicator is
lit. The Auto indicator under the encoder knob lights when
the displayed parameter is enabled for automation.

Threshold/Output Control

The bottom encoder in this section controls the threshold
value for the current plug-in page, or the output gain for the
current plug-in, depending on which indicator is lit. The Auto
indicator under the encoder knob lights when the displayed
parameter is enabled for automation.
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Dynamics Channel Select Controls

Dynamics display
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Channel Select controls in the Dynamics section

Dynamics Display Channel Select Switches

The LED display in the Dynamics section show the name of

the focused plug-in by default. When any rotary encoder is

touched, the display shows the corresponding parameter When you are working with a multichannel plug-in, all chan-

value. nels are controlled in tandem and the Channel Select switches
have no effect.

Multichannel Plug-ins

Lock Switch
Multi-Mono Plug-ins

The Lock switch is used to lock the focus of the Dynamics sec-
tion on the current plug-in. When the plug-in focus is locked,
the current plug-in remains in the Dynamics section, even
when a different track is focused on D-Command. This switch
lights when the plug-in focus is locked.

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels
of a multi-mono plug-in by using the Channel Select switches
to unlink all of the channels, or to link specific channels.
Save and Save As Switches

There are Channel Select switches for the following channels:
The Save and Save As switches perform the Save and Save As o L (Left)

commands in the Plug-in settings menu. The Save command « C (Center)
saves current parameter settings to the current plug-in settings

file, and the Save As command saves the parameter settings to * R(Right)
a new plug-in settings file. * Ls (Left Surround)

¢ Rs (Right Surround)
To save a Dynamics plug-in setting from D-Command: e LFE

1 Press the Save or Save As switch in the Channel Select con-
trols of the Dynamics section. The Save or Save As switch
flashes while the Save Settings dialog is open.

A maximum of six channels (5.1 surround) may be in use at
any time.

2 Type a name for the plug-in setting.

3 Do one of the following:
e Click OK to save the settings and close the dialog.

e Press the flashing Save or Save As switch to save the set-
tings and close the dialog.

* Press the Escape switch to exit the dialog without saving
the settings.
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Master Link Switch

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, and the Master Link switch has
no effect.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the Master
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When
the Master Link button is enabled, the Link switch is lit.

Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function
of the Channel Select switches with multi-mono plug-ins.

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of

the plug-in controls. When a channel is selected, its switch is
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Command Channel Window Display
preference is set to Yes, the Channel Select switches also
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed.
When a channel is bypassed, its switch is lit. If any channels
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are
linked together. Linked channels are indicated by switches
that are lit.
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Dynamics Edit and Display Controls
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Edit and Display controls in the Dynamics section

External Key Switch

The External Key switch turns the Key Input on or off for
plug-ins that support side-chain processing with external in-
put. This switch lights when Key Input is on.

Key Listen Switch

The Listen switch turns the Key Listen function on or off for
plug-ins that support auditioning the Key Input. This switch
lights when Key Listen is on.

Automation Switch

The Automation switch lets you enable Dynamics parameters
for automation by touching or pressing their controls in the
Dynamics section only.

In Automation mode, the Auto switch is lit. While in this
mode, the Auto indicator for any rotary encoder enabled for
automation is lit red, and the switch for any parameter en-
abled for automation is lit.

To toggle automation on and off for individual Dynamics
parameters:

1 Press the Automation switch.

2 Touch the rotary encoders or press the switches in the Dy-
namics section for which you want to toggle automation.

3 Press the Automation switch again to exit Automation
mode.

To toggle automation on and off for all parameters of a Dynamics
plug-in:

1 Press the Automation switch.

2 Do one of the following:
e Hold Alt (Windows) or Option (Mac).

e Hold Do to All.
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3 Touch any rotary encoder or press any switches in the Dy-
namics section.

4 Press the Automation switch again to exit Automation
mode.
Automation Safe Switch

The Automation Safe switch toggles the Safe button in the
plug-in window, which protects existing automation for that
plug-in from being overwritten.

Window Switch

The Window switch is used to open and close the on-screen
window for the currently focused plug-in.

Compare Switch

The Compare switch toggles the Compare button in the
plug-in window, which alternates between the currently saved
plug-in setting and any changes you have made.

Cycle Switch
The Cycle switch steps through all available Dynamics
plug-ins on the focused channel.

Master Bypass Switch

The Master Bypass switch bypasses the plug-in.

Page Switch

With plug-ins that have more than one page of controls, the
Page switch lights. Pressing this switch steps through the
pages for the currently displayed plug-in.

The current function of the rotary encoders in the Dynamics
section is shown by the corresponding indicator LEDs. Active
controls are shown in the on-screen plug-in window by col-
ored outlines.



Dynamics Gain Controls and Meters
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Level meters in the Dynamics section

Output Meter and Clip Indicator

The Output meter shows the output level for the current
plug-in. The Clip indicator lights when a clip is reported by
the plug-in, and can be cleared by pressing the Clear Clip
switch in the Session Management section.

Gain Reduction Meter

The Gain Reduction meter shows the amount of gain reduc-
tion for Compressor/Limiter functions (using the range
shown on the left) and Expander/Gate functions (using the
range shown on the right).

Chapter 7: Plug-in Controls 59



EQ Section

The EQ section includes standard controls for a variety of multi-band equalization plug-ins, an array of controls for managing the
display and editing of plug-in parameters, and controls for selecting or linking channels in multi-mono plug-ins.

Low Filter/ High-Mid Filter/
High-Pass Filter Level
controls controls Channel Select
Low-Mid Filter/ High Filter/ switches
Mid Filter Low-Pass Filter
controls controls

s

Frequency

Frequency

[ ] . ] L] . . (]
LF HPF LMF MF HMF Lvi HF

Gain

©

D-Command EQ section

EQ Plug-in Support

EQ processing plug-ins may have widely varying controls, de-
pending on their applications. The D-Command EQ section
uses paging to accommodate the widest range of plug-ins pos-
sible.

Each encoder column controls several frequency bands,
which are chosen by pressing the Page switch. LEDs light to
indicate the frequency band that is currently active for edit-
ing. Notch/Shape switches are located on the Low and High
band to change filter types.

To simultaneously display all controls in any plug-in, use Cus-
tom Fader Plug-ins mode. (See “Plug-In Mode” on page 104.)
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EQ Edit and Display controls

Page

Displaying EQ Plug-ins

The D-Command EQ section automatically displays the first
EQ plug-in on the channel that is focused in the Focus Chan-
nel section on the Main Unit.

To display successive EQ plug-ins that are on the focused
channel:

= Press the Cycle switch in the EQ section.



Low Filter and High-Pass Filter Controls
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Low Filter and High-Pass Filter controls in the EQ section

Q Encoder

The top encoder controls the Q of the selected filter. The Auto
indicator under the encoder knob lights when the parameter
is enabled for automation.

Notch/Shape Switches and Indicator

The Notch/Shape switch let you switch between the two filter
types when they are available. The indicators on either side of
the switch light to show which type of filter is active.

Frequency Encoder

The middle encoder controls the filter frequency for the cur-
rently selected band. When the filter is a notch filter, the en-
coder controls the center frequency. When the selected filter
is a low-pass filter, the encoder controls the cutoff frequency.
The Auto indicator under the encoder knob lights when the

parameter is enabled for automation.

Gain Encoder

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter
is enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.

Low-Mid Filter and Mid Filter Controls
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Low-Mid Filter and Mid Filter controls in the EQ section
Q Encoder

The top encoder controls the Q of the selected filter. The Auto
indicator under the encoder knob lights when the parameter
is enabled for automation.

Frequency Encoder

The middle encoder controls the center frequency for the cur-
rently selected band. The Auto indicator under the encoder
knob lights when the parameter is enabled for automation.

Gain Encoders

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter
is enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.
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High-Mid Filter and EQ Level Controls
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High-Mid Filter and EQ level controls in the EQ section

Q/Input level Encoder

The top encoder controls the Q of the High-Mid filter, or the
Input level. The Auto indicator under the encoder knob lights
when the parameter is enabled for automation.

Frequency/Output Level Encoder

The middle encoder controls the center frequency for the cur-
rently selected band, or the Output level. The Auto indicator
under the encoder knob lights when the parameter is enabled
for automation.

Gain Encoder

The bottom encoder controls the gain for the High-Mid band.
The Auto indicator under the encoder knob lights when the
parameter is enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.
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High Filter and Low-Pass Filter Controls
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Low Filter and High Filter controls in the EQ section

Q Encoders

The top encoder controls the Q of the selected band. The Auto
indicator under each encoder knob lights when the parameter
is enabled for automation.

Notch/Shape Switches and Indicator

The Notch/Shape switch let you switch between the two filter
types when they are available. The indicators on either side of
the switch light to show which type of filter is active.

Frequency Encoder

The middle encoder controls the filter frequency for the cur-
rently selected band. When the filter is a notch filter, the en-
coder controls the center frequency. When the selected filter
is a low-pass filter, the encoder controls the cutoff frequency.
The Auto indicator under the encoder knob lights when the

parameter is enabled for automation.

Gain Encoder

The bottom encoder controls the gain for each band. The Auto
indicator under the encoder knob lights when the parameter
is enabled for automation.

Filter In Switch

The Filter In switch lets you engage or bypass the correspond-
ing EQ band in the plug-in.



EQ Channel Select Controls
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Channel Select controls in the EQ section

EQ Displays

The LED display in the EQ section shows the name of the fo-
cused plug-in by default. When any rotary encoder is touched,
the display shows the corresponding parameter value.

Lock Switch

The Lock switch is used to lock the focus of the EQ section on
the current plug-in. When the plug-in focus is locked, the cur-
rent plug-in remains in the EQ section, even when a different
track is focused on D-Command. This switch lights when the
plug-in focus is locked.

Save and Save As Switches

The Save and Save As switches perform the Save and Save As
commands in the Plug-in settings menu. The Save command
saves current parameter settings to the current plug-in settings
file, and the Save As command saves the parameter settings to
a new plug-in settings file.

To save an EQ plug-in setting from D-Command:

1 Press the Save or Save As switch in the Channel Select con-
trols of the EQ section. The Save or Save As switch flashes
while the Save Settings dialog is open.

2 Type a name for the plug-in setting.

3 Do one of the following:
e Click OK to save the settings and close the dialog.
e Press the flashing Save or Save As switch to save the set-
tings and close the dialog.
* Press the Escape switch to exit the dialog without saving
the settings.
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Channel Select Switches

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem and the Channel Select switches
have no effect, except with multichannel plug-ins (such as
Focusrite d2) that directly support channel selection.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the con-
trols for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels
of a multi-mono plug-in by unlinking all of the channels, or
by using the Channel Select switches to link specific channels.

There are Channel Select switches for the following channels:
o L (Left)
e C (Center)
¢ R (Right)
e Ls (Left Surround)
¢ Rs (Right Surround)
e LFE

These choices can be used to support all possible channel con-
figurations in Pro Tools. A maximum of six channels (5.1 sur-
round) may be in use at any time.

Chapter 7: Plug-in Controls 63




Master Link Switch

Multichannel Plug-ins

When you are working with a multichannel plug-in, all chan-
nels are controlled in tandem, so the Master Link switch has
no effect, except with multichannel plug-ins (such as
Focusrite d2) that directly support channel linking.

Multi-Mono Plug-ins

When you are working with a multi-mono plug-in, the Master
Link switch toggles the Master Link button in the plug-in win-
dow, which links or unlinks all channels of the plug-in. When
the Master Link button is enabled, the Link switch is lit.
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Select/Link/Bypass Mode Switch

The Select/Link/Bypass Mode switch determines the function
of the Channel Select switches with multi-mono plug-ins.

Select Mode In this mode, the Channel Select switches deter-
mine which channel of a multi-mono plug-in is the focus of

the plug-in controls. When a channel is selected, its switch is
lit. If any channels are linked, their switches follow linked be-
havior.

In Select mode, if the D-Command Channel Window Display
preference is set to Yes, the Channel Select switches also
change the channel display in the plug-in window.

Bypass Mode In this mode, the Channel Select switches deter-
mine which channels of a multi-mono plug-in are bypassed.
When a channel is bypassed, its switch is lit. If any channels
are linked, their switches follow linked behavior.

Link Mode In this mode, the Channel Select switches deter-
mine which individual channels of a multi-mono plug-in are
linked together. Linked channels are indicated by switches
that are lit.



EQ Edit and Display Controls
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Edit and Display controls in the EQ section

Automation Switch

The Automation switch lets you enable EQ parameters for au-
tomation by touching or pressing their controls in the EQ sec-
tion only.

In Automation mode, the Auto switch is lit. While in this
mode, the Auto indicator for any rotary encoder enabled for
automation is lit red, and the switch for any parameter en-
abled for automation is lit.

To toggle automation on and off for individual EQ parameters:

1 Press the Automation switch.

2 Touch the rotary encoders or press the switches in the EQ
section for which you want to toggle automation.

3 Press the Automation switch again to exit Automation
mode.

To toggle automation on and off for all parameters of an EQ
plug-in:

1 Press the Automation switch.
2 Do one of the following:
e Hold Alt (Windows) or Option (Mac).

e Hold Do to All.

3 Touch any rotary encoder or press any switches in the EQ
section.

4 Press the Automation switch again to exit Automation
mode.

Automation Safe Switch

The Automation Safe switch toggles the Safe button in the
plug-in window, which protects existing automation for that
plug-in from being overwritten.

Compare Switch

The Compare switch toggles the Compare button in the
plug-in window, which alternates between the currently saved
plug-in setting and any changes you have made.

Window Switch

The Window switch is used to open and close the on-screen
window for the currently focused plug-in.

Output Meter and Clip Indicator

The Output meter shows the output levels for the current
plug-in. The Clip indicator lights when a clip is reported by
the plug-in, and can be cleared by pressing the Clear Clip
switch in the Session Management section.

Cycle Switch

The Cycle switch steps through all available EQ plug-ins on
the focused channel.

Master Bypass Switch

The Master Bypass switch bypasses the plug-in.

Page Switch

The Page switch steps through the pages for the currently dis-
played plug-in. The Page switch lights when plug-ins have
more than one page of controls. Active controls are shown in
the on-screen plug-in window by colored outlines.
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Chapter 8: Transport and Navigation Controls

Transport Section

The D-Command Transport section includes transport switches, switches for setting the transport mode, scrub/shuttle switches

and controls, and advanced audition and locate switches.

Audition switches

Master Record Mode
switch

Locate switches

Pro Tools Transport
switches

D-Command Transport Section

Transport Switches

MIDI Merge
indicator

Fast Stop
Forward

Pro Tools Transport switches

Rewind

Pro Tools Transport

The D-Command Pro Tools Transport switches correspond to
the controls in the Pro Tools Transport window.

Rewind Switch Moves backward through the Pro Tools session
beginning from the current cursor position.

Fast Forward Switch Moves forward through the Pro Tools ses-
sion beginning from the current cursor position.

Stop Switch Stops playback of the Pro Tools session.

Transport Modes switches

Scrub/Shuttle
controls

Play Switch Begins playback of the Pro Tools session from the
current cursor position.

Record Switch Arms Pro Tools for recording. The exact func-
tion of the Record switch depends on the current Pro Tools
record mode (QuickPunch, TrackPunch, Wait for Note,
Pause).

MIDI Merge Indicator Shows when MIDI Merge is activated.
Latching Behavior for Fast Forward and Rewind
Switches

You can set Fast Forward or Rewind to follow latched behavior
from the D-Command Transport section.

To set Fast Forward to latch:

» Hold the Fast Forward switch and momentarily press the Re-
wind switch.

To set Rewind to latch:

» Hold the Rewind switch and momentarily press the Fast
Forward switch.
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Playback of Timeline Selection and Edit Selection
from the Transport

When the Timeline and Edit selections in the Edit window are
unlinked, you can set the D-Command Transport to control
playback of either the Timeline selection or the Edit selection.

To focus the D-Command Transport on the Timeline selection:

s Press the Edit/Timeline Selection switch in the Miscella-
neous Controls section so that the Timeline LED is lit.

To focus the D-Command Transport on the Edit selection:

» Press the Edit/Timeline Selection switch in the Miscella-
neous Controls section so that the Edit LED is lit.

Scrub/Shuttle Controls

The Scrub/Shuttle controls are used for scrubbing, scrubbing
while trimming, shuttling, and making selections.

Trim  Scrub Shuttle
switch switch switch

O O ©

Trim Scrub Shuttle

N

Scrub/Shuttle
Wheel

Scrub/Shuttle controls
Scrub/Shuttlie Wheel

The Scrub/Shuttle wheel is used to control cursor position in
Pro Tools and for locating external machines.

Scrolling and Locating in Pro Tools Windows
To horizontally scroll the contents of the Edit window or Mix

window:

1 Focus the window you want to scroll by clicking in it or by
pressing the corresponding window key in the Window Man-
agement section.

2 Hold Alt (Windows) or Option (Mac) while turning the
Scrub/Shuttle Wheel.

To vertically scroll the contents of the Edit window or Mix
window:

1 Focus the window you want to scroll by clicking in it or by
pressing the corresponding window key in the Window Man-
agement section.

2 Hold Shift while turning the Scrub/Shuttle Wheel.

68 D-Command Guide

To locate the cursor in the Edit window while in Continuous Scroll
Mode:

= Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Mark In or Mark Out switch
in the Audition section.

Selecting with the Scrub/Shuttle Wheel

To create selections with the Scrub/Shuttle wheel:

1 Locate the cursor in a track.
2 Press the Scrub switch or the Shuttle switch.

3 Do one of the following:

e Hold the Mark In switch and turn the Scrub/Shuttle
wheel counter-clockwise to create or extend the selection
to the left.

e Hold the Mark Out switch and turn the Scrub/Shuttle

wheel clockwise to create or extend the selection to the
right.

To scrub while adding to the front of a selection:

= Hold Start+Shift (Windows) or Control + Shift (Mac) while
scrubbing the front of the selection.

To scrub while adding to the end of a selection:

= Hold Start+Shift+Alt (Windows) or Control+Shift+Option
(Mac) while scrubbing the end of the selection.

To scrub with fine resolution while adding to the front of a
selection:

» Hold Start+Shift+Control (Windows) or Con-
trol+Shift+Command (Mac) while scrubbing the front of the
selection.

To scrub with fine resolution while adding to the end of a
selection:

» Hold Start+Shift+Alt+Control (Windows) or Con-
trol+Shift+Option+Command (Mac) while scrubbing the end
of the selection.

Continuous Zooming in the Edit Window

To horizontally zoom continuously in the Edit window:

= Hold Control (Windows) or Command (Mac) while turning
the Scrub/Shuttle Wheel.

To vertically zoom continuously in the Edit window:

= Hold Control+Alt (Windows) or Command+Option (Mac)
while turning the Scrub/Shuttle Wheel.



Moving Windows On-Screen with the Scrub/Shuttle Wheel

To move a Pro Tools window horizontally on-screen:

= In the Window Management section, hold the switch for
the window and turn the Scrub/Shuttle wheel.

To move a Pro Tools window vertically on-screen:

= In the Window Management section, hold the switch for
the window, hold Shift, and turn the Scrub/Shuttle wheel.

Nudging Track Position or Focus on D-Command with the
Scrub/Shuttle Wheel

To nudge the position of tracks on D-Command in Normal mode:

= Hold any of the Nudge/Bank switches and turn the
Scrub/Shuttle wheel.

To nudge the position of tracks on D-Command in Custom
Faders:

= Hold the Bank/Cycle switch in the Custom Faders section
and turn the Scrub/Shuttle wheel.

Trim Switch

The Trim switch places the transport in Trim/Scrub mode,
which lets you scrub to locate an edit point, then trim to that
point.

To use Trim/Scrub:

1 Navigate to a region or selection you want to trim.

2 Press the Trim switch.

Q To trim to the end of a selection, hold Alt (Windows) or
" Option (Mac) while pressing the Trim switch.

3 Press the Scrub switch.

4 Rotate the Scrub/Shuttle wheel to move the cursor to the
trim location.

5 To trim to the cursor location, press the Trim switch again.
To cancel without trimming, press Escape.

Scrub Switch

The Scrub switch places the transport in Scrub mode, which

lets you scrub from the cursor position or across a selection.

To use Scrub mode:

1 While Pro Tools is stopped, press the Scrub switch.

2 Rotate the Scrub/Shuttle wheel clockwise to scrub audio for-

ward, or counter-clockwise to scrub audio backward.

3 To exit, press the Scrub switch again.

Shuttle Switch
The Shuttle switch places the transport in Shuttle mode,

which lets you locate the cursor in the Edit window.

To use Shuttle mode:

1 While Pro Tools is stopped, press the Shuttle switch.

2 Rotate the Scrub/Shuttle wheel clockwise to shuttle forward,
or counter-clockwise to shuttle backward.

3 To exit, press the Shuttle switch again.

Scrub, Trim/Scrub and Shuttle modes can be used to create se-
lections and define regions in the Pro Tools Edit window.

Master Record Enable Switch

Master

@—

Record

Master Record Enable switch

Master Record Mode switch

The Master Record Enable switch toggles record enable status
for all applicable audio tracks in a session. This switch flashes
when channels are record-enabled and the Pro Tools transport
is stopped, and lights continuously during recording.

If any tracks in the session are record-enabled, pressing the
Master Record Enable switch takes them out of their enabled
state. If no channels are record-enabled, pressing the Master
Record Enable switch places all applicable audio tracks into
record-enabled state.
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Transport Mode Switches

The Transport Mode switches are used to put the Pro Tools
transport in the various playback and record modes.

9-Pin Remote Loop Playback QuickPunch
switch switch switch

Pro Tools Online Machine Online TrackPunch
switch switch switch

Tranpport Mpdes

OO 0000

Pro Tools 9-Pin Machine Loop Track Quick
Online Remote Online PB Punch Punch

Transport Mode switches
Pro Tools Online Switch

The Pro Tools Online switch toggles the Pro Tools online
state. The online state is mirrored in the Online button in the
Pro Tools Transport window.

While Pro Tools is online and waiting for time code, this
switch flashes. When time code is received, this switch lights
continuously.

9-Pin Remote Switch

With Digidesign MachineControl, the 9-Pin Remote switch
enables 9-pin Remote Deck Emulation mode.

Machine Online Switch

WIth Digidesign Machine Control, the Machine Online
switch toggles the state of the Pro Tools transport between
“Transport = Pro Tools” and “Transport = Machine” (in Serial
Deck Control mode) or between “Transport = Pro Tools” and
“Transport = Remote” (in Remote mode).

Loop Playback Switch

The Loop Playback switch toggles Loop Playback mode in
Pro Tools. When Loop Playback mode is active, this switch
lights. The Loop Playback state is mirrored in the Play button
in the Pro Tools Transport window.

QuickPunch Switch

The QuickPunch switch toggles QuickPunch record mode in
Pro Tools. When QuickPunch mode is active, this switch
lights. The QuickPunch state is mirrored in the Record button
in the Pro Tools Transport window.

TrackPunch Switch

The TrackPunch switch toggles TrackPunch record mode in
Pro Tools. When TrackPunch mode is active, this switch
lights. The TrackPunch state is mirrored in the Record button
in the Pro Tools Transport window.

70 D-Command Guide

Audition Switches

The Audition switches are used to activate pre-roll and
post-roll in playback, define selection in and out points, and
trigger automatic playback of ranges

Audition Mark In Post-Roll
itch itch itch
switc Pre-Roll switcl Mark Out switc|
switch switch
Audjtion

OO0 0 0 O

Audition Pre-Roll Mark In Mark Out~ Post-Roll

Audition switches

Audition Switch

The Audition switch toggles Audition mode on and off. When
Audition mode is on, this switch lights.

When Audition mode is on, you can quickly listen to either
the start or end of a selection, with or without pre-roll or
post-roll, by pressing the following switches:

Pre-Roll Switch Plays audio starting at the pre-roll point up to
the beginning of the selection.

Mark In Switch Plays audio starting at the selection start
through the length of the post-roll amount.

Mark Out Switch Plays audio back-timed from the selection
end by the pre-roll amount.

Post-Roll Switch Plays audio starting at the end of a selection
through the post-roll amount.

Pre-Roll and Post-Roll Switches

When Audition mode is off, the Pre-Roll and Post-Roll
switches toggle pre-roll and post-roll playback on and off in
Pro Tools. When pre-roll or post-roll is active, the correspond-
ing switch lights.

When Audition mode is on, the Pre-Roll and Post-Roll
switches play a range of audio around the current Edit selec-
tion.



Mark In and Mark Out Switches

When Audition mode is off, the Mark In and Mark Out
switches are used to define selection start and end during play-
back, or when using the Scrub/Shuttle wheel.

When Audition mode is on, the Mark In and Mark Out
switches play a range of audio around the current Edit selec-
tion.

To move the selection start:

With the transport stopped, hold the Mark In switch and turn
the Scrub/Shuttle wheel.

To move the selection end:

With the transport stopped, hold the Mark In switch and turn
the Scrub/Shuttle wheel.

To move the entire selection:

With the transport stopped, hold both the Mark In and Mark
Out switches and turn the Scrub/Shuttle wheel.

Locate Switches

The Locate switches move the Pro Tools transport to the des-
ignated location.

Instant

Go To Start Go To End Back Back & Play Playback
switch switch switch switch switch
m M Back Back Instant
& Play Playback
Locate switches
Go To Start Switch

The Go To Start switch returns the playback cursor to the be-
ginning of the session.

Go to End Switch

The Go To End switch moves the playback cursor to the end of
the session.

Back Switch

The Back switch stops the Transport (if it is moving) and
moves the playback cursor back (earlier in time) by the
amount of time selected in Back settings pop-up in Pro Tools.
You can also click repeatedly to move back multiple times.

Forward Mode

Forward mode can be invoked by pressing Alt (Windows) or
Option (Mac), and pressing the Back switch.

Back & Play Switch

The Back and Play switch combines the function of the Back
switch and the Transport Play switch. The playback cursor
moves back by the amount of time selected in the Back set-
tings preference in Pro Tools.

If pre-roll is enabled, the pre-roll time will be observed in ad-
dition to the Back time if pre-roll is enabled.

Forward & Play Mode

Forward & Play mode can be invoked by doing the following:

To move the playback location forward and begin playback:

= Hold Alt (Windows) or Option (Mac) and press the Back and
Play switch in the Transport section.

Instant Playback

The Instant Playback switch primes Pro Tools for playback, so
that pressing Play will begin playback instantaneously. This
switch can also be used during recording to put Pro Tools in
Record Pause mode.
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Zoom/Navigate Section

The Zoom/Navigate section is used to control navigation, dis-
play, and selections in the Pro Tools Edit window.

Zoom Mode Navigate Mode
switch @ @ switgh

Zoom @ Navigate

ol B
switches : <
Prev Next

.

Zoom Presets

e e
| |

Zoom Preset switches

D-Command Zoom/Navigate Section
Zoom Mode Switch

The Zoom Mode switch puts the arrow switches in Zoom
mode.

Navigate Mode Switch

The Navigate Mode switch puts the arrow switches in Navi-
gate mode.

Arrow Switches (Up, Down, Previous, Next)

The function of the Arrow switches depends on the current
mode.

Zoom Mode When set to Zoom Mode, the Up and Down Ar-
row switches change the vertical zoom and the Previous (Left)
and Next (Right) Arrow switches change the horizontal zoom.

Navigate Mode In Navigate mode, the Up and Down Arrow
switches move the edit cursor up and down among tracks, and
the Previous (Left) and Next (Right) Arrow switches move the
edit cursor left and right among region boundaries or tran-
sients (according to the Tab to Transients setting).

Text Entry In both Zoom or Navigate modes, the Arrow
switches can be also used to navigate on-screen text fields and
enter numerical values in the on-screen Main and Sub
Counters, Start/End/Length fields, and Pre/Post Roll fields in
the Edit and Transport windows. The Previous (Left) and Next
(Right) Arrow switches move between fields, and the Up and
Down Arrow switches change the value.
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Zoom Preset Switches

The Zoom Preset switches recall the five horizontal Zoom pre-
sets in Pro Tools.

To store a Zoom Preset:

1 Using either the Horizontal Zoom buttons or the Zoomer
tool, set the zoom level that you want to store.

2 While pressing Control (Windows) or Command (Mac),

press a Zoom Preset switch.

To recall a Zoom Preset:

= Press the corresponding Zoom preset switch.

Nudge/Bank Section

The Nudge/Bank section controls the display of any channels
in Normal mode on the D-Command surface. If any channels
are in any of the Custom Fader modes, they are not affected by
Bank or Nudge commands, and the other channels move
around them.

@ Nudge @ — —  Nudge Left and Right switches
@ Bank O ——————— Bank Left and Right switches

D-Command Nudge/Bank Section

Nudge Switches

The Nudge switches move the display of tracks on the control
surface to the left or right, one channel at a time.

To nudge the track focus forward or backward by one channel:

= With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right
Nudge switch.

Bank Switches

The Bank switches move the display of tracks on the controls
surface to the left or right by the number of available channels
on the control surface.

To nudge the track focus forward or backward by eight channels:

= With a track focused in the Focus Channel Strip, hold Con-
trol (Windows) or Command (Mac) and press the left or right
Bank switch.



Chapter 9: Management Sections

Window Management Section

The Window Management section includes controls for opening and closing Pro Tools windows on-screen. When a window is
open, its corresponding switch is lit.

MIDI Event List switch

Mic Pre switch

@_
™)
()
\[

Workspace Browser switch —( )

MIDI Event List Mic Pre

Transport switch

Memory Locations switch ( ) ( |) ( } Pan switch
Mem Loc Transport Pan
Edit switch
Mix switch —( ) ( ) ( ) Plug-in switch
Mix Edit Plug-In

D-Command Window Management section

Workspace Browser Switch

The Workspace Browser switch opens and closes the DigiBase
Workspace Browser. Hold Alt (Windows) or Option (Mac) and
press this switch to close all DigiBase windows.

MIDI Event List Switch

The MIDI Event List switch opens and closes the MIDI Event
List or brings it to the front.

Mic Pre Switch

The Mic Pre switch opens and closes the Mic Pre window for
the focused track.

Memory Locations Switch

The Memory Locations Switch opens and closes the Memory
Locations window

Transport Switch

The Transport switch opens and closes the Transport window

Pan Switch

The Pan switch opens and closes the Pan window for the fo-
cused track. Hold Alt (Windows) or Option (Mac) to close all
Pan windows.

Mix Switch

The Mix switch opens the Mix Window or brings it to the
front.

Edit Switch

The Edit switch opens the Edit Window or brings it to the
front.

Plug-in Switch

The Plug-in switch opens and closes windows for any cur-
rently targeted plug-ins in the session. Hold Alt (Windows) or
Option (Mac) to close all plug-in windows.
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Session Management Section

The Session Management section includes controls for ses-
sion-wide management and save operations.

Plug-in Clip Publish Redo

indicator switch switch
All Notes Off Save Undo
switch switch switch

Go To
switch

O 0O o

GoTo Cleaf Clip  All Notes Off Publish

Undo

Clear Clip
switch

D-Command Session Management section
Go To Switch

The Go To switch is used to focus a specific track onto the Fo-
cus Channel section on the Main Unit.

To go to a specific track:

1 Press the Go To switch.

2 Enter the track position number for the track and press En-
ter.

Clear Clip Switch and Plug-in Clip Indicator

D-Command indicates occurrences of signal clipping on au-
dio tracks, sends, and plug-ins. (Clip indication on D-Com-
mand follows the clip settings in the Pro Tools Display prefer-
ences.)

The Clear Clip switch lights if a clip occurs on an audio track
or on a send anywhere in the session. The Plug-in Clip indica-
tor lights if a clip occurs on a plug-in anywhere in the session.
In addition, D-Command shows clipping with the following
indicators:

e If an audio track clips, the meter clip LED for the clipping
channel’s lights red.

¢ If a send clips, the Send switch flashes in the Channel Strip
Mode controls section. In addition, if one of the encoders
on the channel strip is controlling the clipping send, the
corresponding encoder clip LED lights red.

¢ If a plug-in clips, the Insert switch flashes in the Channel
Strip Mode controls section. In addition, if one of the en-
coders on the channel strip is displaying the clipping
plug-in, the corresponding encoder clip LED lights red.

Pressing the Clear Clip switch clears all clip indicators on
D-Command, and in the Pro Tools session.
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All Notes Off Switch

The All Notes Off switch can be used to silence stuck notes
with MIDI devices. It sends an All Notes Off message to each
channel for all connected MIDI devices.

Publish Switch

The Publish switch executes the Send Session Via DigiDelivery
command in Pro Tools, opening the Send To DigiDelivery di-
alog on-screen.

Save Switch

The Save switch executes the Save Session command in
Pro Tools. Whenever a change is made in a session and the
Save command is available, this switch lights.

To save the current session:

1 Press the Save switch. The switch flashes, prompting confir-
mation of the Save command.

2 Do one of the following:

¢ To confirm the Save command, press the Save switch
again.

—Or —

¢ To cancel the Save command, press Escape.

Redo Switch

The Redo switch executes the Redo command in Pro Tools.

Undo Switch

The Undo switch executes the Undo command in Pro Tools.



Soft Keys Section

The Soft Keys section provides access to a wide range of Pro Tools commands directly from the control surface. It also provides
access to preferences and settings specific to D-Command. The section consists of six variable-function soft keys and displays,
along with a matrix of mode switches that change the functions shown in the displays. When a function is shown in a Soft Key

display, pressing the corresponding Soft Key switch activates that function.

Some controls invoke multiple pages of Soft Key functions. To cycle through multiple pages of the same control, repeatedly press
the control switch.

Soft Keys

Management
Management (= (@ @ ( )
controls —_— \—-—/ (O O
Snapshot Group Track Playlist Window.
Edit
Edit (= i =\ (O)
controls \-— \—
Func 1 Func 2 Func 3 Modes Tools
Mem/MIDI Console Prefs
Memory/MIDI (m— @
controls -/
Mem Loc MIDI User Operation Meter
. Automation
Automation (a— (a—
controls [ [ @ @ (O)

D-Command Soft Keys section

Default Soft Key Display

AutoMatch

Join Actions Modes Uity

Console Preference Utility

controls

When a session is first opened, the Soft Key displays show ba-
sic information about the session:

Session Name

Bit: Session Bit Depth

Sampl: Session Sample Rate
File: Session File Type

Tcode: Session Time Code Rate

Delay Compensation On/Off Status

Delay Compensation can be toggled on and off from this dis-
play. The other settings shown above cannot be changed from
the Soft Keys section.

switch

Soft Key switches
and
displays

Audio Files

(5

Audio/ Files

switch

)

Show/Hide

Track Size

Show/Hide
switch

Track Size

@ 0

Down

switches

Soft Keys Display with Pro Tools Dialogs

When Pro Tools has a dialog on-screen, the two lower Soft
Keys temporarily display “Escape” and “Enter,” letting you
cancel or confirm the dialog from the control surface.

Exiting from Soft Key Modes

You can exit a Soft Key mode and return to the top level Soft
Key display by holding Control (Windows) or Command
(Mac) and pressing the currently lit Soft Key switch.
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Management Controls

Management

O O 0O O O

Snaphot Gre[up Tra[k Play|ist Wini ow

Snapshot Group Track Playlist Window
switch switch switch switch switch

Management controls
Snapshot Switch
The Snapshot switch displays the following commands:

Page 1
e Captre: Capture
e Punch Captre: Punch Capture
e Snap 1-4: Snapshots 1-4
Pages 2-12
* Snap 5-48: Snapshots 5-48 (in groups of 4)

Group Switch
The Group switch displays the following commands:

Page 1
e Create Edit: Create Edit Groups
¢ Create Mix: Create Mix Groups
¢ Create Both: Create Mix and Edit Groups
e Suspnd: Suspend Groups
¢ Modify: Modify Groups

Page 2
e Preset 1-6: Recall Group Presets 1-6

Track Switch

The Track switch displays the following commands:
e New Track: Track > New
e Dup Track: Track > Duplicate
¢ Delete Selectd: Track > Delete
e Make Act/In: Track > Make Active/Inactive
¢ Bounce: File > Bounce To > Disk

Playlist Switch

The Playlist switch displays the following playlist commands:

e New: New Playlist

e Duplicate: Duplicate Playlist

e Delete Audio: Delete Unused Audio Playlists
¢ Delete MIDI: Delete Unused MIDI Playlists
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Window Switch

The Window switch displays the following commands:

Page 1

Auto Enabls: Window > Automation Enable
Track Arm > Track Arming

Beat Det: Event > Beat Detective

Session Setup: Setup > Session

Tasks: Window > Task Manager

Projct Browser: Window > Project Browser

Page 2

Color Pallet: Window > Color Palette
Big Countr: Window > Big Counter
Undo Histry: Window > Undo History
Disk Space: Window > Disk Space
Video Window: Window > Video
System Usage: Window > System Usage

Page 3

1/O Setup: Setup > I/O

HW Setup: Setup > Hardware

PB Engine: Setup > Playback Engine
Disk Alloc: Setup > Disk Allocation
Preferences: Setup > Preferences
Peripherals: Setup > Peripherals



Edit Controls

Edit

@ @ O

ic 2 Fullc 3 Mcles Tc

@

Fulc 1 Fu pls

Modes
switch

Tools

Function 1 Function 2  Function 3
i i switch

switch switch switch

Edit controls
Edit Function 1 Switch (Basic Edit Commands)
The Edit Function 1 switch displays the following commands:

Page 1
e Cut: Edit > Cut
e Copy: Edit > Copy
e Paste: Edit > Paste
e Clear: Edit > Clear
e TCE To TLSel: Edit > TCE Edit to Timeline Selection

Page 2
e CutSP AllAut: Edit > Cut Special > All Automation
e CopySP AllAut: Edit > Copy Special > All Automation
e CutSP PanAut: Edit > Cut Special > Pan Automation
e CopySP PanAut: Edit > Copy Special > Pan Automation
e CutSP PI Aut: Edit > Cut Special > Plug-in Automation
e CopySP PI Aut: Edit > Copy Special > Plug-in Automation

Page 3
e PsteSP Merge: Edit > Paste Special > Merge
e ClIrSP AllAut: Edit > Clear Special > All Automation
e DPsteSP RepFil: Edit > Paste Special > Repeat to Fill Selec-
tion
e CIrSP PanAut: Edit > Clear Special > Pan Automation

e PsteSP ToCurr: Edit > Paste Special > To Current Automa-
tion Type
e ClIrSP PI Aut: Edit > Clear Special > Plug-in Automation

Edit Function 2 Switch
The Edit Function 2 switch displays the following commands:

Page 1
e Trim to Sel: Edit > Trim > To Selection
e Cpture Region: Edit > Capture Region
e Seprte: Edit > Separate Region
e Heal Seprtn: Edit > Heal Separation
e Consolidate: Edit > Consolidate Selection
e Time Stamp: Audio Regions List > Time Stamp Selected

Page 2

SendTo Back: Region > Send to Back
SendTo Front: Region > Bring to Front
Group Region: Region > Group
Ungrp Region: Region > Ungroup
Ungrp All: Region > Ungroup All
Regrp Region: Region > Regroup

Edit Function 3 Switch (Manipulation Commands)

The Edit Function 3 switch displays the following commands:

Page 1

Page 2

Duplicate: Edit > Duplicate

Repeat: Edit > Repeat

Shift: Edit > Shift

Insert Silnce: Edit > Insert Silence
Lock Region: Region > Lock/Unlock
Mute Region: Region > Mute/Unmute

Loop Region: Region > Loop Region

Unloop Region: Region > Unloop Region

ID/Rem SyncPT: Region > Identify/Remove Sync Point
Rename Rgns: Region > Rename Regions

Quantz ToGrid: Region > Quantize to Grid

RgnDrop: Region List > Timeline Drop Order >
L to R/Top to Bottom

Edit Modes Switch

The Edit Modes switch displays the Pro Tools Edit modes:

Shuffl: Shuffle Mode

Spot: Spot Mode

Slip: Slip Mode

Grid Rel: Relative Grid Mode
Grid Abs: Absolute Grid Mode

Edit Tools Switch

The Edit Tool Tools switch displays the Pro Tools Edit Tools.
To cycle through multiple versions of the same tool, repeat-
edly press the corresponding Soft Key.

Zoom: Normal/Single Zoomer tools

Trim: Standard/Scrub/TCE Trimmer tools
Select: Selector tool

Grabbr: Time/Separation/Object Grabber tools
Scrubber tool

Pencil: Square, Random, Free, Line, Triangle, Arc,
S-Curve

To select the Smart Tool, press any two buttons for the Trim-
mer, Selector or Grabber simultaneously.
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Memory/MIDI Controls

Mem/MIDI

£

Mer|i Loc MIPI

Memory Location  MIDI
switch switch

Memory/MIDI controls

Memory Location Switch

The Memory Location switch (“Mem Loc”) displays the names
of Memory Locations in pages of six. The Soft Key display is
paged by repeatedly pressing the Memory Location switch in
the Soft Keys section. To page backwards, hold Shift while
pressing the Memory Location switch.

MIDI Switch
The MIDI switch displays the following commands:

Page 1
e Wait Note: Transport Window > Wait for Note button
e Count Off: Transport Window > Countoff button
e Merge Record: Transport Window > MIDI Merge button
¢ Transpose: Event > MIDI > Transpose
e Veloc: Event > MIDI > Change Velocity
¢ Click On/Off: Options > Click

Page 2
e Change Tempo: Change Tempo window
e Change Meter: Change Meter window
e Split Notes: Event > MIDI > Split Notes
e Select Notes: Event > MIDI > Select Notes
¢ Quantz: Event > MIDI > Grid/Groove Quantize
e Input Quantz: Event > MIDI > Input Quantize

Page 3
e Write RTProp: Track > Write MIDI Real Time Properties

e Remove DpNote: Event > Remove Duplicate Notes

Audio Files Switch

The Audio Files switch displays the following commands for
importing and exporting data into Pro Tools:

Open Recent Session Commands

When no session is open, the Audio Files switch displays the
names of the ten most recent Pro Tools sessions in its display
pages 1 and 2.

When a session is open, the Audio Files switch displays the
names of the ten most recent Pro Tools sessions in the first
two pages in its display pages 3 and 4.
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To open a recent session:

1 In the Soft Keys section, press the Audio Files switch repeat-
edly until the session name is displayed in the Soft Keys.

2 Press the Soft Key that corresponds to the session name.

Audio Files Switch (Page 1)
e Import Audio: File > Import > Audio
e Import MIDI: File > Import > MIDI
e Import SesDat: File > Import > Session Data
e Import RgnGrp: File > Import > Region Groups

e Import Video: File > Import > Video

Audio Files Switch (Page 2)
e Export Region: Region List Menu > Export Regions as
Files
e Export MIDI: File > Export > MIDI

e Export OMFAAF: File > Export > Selected Tracks as New
AAF/OMF

e Export Text: File > Export > Session Info As Text

Audio Files Switch (Page 3 and 4)

e Recent Sessns: Open recent sessions (listed by name)

Show/Hide Switch

The Show/Hide switch displays commands from the
Show/Hide Tracks List menu.

Show/Hide Switch (Page 1)
e Show All: Show All Tracks
e Hide All: Hide All Tracks
e Show Selctd: Show Only Selected Tracks
¢ Hide Selctd: Hide Only Selected Tracks
e Show Inactv: Show Only Inactive Tracks

e Hide Inactv: Hide Only Inactive Tracks

Show/Hide Switch (Page 2)
e Show Audio: Show Only Audio Tracks
e Hide Audio: Hide Only Audio Tracks
e Show Aux: Show Only Auxiliary Inputs
e Hide Aux: Hide Only Auxiliary Inputs
e Show MIDI: Show Only MIDI Tracks
e Hide MIDI: Hide Only MIDI Tracks

Show/Hide Switch (Page 3)

e Show Instmt: Show Only Instrument Tracks
¢ Hide Instmt: Hide Only Instrument Tracks
e Show VCA: Show Only VCA Master Tracks
e Hide VCA: Hide Only VCA Master Tracks

You can select multiple Show/Hide categories by holding Shift
while pressing the corresponding Soft Key.



Console Preferences

Console Prefs
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Console Preferences

The Console Preference switches control D-Command prefer-
ences only, and do not affect the Pro Tools on-screen display.

User Switch

The User switch displays a user-configurable, custom set of
Soft Keys, chosen from any of the other Soft Key displays. To
cycle through both pages of User Soft Key selections, repeat-
edly press the User switch.

To add a Soft Key command to a User Soft Key selection:

1 In the Soft Keys section, press the User switch repeatedly to
display the page (Page 1 or Page 2) where you want to add the
operation.

2 Press the Soft Keys to display the page containing the oper-
ation you want to add.

3 Hold Control (Windows) or Command (Mac) and press the
Soft Key for the operation.

To remove a Soft Key command from the User Soft Key selection:

1 Press the User switch repeatedly to display the operation
you want to remove.

2 Hold Control (Windows) or Command (Mac) and press the
Soft Key for the User operation.

Meter Switch

The Meter switch displays the following D-Command meter
preferences:

SndMtr (Send Meters) Toggles send metering on channel ro-
tary encoders on and off.

InsMtr (Insert Meters) Toggles plug-in metering on channel
rotary encoders on and off.

VCAMtr (VCA Meters) Toggles metering of VCA slaves on
channel rotary encoders on and off.

Meters Toggles channel metering between pre- and post-fader
modes.

CtrMtr (Center Meters) Toggles the 8-channel meter display
on the Main Unit meter bridge between main output levels
and the focused track.

RefLvl (Reference Level) Lets you change the D-Command
meter display to help monitor program material with respect
to different reference levels.

Operation Switch

The Operation switch controls operations specific to D-Com-
mand, and does not affect the Pro Tools on-screen display. For
details on setting preferences, see “Setting D-Command Pref-
erences” on page 24.

The Operation switch has three pages of Soft Key functions.

Operation Switch (Page 1)

BnklJus (Bank Justification) Determines whether banks of
channels in Normal mode are justified at the left, left center
(to the left of the Main Unit), right center, (to the right of the
Main Unit) or right side of the control surface.

CF Jus (Custom Fader Justification) Determines whether chan-
nels in Custom Fader mode are placed at the left, center-left,
center-right, or right side of the control surface.

Rotary (Rotary Encoder Mode) Determines responsiveness of
rotary encoder knobs. Fixed mode is at normal resolution. The
velocity modes set different rates of encoder acceleration. In
Fine mode, response is fixed and at fine resolution.

Encod (Encoder Order) Determines whether inserts, sends, and
pan controls will be displayed in order from top-to-bottom or
bottom-to-top on D-Command rotary encoders.

PIDef (Plug-in View Definition) Determines the view of plug-in
parameters in the Custom Fader section (Name view, Ex-
panded view, or Fader view).

FCStrp (Focus Channel Strip) Determines whether focusing a
channel in the Focus Channel section also places a duplicate
of the focused channel in the channel strip to the immediate
left of the Global Controls section.

When Focus Channel Strip is enabled, all controls and modes
are linked. You can, however, use four encoders simulta-
neously by using the Page Up or Page Down switches to bring
a different set of sends or inserts to the duplicate channel’s en-
coders.

Operation Switch (Page 2)

CFPlug (CF Bank Size for Plug-ins) Determines the number of
channels allocated for Custom Fader Plug-in mode.

CFGrp (CF Bank Size for Custom and Mix/Edit Groups) Deter-
mines the number of channels allocated for Custom Groups
mode.

CFTyp (CF Bank Size for Track Type) Determines the number
of channels allocated for Custom Fader Tracks mode.
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ApTrgt (Target Track from Application) Determines whether se-
lecting an Insert or Send on-screen focuses its track on the
D-Command Main Unit.

ChanWn (Channel Window Display) Determines whether dis-
playing plug-in or send pan parameters (by pressing an en-
coder Select switch) on D-Command opens the corresponding
plug-in or send window on-screen in Pro Tools. Also deter-
mines whether the Channel Select switches (in the Dynamics
or EQ sections) change the channel display of multi-mono
plug-ins.

¢ When this preference is set to “Yes,” the on-screen display
of plug-in and send windows changes to reflect the state of the
control surface.

¢ When this preference is set to “No,” the on-screen display of
plug-in and send windows does not change to reflect the state
of the control surface.

Import PIMaps (Import Plug-in Maps) Opens “Choose a map-
ping file” dialog in Pro Tools.

Export PIMaps (Export Plug-in Maps) Opens “Save Plug-in
Mapping As” dialog in Pro Tools.

For more information about importing and exporting
plug-in maps, see “Exporting and Importing .pim Files” on
page 107.

Select (Select Switch Latch Mode) Determines whether chan-
nel Select buttons follow latching or exclusive-or (non-latch-
ing) behavior when in Select mode.

Operation Switch (Page 3)

SoloFc (Focused Track Follows Solo) Determines whether a so-
loed track is automatically focused in the Focus Channel sec-
tion (this function works in both Select and Focus modes)

TchVal (Touch Display of Parameter Values On/Off) Turns off
the display of parameter values when faders or encoders are
touched.

Brdcst (Broadcast) Determines whether the XMON monitor-
ing system is in Broadcast mode, which prevents AFL and PFL
solo modes from changing the XMON Control Room Input
source.

2KbPan (Two-Knob Panning) Toggles linking of front and rear
pan controls in surround panner windows to facilitate
left-right motion in the surround field.

CFTrks (Custom Faders Display Hidden Tracks) Determines
whether tracks that are hidden in Pro Tools are displayed or
hidden in Custom Fader modes. Tracks that are hidden in
Pro Tools but shown in Custom Faders cannot be Selected or
Record enabled.
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Trk/Ed (Link Track and Edit Selection) Toggles the Options >
Link Track and Edit Selection option, which automatically se-
lects a track or range of tracks when a selection is made in the
track’s timeline.

A\ The duplicate Focus Channel strip is not available when
D-Command is in a Custom Fader mode.

Operation Switch (Page 4)

Import PIMaps (Import Plug-in Maps) Opens “Choose a map-
ping file” dialog in Pro Tools.

Export PIMaps (Export Plug-in Maps) Opens “Save Plug-in
Mapping As” dialog in Pro Tools.

Faders (Faders On/Off) Turns off D-Command faders to pre-
vent fader movement when monitoring a mix.

FilBnk (Always Fill Channel Strips When Banking) Toggles the
preference setting that maximizes the number of channels dis-
played in Normal mode when banking. When selected, bank-
ing follows end stop behavior.

FillICF (Always Fill Custom Faders When Banking) Toggles the
preference setting that maximizes the number of channels dis-
played in Custom Faders when banking. When selected, bank-
ing follows end stop behavior.

Automation Controls

Automation
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Automation controls
AutoMatch Switch

The AutoMatch switch enables AutoMatch command in Latch
or Write automation modes.

Join Switch

The Join switch is used to manually resume writing automa-
tion on all channels that were previously writing automation
after an automation pass is interrupted.



Actions Switch

The Actions switch displays the following commands:

Actions Switch (Page 1)
Prview (Preview) Puts Pro Tools in Preview mode

Punch Prview (Punch Preview) Executes the Punch Preview
command

Prview Suspnd (Preview Suspend) Suspends Preview mode
Captre (Capture) Executes the Capture command

Punch Captre (Punch Capture) Executes the Punch Capture
command

See “Previewing Automation” on page 108 and “Capturing
and Recalling Automation” on page 108 for more information
on these commands.

Actions Switch (Page 2)

Wrt To Start (Write To Start) Writes current automation val-
ues from the insertion point backward to the beginning of a
selection or track while performing an automation pass.

Wrt To Punch (Write To Punch Point) Writes current automa-
tion values back to the point where writing of automation be-
gan

Wrt To All (Write to All) Writes current automation values to
an entire selection or track while performing an automation
pass.

Wrt To End (Write to End) Writes current automation values
from the insertion point forward to the end of a selection or
track while performing an automation pass.

Wrt To Next (Write to Next Breakpoint) Writes current auto-
mation values from the insertion point forward to the next
automation breakpoint while performing an automation pass.

Snap Back Causes all Latch or Write enabled tracks to exit
their current automation pass and return instantly to the pre-
viously written automation levels. During playback, this com-
mand stops writing of automation without applying any Au-
toMatch ramping.

Actions Switch (Page 3)

Copy To Send Opens the Copy To Send dialog to allow copy-
ing of track control values to each selected track’s send (Edit >
Automation > Copy To Send).

Thin Auto (Thin Automation) Performs the Thin Automation
command. (Edt > Automation > Thin).

Colesc VCAAtm (Coalesce VCA Automation) Executes the
Track > Coalesce VCA Master Automation command

Colesc TrmAtm (Coalesce Trim Automation) Executes the
Track > Coalesce Trim Automation Command

Clear TrmAtm (Clear Trim Automation) Executes the Track >
Clear Trim Automation Command

Suspend TrmAtm (Suspend Trim Automation) Temporarily sus-
pends Trim automation to allow auditioning of Trim moves
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Modes Switch

The Modes switch displays the following D-Command Modes:

Modes Switch (Page 1)

AWrtTo Start (Auto Write to Start on Stop) Automatically
writes current automation values from the insertion point
backward to the beginning of a selection or track when the
transport is stopped after an automation pass.

By default, Automatic Write to Start on Stop mode is enabled
for a single automation pass only. To configure the mode to
remain enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWTrtTo Strt switch.

AWTrtTo Punch (Auto Write to Punch Point on Stop) Writes cur-
rent automation values back to where the current automation
pass began.

By default, Automatic Write to Punch Point on Stop mode is
enabled for a single automation pass only. To configure the
mode to remain enabled after an automation pass, hold Alt
(Windows) or Option (Mac) while pressing the AWrtTo Punch
switch.

AWTrtTo All (Auto Write to All on Stop) Writes current automa-
tion values to an entire selection or track when the transport
is stopped after an automation pass.

By default, Automatic Write to All on Stop mode is enabled for
a single automation pass only. To configure the mode to re-
main enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWTrtTo All switch.

AWTrtTo End (Auto Write to End on Stop) Writes current auto-
mation values from the insertion point forward to the end of
a selection or track when the transport is stopped after an au-
tomation pass.

By default, Automatic Write to End on Stop mode is enabled
for a single automation pass only. To configure the mode to
remain enabled after an automation pass, hold Start+Alt
(Windows) or Control+Option (Mac) while pressing the
AWTrtTo End switch.

AWrtTo Next (Auto Write to Next Breakpoint on Stop) Writes
current automation values from the insertion point forward to
the next automation breakpoint when the transport is
stopped after an automation pass.

Automatic Write to Next Breakpoint on Stop remains enabled
after each automation pass, until you disable it by pressing the
lit AWrtTo Next switch.

Auto Join Auto Join is used in Latch mode to automatically re-
sume writing of automation after the transport is stopped and
started again during an automation pass.
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Modes Switch (Page 2)

Wrt To Currnt (Write To Current Parameter) Writes the current
control value to the currently displayed automation parame-
ter (Edit > Automation > Write To Current).

Wrt To All Ena (Write To All Enabled Parameters) Writes cur-
rent control values to all enabled automation parameters (Edit
> Automation > Write To All Enabled).

Trm To Currnt (Trim To Current Parameter) Applies the current
trim value to the currently displayed automation parameter
(Edit > Automation > Trim To Current).

Trm To AllEna (Trim To All Enabled Parameters) Applies cur-
rent trim values to all enabled automation parameters (Edit >
Automation > Trim To All Enabled).

Gld To Currnt (Glide To Current Parameter) Applies a transition
between automation values to the currently displayed auto-
mation parameter (Edit > Automation > Glide To Current).

Gld To AllEna (Glide To All Enabled Parameters) Applies a tran-
sition between automation values to all enabled automation
parameters (Edit > Automation > Glide To All Enabled).

Modes Switch (Page 3)

Match Time (AutoMatch Time) Lets you use the Scrub/Shuttle
wheel to set AutoMatch time, the amount of time it takes for
automation values to return to the previously written values
after an automation pass stops.

Glide Time (AutoGlide Time) Lets you use the Scrub/Shuttle
wheel to set AutoGlide time, the amount of time it takes for
surround pan values to move between two points in an auto-
mation pass performed with the optional Surround panner.

LchStp (Allow Latch Prime in Stop) Toggles the Allow Latch
Prime in Stop preference, which allows tracks in Latch mode
to be primed for writing automation while the transport is
stopped. When a track in Latch mode is primed for writing au-
tomation, its Latch mode indicator flashes.

PlgAut (Plug-In Controls Default to Auto-Enabled) Toggles the
preference that enables plug-in controls automatically when
they are added to a track

AutCls (Coalesce when Removing Slaves from VCA Group) Tog-
gles the preference that automatically coalesces automation to
slave track when they are removed from a VCA-controlled

group

TrmCols (Coalesce Trim Automation) Sets the preference that
determines when Trim automation is coalesced (After Every
Pass, On Exiting Trim Mode, or Manually)



Modes Switch (Page 4)
MmtTch (Latching Behavior for Switched Controls in Touch)

Toggles the preference that determines the behavior of
switched controls in Touch mode.

StdVCA (Standard VCA Logic for Group Attributes) Toggles the
preference that disables normal group linking behavior when
a VCA is assigned to a group

WrtWrn (Suppress Automation “Write To” Warnings Toggles
the preference that suppresses dialogs after invoking the Write
To Start/End/All commands

PanLnk (Use Absolute Pan Linking) Toggles the preference that
determines the behavior of pan controls in grouped tracks

SndTrm (Include Sends in Trim Mode) Toggles the preference
that determines whether Send Faders go into Trim mode
along with Main Volume

CtlUnd (Include Control Changes in Undo Queue) Toggles the
preference that determines whether mixer changes appear in
the Undo queue

Utility Switch

Utility

Utility switch

The Utility switch places the D-Command in Utility mode.
When D-Command is in Utility mode, this switch flashes.

Utility mode lets you view D-Command system information,
name D-Command units, run D-Command diagnostic tests,

and set certain D-Command hardware preferences. For com-
plete information on Utility mode, see Appendix A, “Utility

Mode”

Track Size Switches

Track Size

((\) Track Size Up
— switch

Up

(\ Track Size Down
) switch

Down

Track Size controls

The Track Size Up and Down switches increase and decrease
the track height of all tracks where a selection or edit cursor is
present.
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Chapter 10: Monitor and Meter Sections

Monitor Section Controls

The Monitor section includes a full set of controls for the control room monitoring, headphone/cue, and talkback/listenback
sections of D-Command. All input and output connections to the D-Command monitoring system are made on the XMON in-
terface, which is connected to the D-Command console with the XMON cable, and remotely controlled from this section.

Input source switches Cue Output Channel Select  Talkback/Listenback
and Output controls  controls and Mode switches controls
| ‘ | | Monitor
Inputs Cues Listen
Sum  Stereo 1 Phones  Studio LS Mic 1 Mic 2
Alt Surr Stereo 2 Cue 1In | I TENEEE
Main  Stereo 3 Cue2In AFL/PFL | Set up L © R AFL Internal  External
Ls LFE Rs PFL

Solo @ @ 0 Mute

@ Calibrated Mono Level

Alt Mini Set Source 1B
Main On Dim Mute Auto Talkback

Monitor
Mode
controls

D-Command Monitor section
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Input Source Switches and Output Controls

Inputs
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— Alt Output
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On/Off switch
Mini Output
On/Off switch

Main Output
On/Off switch

Main

Input source switches and Output controls

Input Source Switches

The monitor system has five input sources:
e Main Inputs (6 channels)
e Surround Inputs (6 channels)
e Stereo 1 Inputs (2 channels)
e Stereo 2 Inputs (2 channels)
e Stereo 3 Inputs (2 channels)

These sources are selected by pressing their corresponding In-

put switches, which light when the source is activated.

Input Level Trim Mode

Each input source can be trimmed independently, to allow for

setting of different reference levels or to compensate for differ-

ences in gain structure. Available trim values range from
—20 dB to +10 dB in 0.5 dB steps.

To trim input levels:

1 Press and hold the Input Source Selector switch for the input
you want to trim, until the switch flashes.

2 Turn the Main Output Level encoder knob to set the trim
value. The monitor section display shows “Trim” and the trim
value in dB.

3 Press the flashing Input Source Selector switch to exit Trim
mode.
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Sum Switch

In normal operation, the Input Source switches follow exclu-
sive-or (non-latching) behavior, allowing only one source to
be monitored at a time.

However, D-Command has a Sum mode that allows multiple
input sources to be monitored at the same time. When Sum
mode is on, multiple input source switches can be active.

Sum mode ignores any input trim values when it is active.

To add or remove inputs in Sum mode:

1 Press the Sum switch. The switch lights to indicate Sum
mode is on.

2 Press any number of Input Source switches to toggle their
corresponding inputs on or off. It is possible to turn all inputs
off in this mode.

To exit Sum mode:

= Press the Sum switch again. Monitoring reverts to the input
that was selected when you entered Sum mode.

Output On/Off Switches

The monitor system has three outputs:
e Main Control Room Outputs (6 channels)
e Alt Control Room Outputs (6 channels)
e Mini Control Room Outputs (2 channels)

Only one output can be active at a time. The Output On/Off
switches follow exclusive-or (non-latching) behavior. When
you activate an output, its name and gain value (in dB) are
shown in the monitor section display.

Output Level Control

The monitor system output section has a touch-sensitive ro-
tary encoder for control of output level. When the encoder
knob is touched, the monitor section display shows the cur-
rent level in dB. Gain ranges from a minimum of -INF to a
maximum of +10 dB, in 1 dB steps.

Output Level Trim Mode

Each output level control can be trimmed independently, to
allow for setting of different reference levels or to compensate
for differences in gain structure. Available trim values range
from -20 dB to +10 dB, in 0.5 dB steps.

To trim output levels:

1 Press and hold the On/Off switch for the output you want to
trim, until the switch flashes.

2 Turn the encoder knob to set the trim value. The monitor
display shows the trim value in dB.

3 Press the flashing On/Off switch to exit Trim mode.



Headphone/Cue Controls

Cues
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Cue controls

Cue Input Source Switches

The Headphone/Cue monitor system has three input sources:
e Cue 1 Input (2 channels)
e Cue 2 Input (2 channels)
* Main Monitor Input (2 channels)

Cue Output On/Off Switches

The Cue system has four available outputs:
e Cue 1 (2 channels)
e Cue 2 (2 channels)
e Headphone (2 channels)
e Studio Loudspeaker (2 channels)

The two Cue Outputs, Headphone Output, and Studio Loud-
speaker Output can be active in any combination, including
all on or all off.

The following table shows possible outputs for each input
source. (Talkback can be added to each of the outputs.)

Input Possible Outputs
Cue 1 Cue 1, Headphone, Studio LS
Cue 2 Cue 2, Headphone, Studio LS

Main Monitor Cue 1, Cue 2, Headphone, Studio LS

To assign an input source to an output:

1 Press the switch for the output for which you want to assign
an input. The switch will light, and the Monitor LED display
will show the currently selected source.

2 Press the Set Source switch repeatedly to cycle through the
available source choices.

Assign Talkback Switch

The Assign Talkback switch lets you add the talkback signal to
any of the Headphone/Cue system outputs. The Assign Talk-
back switch lights to indicate that talkback is active for a given
output.
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Output Channel Select Controls

Channel Select switches
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Output Channel Select controls

Set Up switch

Solo/Mute switch
and indicators

Set Up Switch

The Set Up switch resets output trim levels to their default val-
ues.

Channel Select Switches

The Channel Select switches let you solo or mute individual
channels of the Control Room outputs. The function of the
Channel Select switches depends on the mode of the
Solo/Mute switch.

¢ When the mode is set to Solo, each Channel Select switch
solos the corresponding output channel.

¢ When the mode is set to Mute, each Channel Select switch
mutes the corresponding output channel.

In both modes, the Channel Select switches follow latched be-
havior, allowing multiple outputs to be soloed or muted. The
Channel Select switches light to indicate that they are active.

There are Channel Select switches for the following channels:
e L (Left)
e C (Center)
* R (Right)
e Ls (Left Surround)
¢ Rs (Right Surround)
e LFE

These choices support all possible channel configurations in
Pro Tools. A maximum of six channels (5.1 surround) may be
in use at any time.
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Individual Output Trim Mode

Each output channel can be trimmed individually for each of
the three control room outputs (Main, Alt, and Mini), allow-
ing you adjust the channel balance for each set of control
room speakers. Trim values are stored for each of the three
outputs. Available trim values range from -30 dB to +10 dB, in
0.5 dB steps.

To trim the output level for an individual output channel:

1 Activate the control room output (Main, Alt, or Mini) whose
channel levels you want to trim.

2 Press and hold the Channel Select switch for the output
channel you want to trim, until the switch flashes.

3 Turn the Output Level encoder to set the trim value for the
channel. The monitor display shows “Trim” and the trim
value in dB.

4 Press the flashing Channel Select switch to exit Trim mode.

5 Repeat the above steps for each output channel and each set
of outputs (Main, Alt, or Mini) you want to trim.

Solo/Mute Switch and Indicators

The Solo/Mute switch toggles the function of the Channel Se-
lect switches between Solo and Mute modes. The indicators
light to indicate which mode is active.



AFL and PFL Switches

The AFL and PFL switches invokes After Fader Listen and Pre
Fader Listen Solo modes.

AFL and PFL modes send signal to a separate output path with
independently adjustable levels for each mode. The XMON
Control Room Input source is automatically changed to mon-
itor the AFL/PFL input, unless you put D-Command in Broad-
cast mode (see “Broadcast Mode for AFL and PFL Monitoring”
on page 89). This lets you monitor the soloed channels in the
Main control room monitors (with Broadcast mode off) or in
a dedicated solo monitoring system (with Broadcast mode
on).

A\ AFL and PFL Solo modes require the use of the Surround
Mixer plug-in.
To select the Solo mode:

1 Press the AFL or PFL switch in the D-Command Monitor sec-
tion to select the corresponding Solo mode.

Setting AFL and PFL Levels

Levels can be set separately for AFL and PFL modes from the
D-Command Monitor section.

To set the AFL or PFL level:

1 Press the AFL or PFL switch in the D-Command Monitor sec-
tion.

2 Turn the Cue output level control. The AFL/PFL level is
shown in the Monitor displays.

To set the AFL or PFL level to its default setting:

1 Press the AFL or PFL switch in the D-Command Monitor sec-
tion.

2 Hold Alt (Windows) or Option (Mac) and touch the Cue
output level control.

Broadcast Mode for AFL and PFL Monitoring

You can put the D-Command monitoring system in Broadcast
mode, which prevents AFL and PFL solo modes from changing
the XMON Control Room Input source. This lets you solo
channels while preserving the main monitor mix.

You can then use the AFL/PFL path selector in the I/O Setup
dialog to route the AFL/PFL solo signal from the Pro Tools au-
dio interface to a separate set of speakers or headphones.

To put the XMON monitoring system in Broadcast mode:

1 Press the Operation switch in the Soft Key section.

2 Press the Soft Key that corresponds to “Broadcast”

While in Broadcast mode, any channels soloed while in AFL or
PFL are still sent to the AFL/PFL path, but XMON does not
switch the Control Room Input source to monitor that path.

While in Broadcast mode, any channels soloed while in SIP
mode will still cause all other tracks to be muted.
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Talkback/Listen System

Listen
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—-— Select switches

Mic 1 Mic 2

Talkback

Internal Talkback (f)) ((\) External Talkback
switch - = switch
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Talkback/Listen
Level control

Auto Talkback
switch
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Control Room Output controls

Talkback Controls

The Talkback system has two talkback microphone inputs
(one external, one built-in) both using the touch-sensitive ro-
tary encoder for control of output volume. When either
switch is lit, the monitor section display show the correspond-
ing volume level in dB. Level control on each ranges from a
minimum level of —INF to a maximum level of +30 dB.

Talkback Level Control

When the External Talkback switch is lit, the Level control ad-
justs the volume for the external talkback microphone. When
the encoder knob is touched, the monitor section display
shows the level in dB.

The Talkback Level control also adjusts the volume of the
built-in (Internal) microphone, located on the meter bridge of
the D-Command Main Unit.

Talkback Dim Function

When Talkback is engaged, the Dim switch lights and the Dim
function is automatically applied to the Main outputs. Any
adjustment of the Dim level affects both the Talkback Dim
function and the Control Room Output Dim function.

To set the Dim level:

1 Press and hold the Assign Talkback switch until the switch
flashes.

2 Turn the Cue Output Level encoder to set the Dim value.
The monitor section shows the Dim value in dB.
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Auto Talkback Switch

The Auto Talkback switch activates a mode in which the talk-
back and listen microphones are automatically turned on
whenever the Pro Tools transport is not in Play or Record.
When Auto Talkback is active, the Auto Talkback switch
lights, and the Talkback switches flash.

While in Auto Talkback mode, you can temporarily disable
and re-enable talkback, while staying in Auto Talkback mode.

To temporarily disable Talkback while in Auto Talkback mode:

= Press either of the flashing Talkback switches.

To re-enable talkback while in Auto Talkback mode:

= Double-press either Talkback switch so it flashes again.

Talkback Switch

The Talkback switch, located at the bottom of the Channel
Strip Master section on the Main Unit, controls the D-Com-
mand Talkback function.

Auto Mode

(@

Write Trim

(0 ()

Touch  Read

00

Latch Off

Talkback switch

Talkback
Dbl Press to Latch

Talkback switch

The Talkback switch can follow momentary or latched behav-
ior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to
indicate that talkback is active. Press the switch again to turn
off talkback.



Listen Control

The Listen system has two selectable microphone inputs, both
using the touch-sensitive rotary encoder for level control.

Listen Mic Select Switches

There are two Listen Mic Select switches for the external listen
microphone inputs:

e Micl
e Mic 2

Either or both of these inputs can be active at any time. When
one input is active, the encoder controls the level of that input
independently. When both inputs are active, the encoder con-
trols both levels simultaneously, maintaining any relative off-
set between the two.

Level control ranges from a minimum level of —INF to a max-
imum level of +30 dB.

Dim Level Control

The Dim Level control lets you adjust the amount of level re-
duction applied by the Dim switch, located at the bottom of
the Monitor section. Level reduction ranges from -30 dB to
0 dB, in 1 dB steps.

When the Dim encoder knob is touched, the monitor section
display shows “Dim” and the gain reduction in dB.

Monitor Output Mode Controls

Calibration Mode () €2 Mono switch

switch
Calibrated Mono

Dim switch ——— (}7 Mute switch

Dim Mute
Monitor Output Mode controls

Calibration Mode Switch

The Calibration Mode switch invokes a mode that changes the
output value displayed by the Monitor section display from
gain (expressed in dB) to sound pressure level (expressed in

dB SPL) for each of the control room outputs. This switch
lights when an SPL value is shown for the active output.

To display output levels in dB SPL, you must first calibrate
each output. This SPL calibration requires the use of a pink
noise source (or other reference material) and a sound pressure
level meter to measure the output of individual control room
speakers.

To calibrate Control Room outputs to display SPL:

1 Send the reference material to the Main Control Room Out-
puts, and set the output level in Pro Tools to your studio ref-
erence level (for example, —18 dBFS).

2 Pan the signal to center (so that equal level is sent to all
Main Control Room Output speakers).

3 Set the speaker-to-speaker balance for all speakers in the sys-
tem using Output Trim mode for each channel, using the
sound pressure level meter to measure SPL at the mix position.
See “Individual Output Trim Mode” on page 88.

4 Solo the Center speaker, and adjust the Main Control Room
Output level encoder until the sound pressure level meter
measures the target reference level (for example, 85 dB) at the
mix position.

5 Press and hold the Calibration Mode switch until it flashes.

6 Adjust the Main Control Room Output level encoder until
the target reference level is displayed in the Monitor Section
display.

7 Press the flashing Cal switch.

8 Repeat steps 4-7 for the Alt and Mini outputs.

To toggle the output display between dB and dB SPL:

1 Select the output whose display you want to toggle (Main,
Alt, or Mini).

2 Press the Calibration Mode switch.

¢ When the Calibration Mode switch is lit, output is displayed
in dB SPL.

& When the Calibration Mode switch is unlit, output is dis-
played in dB.

Mono Switch

The Mono switch mixes the Left and Right signals of any of
the output modes (any surround channels are not affected) to
provide mono output, useful for checking phase and balance
relationships. The Mono switch lights to indicate that it is ac-
tive.

Mono Trim Mode

Mono output can be trimmed to adjust its reference level in
comparison to other outputs. Available trim values range from
-12 dB to 0 dB, in 0.5 dB steps.

To trim mono output:

1 Press and hold the Mono switch until it flashes.

2 Turn Alt Output encoder knob to set the Mono trim value.
The monitor display shows “Trim” and the trim value in dB.

3 Press the flashing Mono switch to exit Trim mode.
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Dim Switch

The Dim function applies an adjustable gain reduction to the
Control Room outputs. This function affects all three output
destinations. The Dim switch toggles the dim function on and
off, and lights to indicate that it is active.

Mute Switch

The Mute switch toggles the mute state for all Control Room
outputs. Mute operates globally on all three output destina-
tions. The Mute switch lights to indicate that it is active.

If the Mute switch on the XMON interface front panel is acti-
vated, the Mute switch on D-Command must be used to un-

mute the monitor system. (Outputs cannot be unmuted from
XMON front panel.)

92 D-Command Guide



Meter and Time Code Displays (Main Unit)

Time Scale display format indicators

Time Code

HM| VS =
HMLSF
FeetFims =
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Time Scale display
Channel Strip Meter displays Output Meter displays
Talkback Microphone

Meter and Time Scale displays (Main Unit)

Meters

The Channel Strip Meter display features dual 32-segment LED bar graphs for each channel, and can display pre- or post-fader lev-
els depending on the D-Command Meter Preferences setting. In Custom Fader mode, these meter displays can show plug-in input
and output meters, gain reduction meters for dynamics plug-ins, and other parameters. The top LED is red and indicates clipping
on the corresponding channel or parameter.

The Output Meter display includes eight 32-segment LED bar graphs with clip indication for displaying output levels or the level
of the track focused in the Focus Channel Strip, depending on the D-Command Meter Preferences setting.

For details on setting meter preferences, see “Meter Preferences” on page 27.

Time Scale Displays

The Time Scale displays on the Main Unit mirrors the Main Time Scales in Pro Tools.

Time Scale Display Format Indicators

The indicators to the left of the Time Scale displays show the currently displayed format for both the Main Time Scale and the
Sub Time Scale. Formats include:

e Hours:Minutes:Seconds:Milliseconds
e Hours:Minutes:Seconds:Frames
e Feet+Frames

e Bars|Beats

Talkback Microphone

The built-in D-Command talkback microphone is located between the Meters and the Time Scale display.
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Setting D-Command Meters for Different Reference Levels

The Pro Tools Reference Level meter preference lets you change the D-Command meter display to help monitor program material
with respect to different reference levels.

At each setting except 0 dB, a single LED lights continuously across the meter bridge at a fixed point to indicate that reference
level. You can then compare the peaks of the program material to the indicated level.

The following reference level settings are available:

0 dB This is the normal setting used for referencing material to a O dB (full code) reference level.
-14 dB This reference level setting lights a single LED at —-14 dB across the meter bridge.

-18 dB This reference level setting lights a single LED at -18 dB across the meter bridge.

—-20 dB This reference level setting lights a single LED at —-20 dB across the meter bridge.

To set a D-Command meter reference level:

1 In the Soft Keys section, press the Meter switch.
2 Press the Soft Key that corresponds to “RefLvl” to cycle among the meter reference level settings.

3 Press the Meter switch to exit.
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Chapter 11: Operating Modes

The power and flexibility of D-Command lies in its different
operating modes, which let you customize the behavior of its
channel strip controls to fit your workflow.

The two types of D-Command operating modes are Normal
mode and the four Custom Fader modes. This section provides
an overview of each mode and its associated commands.

Normal Mode

In Normal mode, Pro Tools tracks are displayed on D-Com-
mand in a standard console format. In this mode, channel
strips correspond to a track in the session, and most of the
channel strip controls correspond directly to on-screen con-
trols or views in Pro Tools:

¢ Channel Fader controls channel volume

¢ Channel Display shows track name, and track volume when
fader is touched

# Pan switch shows Pan values on encoders (this is the default
view when a new track is created)

< Inserts switch shows Insert name on encoders

# Sends switch shows name of Send on the encoder display,
and Send level on the encoder LED ring

Assigning Elements to Tracks

You can assign Inputs, Outputs, Inserts, and Sends to tracks di-
rectly from D-Command by entering Assign mode.

To assign an input or output to a track:

1 Press the Assign Inputs switch or Assign Outputs switch to
enter the corresponding Assign mode. Input and output as-
signments are displayed and edited on the lower encoder.

2 If necessary, press the Bypass/Mute/Pre switch repeatedly to
move up through to the top menu level.

3 Turn the encoder knob to choose between audio interface
channels and busses.

4 Press the encoder Select switch to confirm your selection.

5 Turn the encoder knob to choose the audio interface chan-
nel or bus assignment that you want.

6 Repeat steps 2-5 for any other channels that you want to as-
sign an input or output.

7 Press the flashing encoder Select switch or press the flashing
Assign switch to confirm the assignments.

To assign a send or insert to a track (global assign mode):

1 Press the Assign Sends switch or the Assign Inserts switch to
enter the corresponding Assign mode. The first two send or in-
sert positions will show on the encoder displays by default.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to
make the assignment.

3 Turn the encoder knob that corresponds to the insert posi-
tion that you want to edit to select from the first level of menu
choices.

4 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

5 Press the encoder Select switch to confirm each menu level
selection.

6 Repeat steps 2-5 to modify other send or insert assignments.

7 Press each flashing encoder Select switch or press the flash-
ing Assign switch to confirm the assignments.

To assign a send or insert to a track (temporary assign mode):

1 Press the Inserts or Sends switch on the channel where you
want to make the assignment.

2 To display and edit other insert positions on the channel,
press the channel’s Page Up or Page Down switches.

3 Do one of the following:

e If the send or insert position is empty, press the encoder
select switch. The encoder display shows the “>" sign in-
dicating that you are editing the send or insert position.

e If the send or insert position is already assigned, press
and hold the encoder select switch until the encoder dis-

play shows the “>” sign indicating that you are editing
the send or insert position.

4 Turn the encoder knob that corresponds to the insert posi-
tion that you want to edit to select from the first level of menu
choices.
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5 Press the encoder Select switch to move down and the By-
pass/Mute/Pre switch to move up through menu levels.

6 Press the encoder Select switch to confirm each menu level
selection.

7 Repeat steps 2-5 to modify other send or insert assignments.

8 Press the flashing encoder Select switch to confirm the as-
signment.

To remove an input, output, send or insert:

1 Press an Assign switch to enter the corresponding Assign
mode.

2 For the assignment you want to remove, press the encoder
Bypass/Mute/Pre switch repeatedly until you reach the top
level menu for the assignment.

3 Turn the encoder knob counter-clockwise until no assign-
ment is visible.

4 Do one of the following:
¢ Press the flashing encoder Select switch or press the flash-
ing Assign switch to confirm the removal.
—or-
e Press the flashing Escape switch to cancel the removal
and restore the assignment.

Assigning Inputs in Sessions with Multiple
Plug-In Outputs

In sessions with plug-ins that have multiple outputs, the out-
puts of those plug-ins are available as inputs in other audio
and Auxiliary Input tracks. These appear as a third category of
inputs, labelled plug-ins, in the track input menu.

When assigning inputs from D-Command, this third category
of inputs appears as a top-level menu choice.

To assign an input from a plug-in output:

1 Press the Assign Inputs switch.

2 On the channel where you want to make the assignment,
turn an encoder knob to select Plug-In from the first level of
menu choices.

3 Press the encoder Select switch to move down to the indi-
vidual plug-in level.

4 Turn the encoder knob to select the plug-in whose auxiliary
output you want to select.

5 Press the encoder Select switch to move down to the list of
plug-in auxiliary outputs.
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6 Do one of the following:
e Press the flashing encoder Select switch or press the flash-
ing Assign Inputs switch to confirm the assignment.
—or-
e Press the flashing Escape switch to cancel the assign-
ment.

Making Elements Active or Inactive

You can make Inputs, Outputs, Inserts, Sends, and entire
tracks active or inactive directly from D-Command by enter-
ing a temporary Make Inactive mode.

To toggle input paths active/inactive:

1 Press the Make Inactive Inputs switch to enter the Make In-
active mode.

2 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the input. Inactive inputs are
shown with an inverted text display.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle output paths active/inactive:

1 Press the Make Inactive Outputs switch to enter the Make
Inactive mode.

2 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the combined outputs for
that channel.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle individual outputs sub-paths active/inactive:

1 Press the Make Inactive Outputs switch to enter the Make
Inactive mode.

2 Press the Select switch on the appropriate encoder to view
the output sub-paths for the channel.

3 Press the Page Up or Page Down switches to step through
the possible output sub-paths.

4 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate your choice of output
sub-paths. Inactive output sub-paths are shown with an in-
verted text display.

5 Press the flashing Make Inactive switch to exit Inactive
mode.



To toggle a send or plug-in active/inactive:

1 Press the Make Inactive Sends switch or the Make Inactive
Inserts switch to enter the corresponding Make Inactive
mode. The first two insert or send positions will show on the
encoder displays.

2 To display and edit other insert positions, press the Page Up
or Page Down switches on the channel where you want to
make the assignment.

3 Press the Bypass/Mute/Pre switch on the appropriate en-
coder to deactivate or reactivate the insert or send assignment.
Inactive assignments are shown with an inverted text display.

4 Repeat steps 2-3 to modify other send or insert assignments.

5 Press the flashing Make Inactive switch to exit Inactive
mode.

To toggle a track inactive/active:

1 Press any of the Make Inactive switches.

2 Press channel strip Select buttons to deactivate or reactivate
the corresponding tracks.

3 Press the flashing Make Inactive switch to exit Inactive
mode.

Selecting a Track

You can select tracks in Pro Tools directly from D-Command.
In Select mode, Select switches can follow latching or
non-latching behavior. For details on setting the latch mode
for the Select switch, see “Display of Hidden Tracks in Custom
Faders” on page 25.

To select a track from D-Command:

1 Make sure the Select/Focus switch mode is set to Select.

2 Press the channel Select switch for the track you want to se-
lect.

To select a range of tracks:

1 Press the Select switch on the channel at the start of the
range you want to select.

2 Hold Shift and press the Select switch on channel at the end
range you want to select.

All tracks between the first channel and last channel (inclu-
sive) are selected.

To select or deselect multiple, non-contiguous tracks, do one of
the following:

= If the Select Switch Latch Mode is set to latch, press addi-
tional Select switches.

—Or —

= Hold Control (Windows) or Command (Mac) and press the
Select switches on multiple channels.

Focusing a Track

You can focus any track in a session in the Focus Channel sec-
tion, and the Dynamics and EQ sections of D-Command. Fo-
cusing a track also makes it available for use with the Custom
Fader Plug-in mode. (See “Plug-In Mode” on page 104.)

To focus a track in the Focus Channel section from D-Command:

1 Make sure the Select/Focus switch mode is set to Focus.

2 Press the channel Select switch for the track you want to fo-
cus.

To focus a track on the Focus Channel section while staying in
Select mode:

» Hold Start+Shift (Windows) or Control+Shift (Mac) and
press the channel Select switch for the track you want to focus.

To focus a track on the Focus Channel section from Pro Tools:

1 Make sure the Target Track from Application preference is
set to Yes. For details on this preference, see “Target Track from
Application” on page 26.

2 On-screen in Pro Tools, click the plug-in state plate, send
window, panner window, or mic pre pane for the track you
want to focus.

To focus a specific track number:

1 Do one of the following;
e Press the Go To switch on D-Command.

e Choose Operations > Scroll to Track Number in
Pro Tools.

2 Enter the track position number for the track and press En-
ter.

To nudge the track focus left or right by one channel:

= Hold Control (Windows) or Command (Mac) and press the
Nudge Left or Nudge Right switch.

To bank the track focus left or right by eight channels:

= Hold Control (Windows) or Command (Mac) and press the
Bank Left or Bank Right switch.
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Focus Channel Strip

If the D-Command Focus Channel Strip Operations prefer-
ence is set to Yes, focusing a track also places a duplicate of the
focused track in the channel strip to the immediate left of the
Global Controls section. See “FCStrp (Focus Channel Strip)”
on page 79.

A\ The duplicate Focus Channel strip is not available when
D-Command is in a Custom Fader mode.

Focusing Tracks when Soloing

To set D-Command to automatically focus a track when it is
soloed:

1 Press the Operation switch repeatedly to display the page
that includes the Focused Track Follows Solo preference (So-
loFc).

2 Press the Soft Key that corresponds to “SoloFc” until its
value is “Yes.”

Focusing a Plug-In

If the D-Command Focus Channel Strip Operations prefer-
ence is set to Yes, focusing a track on D-Command brings the
name of the first active plug-in into the Focus Channel dis-

play.

To focus a plug-in in the Focus Channel display:

1 Make sure the Select/Focus switch mode is set to Focus.

2 Press the channel strips’s Select switch. The first plug-in that
is not a dynamics or EQ plug-in is automatically focused, and
its name appears in the Custom Faders display.

3 In the Custom Faders section, press the Bank/Cycle switch
to cycle through the plug-ins on the Custom Faders display.

The plug-in whose name appears in the Focus Channel display
is then available for Custom Fader Plug-In mode. (See “Plug-In
Mode” on page 104.)

To focus a plug-in in the Dynamics or EQ section:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The first dynamics and EQ
plug-ins on that track are automatically focused in the corre-
sponding D-Command section.

2 Press the Cycle switch in the Dynamics or EQ section to fo-
cus successive dynamics or EQ plug-ins on that channel. (The
No Insert option is always available.)
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To focus a plug-in in the Custom Faders section (temporary
plug-in assign mode):

1 Press the Inserts switch on the plug-in’s channel strip to en-
ter Inserts mode.

2 Press the encoder Select switch for the plug-in that you want
to control.

The plug-in is focused in the Custom Fader section. (See
“Plug-In Mode” on page 104.)

Automation Safe Mode

The Automation Safe switch invokes a mode in which the By-
pass/Mute/Pre switch for each encoder and the channel Select
switch become Automation Safe switches. While in this mode,
pressing a Bypass/Mute/Pre switch on a plug-in or send pro-
tects any automation on that plug-in or send from being over-
written. Pressing a channel Select switch protects any auto-
mated parameters on that track from being overwritten.

In Automation Safe mode, the Automation Safe switch is lit.
While in this mode, the Bypass/Mute/Pre switch for any pro-
tected insert or send is lit, and the channel Select switch for

any protected channel is lit.

To toggle Automation Safe mode on and off:

1 Press the Automation Safe switch.

2 Press the channel Select switch on the tracks for which you
want to toggle automation safe status.

3 Press the Bypass/Mute/Pre switch for the plug-ins or sends
for which you want to toggle automation safe status.

4 Press the Automation Safe switch again to exit Automation
Safe mode.

Bypassing Plug-ins

When a plug-in name is displayed on an encoder (in the top
level Inserts display), the encoder’s Bypass/Mute/Pre (B/M/P)
switch bypasses the corresponding plug-in. The B/M/P switch
lights when the insert or plug-in is bypassed.

To bypass a plug-in:
1 Press the Inserts switch on the plug-in’s channel to display

the first two Insert names on the channel’s encoders.

2 To display and edit other insert positions, press the Page Up
or Page Down switches.

3 Press the B/M/P switch that corresponds to the plug-in you
want to bypass. The B/M/P switch lights when the plug-in is
bypassed.



Making Plug-ins Active/Inactive

When a plug-in name is displayed on an encoder (in the top
level Inserts display), it can be made inactive without entering
Make Inactive mode.

To toggle a plug-in active/inactive:

1 Press the Inserts switch on a channel strip to display the
names of the plug-ins on the channel’s encoders.

2 If the insert location for the plug-in that you want to make
active/inactive is not showing, press the Page Up or Page
Down switches on the channel where you want to make the
assignment until the appropriate location is displayed.

3 Hold Control+Start (Windows) or Control+ Command
(Mac) and press the encoder Select switch for the plug-in.

Muting Sends

You can mute sends directly from D-Command by setting the
appropriate mode for the Bypass/Mute/Pre switch.

To mute sends:

1 Press the Sends switch on the track to display Send names in
the channel encoders.

2 To display and edit other send positions, press the Page Up
or Page Down switches.

3 Press the Switch Mode switch to set the mode to Mute.

4 Press the B/M/P switch for the send you want to mute. The
red Mute LED lights to indicate that the send is muted.

Setting Send Pre-/Post-Fader Operation

You can set sends to pre-fader or post-fader operation directly
from D-Command, by setting the appropriate mode for the
Bypass/Mute/Pre switch.

To toggle sends between pre-fader and post-fader operation:

1 Press the Sends switch on the track to display Send names in
the channel encoders.

2 Press the Switch Mode switch to set the mode to Pre.

3 Press the B/M/P switch for the send you want to toggle. The
green Pre LED lights to indicate that the send is set for
pre-fader operation.

Flip Mode

Channels in Normal mode can use Flip Mode, which transfers
controls from a row of encoders to the channel faders.

In Flip mode, the Flip switch lights, the rotary encoder control
swaps with the channel fader; the encoder Select switch swaps
with the channel Select switch; the encoder Bypass/Mute/Pre
switch swaps with the channel Mute switch; and the encoder
display swaps with the channel display.

To transfer controls from a row of rotary encoders to the channel
faders:

= Press the Flip switch that corresponds to the encoder row
that you want to transfer.

To exit Flip mode:

= Press a lighted Flip switch.

Assigning Inserts and Sends While in Flip
Mode

You can assign Inserts or Sends directly to an encoder even
when its controls are flipped to the channel fader.

When an encoder’s controls are flipped to the channel fader,
the channel Select switch replaces the encoder Select switch,
the channel Mute switch replaces the Bypass/Mute/Pre switch,
and the channel Fader replaces the encoder knob.

To assign an individual insert or send to a flipped encoder:

1 On the channel where you want to make the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel. The controls for the flipped encoder
appear on the channel fader.

2 Press and hold the channel Select switch on the channel
where you want to assign the insert or send. The channel
scribble strip shows a right arrow (“>--") to indicate the chan-
nel is in assign mode.

3 Move the channel fader to select from the first level of menu
choices.

4 Press the channel Select switch to move down and the chan-
nel Mute switch to move up through menu levels.

5 Do one of the following:

e Press the flashing channel Select switch to confirm the
assignment.

— Or —

e Press the flashing Escape switch to cancel the assign-
ment.
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To change a previously assigned insert or send on a flipped
encoder:

1 On the channel where you want to change the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel.

2 Press and hold the channel Select switch for the flipped in-
sert or send you want to change, until the channel scribble
strip shows a right arrow (“>") next to the assignment to indi-
cate the channel is in assign mode.

3 Do one of the following to select a new insert or send:
e Move the channel fader to select from the current level of
menu choices.
—or—
e Press the channel Select switch to move down and the
channel Mute switch to move up through menu levels.

4 When the new insert or send is displayed in the channel
scribble strip, do one of the following:

e Press the flashing channel Select switch to confirm the
assignment.

e Press the flashing Escape switch to cancel the assign-
ment.

To remove an individual insert or send on a flipped encoder:

1 On the channel where you want to remove the assignment,
press the Inserts or Sends switch to display the corresponding
elements on the channel.

2 Press and hold the channel Select switch for the flipped in-
sert or send you want to remove, until the channel scribble
strip shows a right arrow (“>") next to the assignment to indi-
cate the channel is in assign mode.

3 Press the encoder Bypass/Mute/Pre switch repeatedly until
you reach the top level menu for the assignment.

4 Move the channel fader until no assignment is visible.

5 Do one of the following:
e Press the flashing channel Select switch to confirm the
removal.
—or-
e Press the flashing Escape switch to cancel the removal
and restore the assignment.
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Custom Fader Modes

With the Custom Faders feature, you can temporarily set aside
channel strips on D-Command and focus them on your own
customized groups of tracks, on Pro Tools Mix and Edit
groups, on specific track types, or on plug-in controls. Custom
Fader modes are only accessible on D-Command, and are not
displayed on-screen in Pro Tools.

On D-Command, Custom Fader channels are completely sep-
arate from the surrounding channels on the control surface.
All tracks in the session bank around the Custom Fader chan-
nels, and continue to behave normally in Pro Tools and on
D-Command.

When channels are in use by any of the Custom Fader modes,
the blue indicator marked “CF,” located to the left of the
channel fader, is lit.

The status of Custom Fader modes is saved with the Pro Tools
session. If you save and close a session with a Custom Fader
mode active, the session will reopen with the same mode ac-
tive.

Overview of Custom Fader Modes

The three Custom Fader modes are covered in detail later in
this section:

Groups Mode Lets you access Custom Groups or Mix/Edit
Groups functions.

The Custom Group functions let you create and recall up to
eight custom arrangements of tracks on D-Command that are
independent of the Mix or Edit groups in Pro Tools.

The Mix/Edit Group functions let you recall Pro Tools Mix or
Mix/Edit groups and display them on the Custom Fader chan-
nel strips. You can also activate and delete Mix or Mix/Edit
groups.

Tracks Mode Lets you bring all tracks of a particular type to the
Custom Fader channel strips. Track Types include Audio
tracks, Auxiliary Input tracks, MIDI tracks, Instrument tracks,
and Master Fader tracks.

Plug-In Mode Lets you focus the controls of a plug-in on the
Custom Fader channel strips, and any plug-in meters on the
channel strip’s meters.

A special expanded Plug-In view focuses the plug-in header
controls (such as Bypass, Compare and Safe) on the channel
strip Mute switches.



Custom Fader Preferences

Setting the Number of Custom Fader Channels

You can set the size of the Custom Fader bank for each of the
Custom Fader modes. See “Maximum Custom Fader Bank
Size” on page 25.

Setting the Custom Fader Justification

You can set the location of the Custom Fader bank on the con-
trol surface. See “Custom Fader Justification” on page 25.

Displaying Hidden Tracks in Custom Faders

You can set D-Command to show hidden tracks in the Cus-
tom Fader views. See “Display of Hidden Tracks in Custom
Faders” on page 25.

Custom Fader Controls

The Groups switch, Tracks switch, and Plug-In switch in the
Custom Faders section light when the corresponding Custom
Fader mode is active.

The Map switch works in combination with the Custom Fader
modes, and has no independent effect.

The Lock switch and Window switch function both in the
Custom Fader modes and independently. See “Lock Switch”
on page 43.

Focus Channel
Custom Faders

Groups switch 7() ()— Map switch

Groups Map

Tracks switch —() ()— Lock switch

Tracks = Lock

Plug-In switch 7() ()— Window switch

Plug-In /Window

@

Bank/Cycle

Focus Channel
display

Bank/Cycle switch

Custom Fader controls

Custom Groups Mode

Custom Groups mode lets you create a custom collection of
tracks and arrange them in any order in the Custom Fader
channels. You can create up to eight independent Custom
Groups in a session.

Custom Groups are useful for temporarily associating tracks
that are not part of a Pro Tools Mix/Edit group. Also, because
you can add multiple instances of the same track to a Custom
Group, you can use this mode to map multiple parameters
from a single track onto adjacent channel faders.

Custom Groups are created and recalled entirely on D-Com-
mand, and are independent of Mix/Edit groups in Pro Tools.
D-Command Custom Groups are not reflected on-screen in
Pro Tools.

Custom Groups are saved in the Pro Tools session file, and
move with the session to any other system that supports
D-Command operation.

To create a Custom Group:

1 Hold the Groups switch in the Custom Faders section until
it flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The eight avail-
able Custom Groups appear on the encoders in the Custom
Fader channels.

3 If the Custom Group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Custom
Groups.

4 Press the encoder Select switch that corresponds to the Cus-
tom Group you want to define. The Focus Channel display in-
dicates the selection.

5 Hold Control (Windows) or Command (Mac) and press the
Groups switch in the Custom Faders section. The Groups
switch flashes.

6 Add or subtract channels from the Custom Group by doing
any of the following:

e To add a channel to the Custom Group:

¢ Press the channel Select switch for the source channel
you want to add to the Custom Group. Tracks are added
to the Custom Group in the order you select them, and
are right-justified in the Custom Fader channels.

¢ To add multiple copies of a channel to the Custom Group:

e Hold Shift and press the channel Select switch once for
each copy of the source channel that you want to add to
the Custom Group.
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e To insert a channel between existing channels in a Custom

Group:

e Press the channel Select switch of the Custom Fader
channel following the position where you want to insert
a new channel. The switch will light indicating that the
next channel will be placed before the selected channel.

e Press the channel Select switch for the source channel
you want to add to the Custom Group.

¢ To remove a track from the Custom Group, do one of the
following:
e Press the channel Select switch for the source channel
that you want to remove from the Custom Group.

¢ Hold Control+Start (Windows) or Command+Control
(Mac) and press the channel Select switch of the Custom
Fader channel you want to remove from the Custom
Group.

e Press the Default switch and press the channel Select
switch of the Custom Fader channel you want to remove
from the Custom Group.

7 Press the flashing Group switch when you are finished.

To recall a Custom Group:

1 Hold the Groups switch in the Custom Faders section until
it flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The eight avail-
able Custom Groups appear on the encoders in the Custom
Fader channels.

3 If the Custom Group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Custom
Groups.

4 Press the encoder Select switch that corresponds to the Cus-
tom Group you want to recall.

To recall a Custom Group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until
it flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Custom” for Custom Groups mode. The Custom
Group names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Custom Group you want to recall.

5 Press the Soft Key that corresponds to the Custom Group
you want to recall.
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To name a Custom Group:

1 Recall the Custom Group you want to name.

2 Hold Alt (Windows) or Option (Mac) and press the Groups
switch.

3 Enter a name for the Custom Group in the Pro Tools dialog
and click OK.

To edit a Custom Group:

1 Recall the Custom Group you want to edit.

2 Hold Control (Windows) or Command (Mac) and press the
Groups switch. The Groups switch flashes.

3 Add or remove channels from the Custom Group by press-
ing the appropriate channel Select switches.

4 Press the flashing Groups switch when you are finished.

To delete a Custom Group:

1 Recall the Custom Group you want to delete.

2 Hold Start+Alt+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Groups switch.

3 Press Enter.

To exit Custom Groups Mode:

= Press the Escape switch.

Mix/Edit Groups Mode

Mix/Edit Groups mode lets you create, display, and edit

Pro Tools Mix and Mix/Edit groups on the Custom Fader
channels. This mode is useful for quickly calling the members
of a group to a set of faders for mixing and automation.

To recall a Mix/Edit group to the Custom Fader channels:

1 Hold the Groups switch in the Custom Faders section until
it flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
Group letters and names appear on the encoders in the Cus-
tom Fader channels.

3 If the Mix/Edit group you want to access is not visible on the
encoders in the Custom Fader channels, press the Page Up or
Page Down switches to step through available Mix/Edit
groups.

4 Press the encoder Select switch that corresponds to the
Mix/Edit group you want to display.



To recall a Mix/Edit Group to the Custom Fader channels from
the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until
it flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Mix/Edit group you want to recall.

5 Press the Soft Key that corresponds to the Mix/Edit group
you want to recall.

To activate/deactivate a Mix/Edit group:

= Do one of the following:

e When all Mix/Edit groups are displayed in the Custom
Group encoders, press the Bypass/Mute/Pre switch that
corresponds to the Mix/Edit group you want to acti-
vate/deactivate.

e When a Mix/Edit group is selected, hold Start+Control
(Windows) or Control+Command (Mac) and press the
Groups switch.

A deactivated group is indicated by inverted text in the Cus-
tom Faders display.

To activate/deactivate a Mix/Edit group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until
it flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down

to display the Mix/Edit group you want to activate/deactivate.

5 Hold Start+Control (Windows) or Control+Command
(Mac) and press the Soft Key that corresponds to the Mix/Edit
group you want to activate/deactivate.

To create a Mix/Edit group:

1 Make sure you are in Select mode.

2 Select the tracks you want to group by pressing their Select
switches.

3 Press the Group switch in the Management Soft Key section.

4 Choose the type of group to create: Edit Group, Mix Group,
or Edit/Mix Group.

5 Enter a name for the Group and click OK.

To edit a Mix/Edit group:

1 In Mix/Edit Groups mode, recall the Mix/Edit group you
want to edit.

2 Hold Control (Windows) or Command (Mac) and press the
Groups switch.

3 Add or remove channels from the Mix/Edit group by press-
ing the appropriate Channel Select switches.

4 Press the flashing Escape switch when you are finished.

To delete a Mix/Edit group:

1 Recall the Mix/Edit Group you want to delete.

2 Hold Start+Alt+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Groups switch.

3 Press Enter.

To delete a Mix/Edit group from the Soft Keys:

1 If the Soft Keys are in another display mode, return to the
top level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Hold the Groups switch in the Custom Faders section until
it flashes.

3 Press the Bank/Cycle switch until the Focus Channel display
indicates “Groups” for Mix/Edit Groups mode. The Mix/Edit
group letters and names appear in the Soft Keys.

4 Press the Soft Key that corresponds to Page Up or Page Down
to display the Mix/Edit group you want to delete.

5 Hold Alt+Start+Control (Windows) or Control+Op-
tion+Command (Mac) and press the Soft Key that corresponds
to the Mix/Edit group you want to delete.

To exit Mix/Edit Groups Mode:

= Press the Escape switch.
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Displaying Mix/Edit Group Tracks On-Screen

In the top level of Mix/Edit Groups mode, you can display the
tracks in a Mix/Edit group and hide all other tracks from
D-Command.

To display tracks in a Mix/Edit group on-screen:

= Hold Start (Windows) or Control (Mac) and press the Select
switch for the Mix/Edit group to perform the “Show Only
Tracks In Group” command.

Displaying or “Spilling” VCA Slave Tracks to
Custom Faders

You can display all of the slave tracks for a VCA Master track
into the Custom Faders. This feature uses Mix/Edit Groups
mode to replicate a “VCA spill” command.

Whenever a VCA Master track is assigned to group, its By-
pass/Mute switch lights.

To spill VCA slave tracks in Custom Faders:

= Press the lit Bypass/Mute switch on a VCA Master track. The
Bypass/Mute switch flashes to indicate that the VCA Group is
spilled.

To exit display of VCA slave tracks in Custom Faders, do one of
the following:

= Press the flashing Bypass/Mute switch in the VCA Master
track.

= Press the Groups switch in the Custom Fader controls.

Tracks Mode

Tracks Mode lets you bring all tracks of a particular type to the
Custom Fader channel strips. Track Types include Audio
tracks, Auxiliary Input tracks, MIDI tracks, Instrument tracks,
VCA Master tracks, and Master Fader tracks.

To bring a Track type to the Custom Fader channels:

1 Hold the Tracks switch in the Custom Faders section until it
flashes.

2 Press the Bank/Cycle switch until the Focus Channel display
indicates the Track type you want to display.
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To bring a Track type to the Custom Fader channels from the Soft
Keys:

1 If the Soft Keys are in another display mode, return to the
top level Soft Key display by holding Control (Windows) or
Command (Mac) and pressing the currently lit Soft Key
switch.

2 Press the Tracks switch in the Custom Faders section.

3 Press the Soft Key that corresponds to the track type you
want to display in the Custom Fader channels.

The name of the Track type appears in the Custom Fader dis-
play. Tracks of the designated type appear in the Custom
Fader channels.

To exit Tracks mode:

= Press the lit Tracks switch.

Plug-In Mode

Plug-In mode focuses the first plug-in on the focused channel
on the Custom Fader Channels. This places all of the plug-in’s
parameters on the Custom Fader channel encoders, and any
plug-in meters on the Custom Fader channel meters.

This mode is useful for controlling plug-ins with a large num-
ber of controls, such as virtual instruments.

To focus a plug-in on the Custom Fader channels:

1 Focus the plug-in’s track in the Focus Channel section by
pressing the track’s Select switch. The name of the first plug-in
that is not a dynamics or EQ plug-in appears in the Focus
Channel display.

2 Press the Plug-In switch in the Custom Fader section. The
switch lights to indicate the mode is active. The plug-in name
and channel format appear in the Custom Fader channel dis-
plays, and the plug-in’s parameters appear in the Custom
Fader channel encoders.

3 In the Custom Faders section, press the Bank/Cycle switch
to cycle through the plug-ins on the focused channel. (The No
Insert option is always available.)



Custom Faders and Display of Plug-In Parameters

There are three view options available for display of plug-in
parameters in the channel displays of the Custom Faders.
These options, or view definitions, are accessible from the
D-Command operation preferences. See “Custom Fader
Plug-In Mode View Definition” on page 26 for more informa-
tion.

Display of Parameter Types in the Rotary Encoders

In general, continuous plug-in parameters map to the Custom
Fader encoder knobs, and switched parameters functions map
to the B/M/P (Bypass/Mute/Pre) encoder switches. The pres-
ence of a switched parameter is indicated by the Pre indicator
above the corresponding B/M/P switch.

To display the parameter controlled by the B/M/P switches:

» Press the Switch Info switch.

Q In some cases, the same control may be mapped to both
" an encoder knob and its corresponding switch, allowing
you to use either control to adjust the parameter.

Plug-in meters map to the Custom Fader channel meters.
Plug-in input and output meters appear as standard level
meters. Any dynamics gain reduction meters (for example, in
a compressor or limiter plug-in) are shown as top-to-bottom
meters.

Expanded Plug-In View

Expanded Plug-In view lets you access additional plug-in con-
trols and manage individual channels (also called streams) of a
multi-mono plug-in. This mode places the following standard
header controls in the Custom Fader channel displays:

e Plug-In Bypass
e Plug-In Compare
¢ Plug-In Automation Safe

¢ Plug-In Automation Enable

Q If the Custom Fader Plug-In Mode View Definition is set
" to Expanded view, then you are automatically in
Expanded Plug-In View when you enter Plug-In mode.

To enter Expanded Plug-In view:
= Press and hold the Plug-In switch in the Custom Fader sec-
tion until the switch flashes.

The plug-in header controls are mapped as follows:

Plug-In Bypass To bypass the currently displayed plug-in, press
the Mute switch that corresponds to “Bypass” in the channel
displays. This toggles the Effect Bypass button in the Plug-In
window.

Plug-In Compare To toggle between the original saved plug-in
setting and any changes you have made to it, press the Mute
switch that corresponds to “Comp” in the channel displays.
This toggles the Compare button in the Plug-In window.

Plug-In Automation Safe To prevent existing plug-in automa-
tion from being overwritten, press the Mute switch that corre-
sponds to “Safe” in the channel displays. This toggles the Safe
button in the Plug-In window.

Plug-In Automation Enable To enable individual plug-in con-
trols for automation, press the Mute switch that corresponds
to “AutoEn” in the channel displays. This lists the automat-
able plug-in controls on the Custom Fader encoders. Choose
the controls to automate by pressing their encoder Select
switches. This toggles the Auto button in the Plug-In window.

Multi-Mono Plug-ins and Expanded Plug-In View

With multi-mono plug-ins, the following plug-in channel
controls are mapped to the Custom Fader channel displays:

Link To link channels of a multi-mono plug-in, press the Mute
switch that corresponds to “Link” in the channel displays.
This toggles the Master Link button in the Plug-In window.

Target Stream To target a particular multi-mono plug-in chan-
nel for editing, press the Mute switch that corresponds to
“TargtS” in the channel displays. This lists the plug-in chan-
nels on the Channel Fader encoders. You can then choose a
channel by pressing its encoder Select switch. The switch
lights to indicate the targeted channel.

Group Stream To group individual multi-mono plug-in chan-
nels for editing, press the Mute switch that corresponds to
“GroupS” in the channel displays. This lists the plug-in chan-
nels on the Channel Fader encoders. You can then group any
number of streams by pressing their encoder Select switches.
The Select switches light to indicate grouped channels.

Bypass Stream To bypass individual multi-mono plug-in
streams, press the Mute switch that corresponds to “BypS” in
the channel displays. This lists the plug-in channels on the
Channel Fader encoders. You can then bypass a stream by
pressing its encoder B/M/P switch. The B/M/P switch lights to
indicate the bypassed stream.

To exit Expanded Plug-In view:

= Press the flashing Plug-In switch.
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Custom Fader Flip Mode

When in Custom Groups, Mix/Edit Groups, or Plug-In mode,
you can flip Custom Fader encoder rows to the faders with
Custom Fader Flip mode. Custom Fader Flip mode only affects
Custom Fader channels, and has no effect on channels in Nor-
mal mode.

To enter Custom Fader Flip mode:

= When in Groups, Tracks, or Plug-In mode, hold Win (Win-
dows) or Control (Mac) and press the Flip switch for the en-
coder row you want to flip to the faders.

To exit Custom Fader Flip mode:

= Press the lit Flip switch.

Custom Fader Map Modes

When in Groups or Plug-In mode, you can map individual en-
coder controls to faders on a track-by-track basis with Custom
Fader Map modes.

This mapping feature works differently depending on which
of the Custom Fader modes you are in. (Mapping is not avail-
able in Tracks mode.)

Custom Fader Maps are saved with the session.

Map Mode for Custom Groups or Mix/Edit Groups

When in Custom Groups mode or Mix/Edit Groups mode,
you can map any encoder parameter to the fader on the same
Custom Fader channel. In these Map modes, the rotary en-
coder control swaps with the channel fader, and the encoder
Bypass/Mute/Pre switch swaps with the channel Mute switch.

Mapping while in these modes is vertically restricted to encod-
ers and faders in the same channel strip.

To map an encoder to a fader (Custom Groups mode or Mix/Edit
Groups mode):

1 While in Custom Groups mode or Mix/Edit Groups mode,
press and hold the Map switch in the Custom Faders section
until the switch flashes.

2 In the Custom Fader channels, touch any rotary encoders
that you want to map to their corresponding channel fader.

3 Do one of the following:
e Press the flashing Map switch to confirm the mapping.

e Press the Escape switch to cancel the mapping and leave
Map edit mode.

The Map switch lights solid to indicate that the mapping is ac-
tive.
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To bypass mapping (Custom Groups mode or Mix/Edit Groups
mode):

= Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each Custom Group or Mix/Edit
Group.

To recall mapping (Custom Groups mode or Mix/Edit Groups
mode):

1 Press the Groups switch in the Custom Faders section. The
Focus Channel display indicates “Custom” for Custom
Groups mode, and the eight Custom Groups appear on the en-
coders in the Custom Fader channels.

2 While holding the Groups switch, press the Bank/Cycle
switch to toggle between “Groups” (Mix/Edit Group Mode)
and “Custom” (Custom Group Mode) if necessary. The Focus
Channel display indicates the selection.

3 Press the Select switch that corresponds to the Custom Fader
group you want to recall.

4 Press the Map switch.

Plug-In Map Mode

When in Custom Faders Plug-In mode, you can map any
plug-in parameter to any of the faders in the Custom Fader
channels, including faders on different channels. In Plug-In
Map mode, a mapped rotary control is duplicated on the
fader, and a mapped switch is duplicated on the channel Mute
switch. (Because Plug-In mode does not use the faders, no
swapping takes place.)

Mapping while in this mode has no restriction on the vertical
relationship between encoders and faders.

How Plug-In Mapping is Stored

¢ When you map a plug-in, all other instances of that plug-in
in the session will use the same mapping.

« Plug-in mapping is saved as a preference file with a .pim ex-
tension.

# Plug-In mapping for the last opened session is remembered
by the Pro Tools system (saved in the Pro Tools application

preferences file), so when you create a new session on the sys-
tem, all instances of the same plug-in will use the stored map-

ping.
« Plug-in mapping files (.pim) files can be imported and ex-
ported for use with other D-Command and D-Control con-
soles.

To map an encoder to a fader (Plug-In mode):

1 While in Plug-In mode, press the Map switch in the Custom
Faders section.

2 In the Custom Fader channels, press the channel Select
switch on the channel where you want to map the encoder.
The Select switch flashes to indicate Map mode.



3 Do one of the following:

¢ In the Custom Fader channels, touch any rotary encoder
that you want to map to the selected channel'’s fader.

— Or —

e In the Custom Fader channels, press any switch that you
want to map to the selected channel’s Mute switch.

The mapped control appears on the selected channel’s fader.
Plug-In parameter mapping is remembered for that plug-in,
and is usable on any channel where it occurs.

To bypass mapping (Plug-ln mode):

= Press the lit Map switch. Even when it is not displayed, map-
ping is remembered for each plug-in.

To recall mapping (Plug-In mode):

1 Focus the plug-in in the Focus Channel section.

2 Recall the plug-in by pressing the Plug-In switch in the Cus-
tom Faders section.

3 Press the Map switch.

To clear mapping (Plug-In mode):

1 Focus the plug-in in the Focus Channel section.

2 Recall the plug-in by pressing the Plug-In switch in the Cus-
tom Faders section.

3 Press the Map switch.
4 Press and hold the Set to Default and Do to All switches.

5 Press the channel Select switch on any Custom Fader chan-
nel.

Exporting and Importing .pim Files

To export plug-in mapping:

1 Press the Operation Console Prefs Soft Keys switch twice to
view the second page of Soft Key functions.

2 Press the Soft Key that corresponds to “Export PIMaps.”

3 Enter a name for the Plug-In Map (.pim) file, choose a loca-
tion, and click Save.

4 Press the Operation Soft Key twice to exit.

To import plug-in mapping:

1 Press the Operation Console Prefs Soft Keys switch twice to
view the second page of Soft Key functions.

2 Press the Soft Key that corresponds to “Import PIMaps.”

3 Locate the plug-in mapping (.pim) file you want to use and
click Import.

4 Press the Operation Soft Key twice to exit.

Working with Automation

Setting the Automation Mode of Channels

To cycle a channel forward through the automation modes:

= Press the Automation Mode switch on the channel.

To cycle a channel backward through the automation modes:

= Hold the Shift (add) Modifier switch and press the Automa-
tion Mode switch on the channel.

To toggle a channel in and out of Trim mode:

= Press the Trim switch on the channel.

To set the automation mode of one or more channels:

1 Hold an Automation Mode switch (Write, Touch, Latch,
Trim, Read, or Off).

2 Press the Select switches or Auto switches on the channels

whose automation mode you want to set.

To set the automation mode of all or all selected channels:

1 Press the Do To All or Do To Selected switch.
2 Press an Automation Mode switch (Write, Touch, Latch,

Trim, Read, or Off).

To toggle the write enable status of an automation type across
all channels:

= Press the switch for the corresponding automation type
(Volume, Pan, Mute, Send Level, Send Pan, Send Mute, or
Plug-In) in the Automation Enable section.

To suspend automation for all tracks:

= Press the Auto Suspend switch in the Channel Strip Master
Function controls. The Auto Suspend switch flashes to indi-
cate that automation is suspended.

To suspend Trim automation for all tracks:

= Hold Control (Windows) or Command (Mac) and press the
Auto Suspend switch in the Channel Strip Master Function
controls. The Auto Suspend switch flashes to indicate that au-
tomation is suspended.
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Displaying the Automation Playlist for a
Control

To display the automation playlist on-screen for a parameter
controlled by a fader:

» Hold Control+Start (Windows) or Command+Control
(Mac) and touch the fader.

To display the automation playlist on-screen for a parameter
controlled by an encoder:

» Hold Control+Start (Windows) or Command-+Control
(Mac) and touch the encoder.

To display all automation playlists on-screen for a parameter
type:

= Hold Alt+Control+Start (Windows) or Option+Com-
mand+Control (Mac) and touch a fader or encoder controlling
the parameter type.

Previewing Automation

You can audition changes to a mix and compare them to ex-
isting automation values without committing them to the au-
tomation playlist by using Preview mode.

To preview a new automation value for a control:

1 Press the Auto switch on each channel you want preview so
that it is in a write-enabled state (Write, Touch, Latch,
Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to preview
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-in).
3 Do one of the following:
e Press the Preview Soft Key in the Actions Soft Keys Page.
e Hold Control (Win) or Command (Mac) and press the

Off switch in the Automation Mode controls. The Off
switch flashes to indicate Preview mode.

4 Isolate a control by moving it.

5 Start playback and adjust the isolated control to audition
the new automation values.

To suspend Preview mode:

= Do one of the following:
e Press the Suspend Preview Soft Key in the Actions Soft
Keys Page.
—_or—
e Hold Control (Win) or Command (Mac) and press the
Read switch in the Automation Mode controls.
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To punch a preview value to the automation playlist:

= Do one of the following:
e Press the Punch Preview Soft Key in the Actions Page.
—or-
¢ Hold Control+Start (Windows) or Command+Control

(Mac) and press the flashing Off switch in the Automa-
tion Mode controls.

Capturing and Recalling Automation

You can capture the current automation values of actively
writing controls and store them as snapshots. On D-Com-
mand, up to 48 snapshots can be stored and recalled. These
stored snapshots are saved with the Pro Tools session, and can
be imported into other sessions using the Import Session Data
command.

Capturing Automation Values

Before you can store automation values as a snapshot, they
must be loaded into the Capture buffer.

To capture automation values:

1 Press the Auto switch on each channel whose automation
values you want to capture so that it is in a write-enabled state
(Write, Touch, Latch, or Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to capture
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-in).

3 In the Management area of the Soft Keys section, press the
Snapshot key to display the Capture commands in the Soft
Keys section.

4 Start playback, and if necessary, touch a write-enabled con-
trol to start writing automation. The Capture switch in the
Soft Keys section lights to indicate that a capture is possible.

5 When the currently writing controls reach a value you want
to capture, press the Capture switch in the Soft Keys section.

The Punch Capture switch lights in the Soft Keys section lights
to indicate captured values are available to punch.



Storing and Recalling Captured Automation Values

After automation values are captured, the captured state can
be stored in any of 48 available snapshots. These can then be
recalled to the Capture buffer, where they are available to
punch.

To store a snapshot:

1 Capture the automation values you want to store. (See “Cap-
turing Automation Values” on page 108.)

2 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears. The bottom four Soft Keys show four snapshot num-
bers at a time (1-4, 5-8, etc.).

3 Hold the Soft Key that corresponds to the desired snapshot
number for more than one second. The Soft Key display tem-
porarily reads “Saved” to indicate that the snapshot is stored.

The automation values currently in the Capture buffer are
stored in the snapshot. Any previously saved snapshot is over-
written.

The Soft Key lights to indicate that an automation snapshot is
stored.

To name a snapshot:

1 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears.

2 Double-press the Soft Key that corresponds to the snapshot
you want to name.

3 Type the name of the snapshot and press the Soft Key that
corresponds to Enter.

To recall a snapshot:

1 In the Management area of the Soft Keys section, press the
Snapshot key repeatedly until the desired snapshot number
appears. The bottom four Soft Keys show four snapshot num-
bers at a time (1-4, 5-8, etc.).

2 Press the Soft Key that corresponds to the snapshot you
want to recall. The switch flashes to indicate that the snapshot
is loaded into the Capture buffer, and available to punch.

To clear a stored snapshot:

= Hold Control+Alt+Start (Windows) or Command+Op-
tion+Control (Mac) and press the Soft Key that corresponds to
the snapshot you want to clear.

Punching Recalled Automation Values

When a snapshot is loaded into the Capture buffer, it is ready
to punch at a different location.

To punch a recalled snapshot:

1 Move to a location where you want to apply the snapshot.
You can do this during playback or while the transport is
stopped.

2 Press the Punch Capture switch in the Soft Keys section to
apply the snapshot. The captured automation states are ap-
plied to all automation types that are currently enabled in the
Automation window.

Using Snapshots in Preview Mode

On D-Command, you can punch snapshots while in Preview
Mode. This lets you audition the automation values in a snap-
shot without committing them to the automation playlist.

To punch snapshots while in Preview mode:

1 Press the Auto switch on each channel you want preview so
that it is in a write-enabled state (Write, Touch, Latch,
Touch/Latch).

2 In the Automation Enable controls, press the corresponding
switch to enable each automation type you want to preview
(Volume, Pan, Mute, Send level, Send pan, Send mute, or
Plug-in).

3 Hold Control (Win) or Command (Mac) and press the Off
switch in the Automation Mode controls to enter Preview
mode.

4 Press the Snapshot key repeatedly until the desired snapshot
number appears in the Soft Keys.

5 Press the Soft Key that corresponds to the snapshot you
want to recall.

6 Start playback.

7 Press the Punch Capture switch in the Soft Keys section to
punch the snapshot and audition the new automation values.

8 Adjust controls or punch additional snapshots to audition
the new automation values.

9 When you are ready to commit the preview value, press the
Punch Preview Soft Key.
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Joining Automation Values

D-Command remembers the automation write status of all
writable parameters when you stop the transport during an
automation pass. It stores this information in the Join buffer.

When you press the Join switch during playback, writing re-
sumes at the current value for all controls that were previously
writing automation.

To Join automation values:

1 Make sure the controls you want to join are in a write-en-
abled state.

2 Stop playback during an automation pass.

3 Start playback. The Join switch lights to indicate that the
Join buffer

4 When you want to resume writing automation at the cur-
rent values, press the Join switch.

To clear the Join buffer:

» Hold Control+Start (Windows) or Command-+Control
(Mac) and press the Join switch.

AutoMatching Automation Values

To AutoMatch all currently writing controls:

1 Make sure the automation types you want to AutoMatch are
write-enabled.

2 Start playback.

3 When you reach a point in the session where you want to re-
turn controls to their previously written values, do one of the
following:
¢ Press the AutoMatch switch in the Automation area of
the Soft Keys section.
e Hold Alt (Windows) or Option (Mac) and press the Auto
switch on a channel.
e Press the Do to All switch and press the Auto switch on a
channel.
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AutoMatching Individual Controls

On D-Command, you can invoke AutoMatch on individual
controls or control types on single channels.

To AutoMatch all controls of a type on a channel:

= Hold Control (Windows) or Command (Mac) and press any
of the following in the Channel Strip Mode controls for the
track whose controls you want to AutoMatch:

e Inserts
¢ Sends

e Pan

To AutoMatch the volume fader on a channel:

= Hold Control (Windows) or Command (Mac) and press the
Auto switch in the Channel Strip Function controls for the
channel.

To AutoMatch a pan control or the controls for an individual
insert or send on a channel:

1 Press the switch in the Channel Strip Mode controls to dis-
play the Pan controls or the top level of Inserts or Sends for the
channel.

2 Hold Control (Windows) or Command (Mac) and press the
Rotary Encoder Select switch for the control you want to Au-
toMatch:

e For Sends, the Send level, pan, and mute will AutoMatch.
e For Inserts, all automated controls will AutoMatch.

e For Pan, all pan sliders on the channel will AutoMatch.

To AutoMatch all controls for a plug-in displayed in the Dynamics
or EQ section:

= Hold Control (Windows) or Command (Mac) and press the
Auto switch in the Dyn or EQ section of the console.



Appendix A: Utility Mode

D-Command Utility mode lets you view system information,
run diagnostic tests, set hardware preferences, and reset sys-
tem settings.

Entering Utility Mode

You can enter Utility mode at any time to change D-Com-
mand settings. Utility mode can be accessed from the D-Com-
mand Main Unit and also on individual D-Command Fader
Modules.

Entering Utility Mode from a Main Unit

When putting a D-Command Main Unit into Utility mode,
the behavior of connected Fader Modules depends on whether
or not the units are online.

A D-Command unit is online if Pro Tools is running and the
unit is declared in the Peripherals page of the Setups dialog. A
unit is offline when Pro Tools is not running, or if it is not de-
clared on a system that is running Pro Tools.

To enter Utility mode from the Main Unit:

= Press the Utility switch in the Session Management section.
The Utility switch and the Soft Keys flash to indicate Utility
mode is active.

e If the Main Unit is online, any Fader Modules declared
on the same Pro Tools system also enter Utility mode.

e [f the Main Unit is offline, all offline Fader Modules on
the same Ethernet network enter Utility mode.

Entering Utility Mode on a Fader Module

You can put individual Fader Modules into Utility mode to
test them independently of other D-Command units.

To put an individual Fader Module into Utility mode:
1 If Pro Tools is running, do one of the following:
e Quit Pro Tools.
—_or—

e Choose Setups > Peripherals, click Ethernet Controllers,
and make sure the Fader Module is not declared.

2 Press and hold the Modifier Keys in the lower left of the
Fader Module in the following sequence: Shift + Alt/Com-
mand + Win/Option. The encoder Select switches in the bot-
tom row flash to indicate Utility mode is active.

Shift/Shift Ctl/Ctl t/Win /Al
Cleeed)

1

3
Fader Module Modifier Key sequence for Utility mode

Navigating Utility Mode

When the unit is in Utility mode, the Utility Setup Page is dis-
played on the Soft Key displays (Main Unit) or on the bottom
row of encoders (Fader Module).

The Utility Setup page has five top level options:
e System: System Info Page
e Name: Name Setup Page
e Test: Test Setup Page
e Reset: Reset D-Command to Defaults

e Pref: Preference Setup Page

To access an option on the Utility Setup Page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the option.

To move back up to the Utility Setup Page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Escape.”
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Exiting Utility Mode

To exit Utility mode, do one of the following:
= Press the flashing Utility switch (Main Unit).

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

D-Command System Info Page

The System Info page provides access to the system firmware
version and Ethernet information.

To display the System Info page:

= From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “System.”

To exit the System Info page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Firmware Version

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to “FW
ver.” This shows the Comm board and Motor Control board
firmware versions.

Ethernet Info

In the System Info page, hold the Soft Key (Main Unit) or en-
coder Select switch (Fader Module) that corresponds to
“Ethrnt” to display the following information:

+ Unit Name (as named on the Name Page)
o ID: Ethernet address (Machine Address Code) for the unit
¢ Num: The Digidesign serial number for the unit

o Type: The Ethernet packet type used by Digidesign for con-
trol surface communication
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D-Command Name Page

The Name page is used to view and change D-Command unit
names. These names appear in the Pro Tools Peripherals dia-
log, and must be unique so as to identify each D-Command
unit correctly. This is especially important if your system is on
an Ethernet network with multiple controllers connected to
it.

To display the Name page for a D-Command unit:

1 Put the unit you want to name into Utility mode. Fader
Modules must be put into Utility mode independently. (See
“Entering Utility Mode on a Fader Module” on page 111.)

2 From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Name.”

The Main Unit name appears in the Soft Keys section. The
Fader Module name appears in its encoder displays. The first
character of the name flashes to indicate text entry.

To change the unit name:

1 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the selected text.

2 To move forward and backward through the name field,
press the flashing Soft Keys (Main Unit) or encoder Select
switches (Fader Module) that correspond to the “<” and “>"
symbols.

3 When you are finished entering text, do one of the follow-
ing:

¢ Confirm the new name by pressing the Soft Key (Main
Unit) or the encoder Select switch (Fader Module) that
corresponds to “OK.”

e Clear the name field by pressing the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corre-
sponds to “Clear.”

e Cancel the new name by pressing the Soft Key (Main
Unit) or the encoder Select switch (Fader Module) that
corresponds to “Cancel.”



D-Command Test Pages

The Test pages let you test various mechanical and electronic
components of the unit.

To display the Test Setup page:

= From the Utility Setup page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Test.”

The Test Setup page has five top level test modes:
e Ethernet: Ethernet Test Page
e LED: Switch and LED Test Pages
e Display: Display Test Page
e Fader: Fader Test Page
e Rotary: Rotary Encoder Test Page

To enter a test mode on the Test Setup page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the test mode name.

To exit the Test Setup page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Ethernet Test Page

There are three test levels for Ethernet communication on
D-Command: Internal, Mendec, and External. These tests can
assist Digidesign Technical Support should you ever experi-
ence difficulty with Ethernet communication between
D-Command and Pro Tools.

Each test sends data packets through that unit’s Ethernet sys-
tem. The Transmit (Xmit) and Receive (Recv) values for each
test show the number of packets sent and received in the test,
and the “Error” and “Retry” fields show percentage error in
the transmission and receiving process. An error rate of 1 per-
cent or less generally indicates acceptable performance. (In
normal operation, errors are retried and no data loss occurs.)

To display the Ethernet Test page:

1 Put the unit you want to test into Utility mode. Fader Mod-
ules must be put into Utility mode independently. (See “Enter-
ing Utility Mode on a Fader Module” on page 111.)

2 From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Ethrnt.”

To exit the Ethernet Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Internal

The Internal test verifies the first stage of Ethernet communi-
cation by sending data packets through the unit’s Ethernet
link chip.

To perform the Internal Ethernet test:

1 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Intrnl.”

To exit the Internal Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Mendec

The Mendec (Manchester Encoder/Decoder) test verifies the
second stage of Ethernet communication by sending data
packets through the unit’s Ethernet encoder and decoder.

To perform the Mendec Ethernet test:

1 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Mendec.”

To exit the Mendec Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

External

The External test verifies the third stage of Ethernet commu-
nication by sending data packets out of the unit’s external
Ethernet port and back into the unit using the Ethernet loop-
back connector (provided with the D-Command Main Unit).

To perform the External Ethernet test:
1 If Pro Tools is running, quit Pro Tools.
2 Disconnect the unit from the Ethernet network.

3 Plug the Ethernet Loopback connector into the unit’s Ether-
net port.

4 From the Ethernet Test page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Clear” to clear any values in the unit’s test data page.

5 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “Extrnl.”
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To exit the External Ethernet test:

= Press the flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Switch and LED Test Page

The Switch and LED Test page has five modes:
e Switch: Switch Test Mode
e Red: Red LED Test Mode
¢ Yellow: Yellow LED Test Mode
e Green: Green LED Test Mode
e Vegas: Vegas Mode

To display the Switch and LED Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
ULED.II

To exit the Switch and LED Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Switch and LED Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the mode name.

Switch Test Mode
Switch Test mode lets you test each switch on the unit indi-

vidually.

To test any switch:

= Press the switch you want to test.

The switch LED lights as long as it is held and the Soft Key dis-
play (Main Unit) or encoder displays (Fader Module) show the
location information for the switch.

To exit Switch Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

LED Test Modes (Red, Yellow, Green)

The LED Test modes lets you test all red, yellow, and green

LEDs on the unit individually.

To test LEDs:

= Press the Soft Key that corresponds to “Red,” “Yellow,” or
“Green” to test all LEDs of the corresponding color.
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To exit LED Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Vegas Mode

Vegas mode randomly lights every switch, meter, and display
on the unit, and runs the faders in sine wave mode.

To enter Vegas mode:

= Press the Soft Key that corresponds to “Vegas.”

To exit Vegas mode:

= Press any switch on the unit.

Display Test Page

The Display Test page has three modes:
e Text: Display Test
¢ Time Code: Time Code Display Test
¢ Meter: Meter Bridge LED Test

To display the Display Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Disply.”

To exit the Display Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Display Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the mode name.

Text (Display) Test

The Text test mode cycles through a series of display tests that
check all displays on the control surface.

To exit Text Test mode:

= Press any flashing Soft Key (Main Unit) or encoder Select
switch (Fader Module).

Meter Bridge LED Test

The Meter Bridge LED test cycles through a series of auto-

mated tests that check all LEDs on each meter.

To exit Meter Bridge LED Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”



Time Code Display Test
(Main Unit Only)
The Time Code Display test cycles through a series of auto-

mated tests that check all LED segments on the Main Unit
Time Code display.

To exit Time Code Display Test mode:

= Press the Soft Key that corresponds to “Escape.”

Fader Test Page
The Fader Test page provides four test modes and a calibration
mode:

e Step: Fader Step Test Mode

e Cycle: Fader Cycle Test Mode

e Group: Fader Group Test Mode

¢ Touch: Fader Touch Test Mode

e Recal: Recalibrates Faders

To display the Fader Test page:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Fader.”

To exit the Fader Test page:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

To enter any of the Fader Test modes:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the test name.

Step Test Mode

In Step Test mode, faders jump together, in stepped fashion,
to positions that are adjustable with the Scrub/Shuttle wheel
(Main Unit) or any encoder knob (Fader Module).

To exit Step Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Cycle Test Mode

In Cycle Test mode, faders move together, from the bottom to
top, in a continuous cycle, at a speed that is adjustable with
the Scrub/Shuttle wheel (Main Unit) or any encoder knob
(Fader Module).

Fader position values are shown in the channel displays and
are updated in real time as the faders move.

To exit Cycle Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Group Test Mode

In Group Test mode, faders can be moved to test group re-
sponse.

This mode displays which faders are currently being touched
by showing the letter “T” in their channel displays.

To exit Group Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Touch Test Mode

The Touch Test page lets you test the touch sensitivity of each
fader. The channel displays show when a fader is touched and
what frequency the fader is currently recognizing. The fader
frequency value is updated in real time.

This mode displays which faders are currently being touched
by showing the letter “T” in their channel displays.

To exit Touch Test mode:

= Press the Soft Key (Main Unit) or encoder Select switch
(Fader Module) that corresponds to “Escape.”

Recal

The Recal command recalibrates D-Command fader touch
sensitivity and position to factory specifications.

In addition, under conditions of heavy use, the D-Command
fader motor protection feature may disengage a fader if it is in
danger of overheating. The Recal command reengages any dis-
engaged faders.

To recalibrate the faders:

= From the Fader Test page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Recal.”
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Rotary Test Page

The Rotary Test page lets you test the touch-sensitive encoder
knob and the LED ring in each rotary encoder, as well as the
Scrub/Shuttle wheel on the Main Unit.

To enter Rotary Test mode:

= From the Test Setup page, press the Soft Key (Main Unit) or
encoder Select switch (Fader Module) that corresponds to
“Rotary.”

To exit Rotary Test mode:

= Press the Soft Key next to “Escape” (Main Unit) or the flash-
ing encoder Select switch.

To test the rotary encoders:

# Touch any encoder knob. When the encoder knob is
touched, the encoder’s display turns red and the “Auto” indi-
cator LED below the knob lights.

o Turn any encoder knob. When the encoder knob is turned,
each LED in the LED ring lights in order.

To test the Scrub/Shuttle wheel:

= Turn the Scrub/Shuttle wheel. The numerical value in the
lower left display of the Soft Key section value changes de-
pending on which way you turn the wheel.

Resetting D-Command to Factory
Defaults

The Reset (Factory Default) page lets you reset the D-Com-
mand Main Unit and Fader Modules to their factory default
settings.

To reset D-Command:

1 From the Utility Setup Page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Reset.”

2 Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to “OK.”

3 Do one of the following:
e Confirm your choice by pressing OK again.
—or-
e Cancel the reset operation by pressing the Soft Key (Main

Unit) or the encoder Select switch (Fader Module) that
corresponds to “Cancel.”
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D-Command Preferences

D-Command Preferences let you set various display and oper-
ation preferences for the unit.

To display the Preferences page:

= From the Utility Setup Page, press the Soft Key (Main Unit)
or the encoder Select switch (Fader Module) that corresponds
to “Prefs.”

The D-Command Preferences page has five preferences:
e Bright: Display Brightness
e Contrast: Display Contrast
e Foot 1: Footswitch 1 Settings
e Foot 2: Footswitch 2 Settings
e Sleep: Sleep Mode Settings

To access a preference on the Preferences page:

= Press the Soft Key (Main Unit) or the encoder Select switch
(Fader Module) that corresponds to the preference name.

Display Brightness Page

The Display Brightness page lets you adjust the brightness of
the display LED displays.

To set the display brightness:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Bright.”

2 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the brightness value. Bright-
ness values range from 0-127.

3 Do one of the following:
¢ Confirm the new brightness value by pressing the Soft
Key (Main Unit) or the encoder Select switch (Fader Mod-
ule) that corresponds to “OK.”

¢ Cancel the new brightness value by pressing the Soft Key

(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “Cancel.”



Display Contrast Page

The Display Contrast page lets you adjust the level of back-
lighting in the display LED displays.

To set the display contrast:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Contrast.”

2 To adjust the overall contrast for all displays, press the Soft
Keys (Main Unit) or the encoder Select switches (Fader Mod-
ule) that correspond to “>>" or “<<” to increase or decrease the
contrast value. Overall contrast values range from 0-9.

3 To adjust the relative contrast for individual rows of dis-
plays, turn the Flip encoder knobs (Main Unit) or any encoder
knobs in a given row (Fader Module). Individual contrast val-
ues are shown as “Step” numbers ranging from 0-62.

4 To cycle the displays through inverted text display, repeat-
edly press the Soft Key (Main Unit) or the encoder Select
switch (Fader Module) that corresponds to “Invert.”

5 Do one of the following:

e Confirm the new contrast values by pressing the Soft Key
(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “OK.”

¢ Reset the contrast values to their defaults by pressing the
Soft Key (Main Unit) or the encoder Select switch (Fader
Module) that corresponds to “Reset.”

¢ Cancel the new contrast values by pressing the Soft Key
(Main Unit) or the encoder Select switch (Fader Module)
that corresponds to “Cancel.”

Footswitch 1 and 2 Settings Pages
(Main Unit Only)

The Footswitch Settings pages for Footswitch 1 and Foot-
switch 2 let you set the function for each. For each setting,
pressing the footswitch is the functional equivalent of press-
ing the corresponding switch on the D-Command Main Unit.

Each Footswitch Settings page has four options:
e Flip + / Flip - : Changes the polarity of the footswitch
connection to positive (+) or negative (-).
e DPlay: Simulates pressing the Play switch on the transport
e Record: Simulates pressing the Record switch on the
transport

e Talkback: Simulates pressing the Talkback switch on the
D-Command Main Unit

To set the function of the footswitches:

1 From the Preferences page, press the Soft Key that corre-
sponds to “Foot 1” or “Foot 2.”

2 Press the Soft Key that corresponds to the function you want
to assign to the footswitch. The Soft Key for the selected func-
tion lights continuously.

= Press the Soft Key that corresponds to “Escape.”

Sleep Mode Settings Page

Sleep mode saves power by dimming the LEDs on the D-Com-
mand unit. The Sleep Mode Settings page lets you set the
amount of idle time before the LEDs on the unit dim automat-
ically.

To set the time before the D-Command unit sleeps:

1 From the Preferences page, press the Soft Key (Main Unit) or
the encoder Select switch (Fader Module) that corresponds to
“Sleep.”

2 Turn the Scrub/Shuttle wheel (Main Unit) or any encoder
knob (Fader Module) to change the time before the unit goes
to sleep. Times range in 1-minute increments from 1 to 59
minutes, then in 1-hour increments from 1 to 12 hours, to Off
(the unit never goes to sleep).
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Appendix B: Audio Connections and Pinouts

All external D-Command audio connections are made to the back panel of the XMON interface, shown below. All audio connec-
tors are standard female DB-25 connectors. The connector for communication with D-Command is a 15-pin female connector.

Cue Inputs Main Inputs Surround Inputs Stereo Inputs
CUE I[IPUTS MAIN |NPUTS SURROUI|D INPUTS STERE(| INPUTS
C([( ''''''''''''''''''''''''' )])D C([( ......................... )])D q[( ......................... )])D gmgidesign Iy

SERAL NUMBER

100240506042, 5K 45W

ol P P P . )P 00000666 @

Cue Outputs Main Outputs Alt Outputs Talkback/Listenback/ Utility D-Command connector

XMON back panel connectors

- _ Main Inputs
25-Pin Female Connector Pinouts

Main Inputs

All XMON DB-25 connector pinouts conform to the pin num-

bering scheme shown below. Signal Name Hot (+) | Cold (=) | Ground (shield)
13 1 Main Input 1 (L) 24 12 25
[Main Input 2 (Lc)]* 10 23 11
R Main Input 3 (C) 21 9 22
25 14 [Main Input 4 (Re)]* | 7 20 8
DB-25 Connector (user view)
Main Input 5 (R) 18 6 19
Cue Inputs
Main Input 6 (Ls) 4 17 5
Cue Inputs Main Input 7 (Rs) 15 3 16
Signal Name Hot (+) | Cold (=) | Ground (shield)
Main Input 8 (LFE) 1 14 2
Cue Input 1 (Left) 24 12 25
GND 13
Cue Input 1 (Right) | 10 23 11
SHIELD GND connector housing
Cue Input 2 (Left) 21 9 22
e Inout 2 (Right) | 7 20 s * Main Inputs 2 and 4 are active on XMON, but the corre-
ue Input 2 (Right) sponding Lc and Rc outputs cannot be controlled indepen-
[Not Connected] 18 6 19 dently from the D-Command monitor section.
[Not Connected] 4 17 5
[Not Connected] 15 3 16
[Not Connected] 1 14 2
GND 13
SHIELD GND connector housing
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Surround Inputs Cue Outputs

Surround Inputs Cue Outputs
Signal Name Hot (+) | Cold (=) | Ground (shield) Signal Name Hot (+) | Cold (=) | Ground (shield)
Surround Input 1 (L) 24 12 25 SLS Output (Left) 24 12 25
[Surround Input 2 (Lc)]* | 10 23 11 SLS Output (Right) 10 23 11
Surround Input 3 (C) 21 9 22 Cue Output 1 (Left) 21 9 22
[Surround Input 4 (Re)1* | 7 20 8 Cue Output 1 (Right) | 7 20 8
Surround Input 5 (R) 18 6 19 Cue Output 2 (Left) 18 6 19
Surround Input 6 (Ls) 4 17 5 Cue Output 2 (Right) | 4 17 5
Surround Input 7 (Rs) 15 3 16 [Not Connected] 15 3 16
Surround Input 8 (LFE) 1 14 2 [Not Connected] 1 14 2
GND 13 GND 13
SHIELD GND connector housing SHIELD GND connector housing

* Surround Inputs 2 and 4 are active on XMON, but the corre- Main Speaker Outputs
sponding Lc and Rc outputs cannot be controlled indepen-

dently from the D-Command monitor section. Main Speaker Outputs
Signal Name Hot (+) | Cold (-) | Ground (shield)
Stereo Inputs -
Main 1 (L) 24 12 25
Stereo Inputs [Main 2 (Lc)]* 10 23 11
Signal Name Hot (+) | Cold (-) | Ground (shield) .
Main 3 (C) 21 9 22
Stereo Input 1 (Left) 24 12 25 -
[Main 4 (Rc)]* 7 20 8
Stereo Input 1 (Right) | 10 23 11 -
Main 5 (R) 18 6 19
Stereo Input 2 (Left) 21 9 22 -
Main 6 (Ls) 4 17 5
Stereo Input 2 (Right) | 7 20 8 -
Main 7 (Rs) 15 3 16
Stereo Input 3 (Left) 18 6 19 .
Main 8 (LFE) 1 14 2
Stereo Input 3 (Right 4 17 5
P (Right) GND 13
[Not Connected] 15 3 16 -
SHIELD GND connector housing
[Not Connected] 1 14 2
* Main Speaker Outputs 2 and 4 are active on XMON, but Lc
GND 13 and Rc outputs cannot be controlled independently from the
SHIELD GND connector housing D-Command monitor section. Global Volume, Solo, and

Mute controls affect all outputs.
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Alt Speaker Outputs

Alt Speaker Outputs

Signal Name Hot (+) | Cold (=) | Ground (shield)
Alt 1 (L) 24 12 25

[Alt 2 (Lc)]* 10 23 11

Alt 3 (C) 21 9 22

[Alt 4 (Rc)]* 7 20 8

Alt 5 (R) 18 6 19

Alt 6 (Ls) 4 17 5

Alt 7 (Rs) 15 3 16

Alt 8 (LFE) 1 14 2

GND 13

SHIELD GND connector housing

* Alt Speaker Outputs 2 and 4 are active on XMON, but Lc and

Rc outputs cannot be controlled independently from the
D-Command monitor section. Global Volume, Solo, and
Mute controls affect all outputs.

Talkback/Listenback Pinouts

15-Pin Connector Pinouts

The XMON 15-pin connector pinouts conform to the pin
numbering scheme shown below.

8

15 9

15-pin connector (user view)

XMON to D-Command Connector Pinouts

XMON to D-Command Pinouts

Signal Name Hot (+) | Cold (=) | Ground (shield)
RS422 Input 1 9

RS422 Output 2 10

MIDI Input 12 4

MIDI Output 11 3

Headphones L 5 13

Headphones R 6 14

Internal Talkback Mic 15 8

GND 7

SHIELD GND connector housing

Talkback/Listenback
Signal Name Hot (+) | Cold (-) | Ground (shield)
Ext Talkback Mic 24 12 25
Input
Listen Mic 1 Input 10 23 11
Listen Mic 2 Input 21 9 22
AFL Input 1 20 7 8
AFL Input 2 6 18 19
Mini Speaker Out (L) | 4 17 5
Mini Speaker Out (R) | 15 3 16
Talkback/Slate Out 1 14 2
GND 13
SHIELD GND connector housing
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Numerics
9-Pin Remote switch 70

A

Actions switch (automation) 81
After-Fader Listen (Monitor section) 89
All Enabled switch (automation) 39
All Notes Off switch 74
All switch (automation) 39
Alt outputs (Monitor section) 86
Arrow switches 72
Assign controls 45, 95

Inputs 45

Inserts 46

Outputs 45

Sends 46
Assign Talkback switch 87
Attack/Q control (Dynamics plug-ins) 54
Audio Files switch 78
Audition Mode switch 70
Audition switches 70

Audition Mode 70

Mark In 71

Mark Out 71

Post-Roll 70

Pre-Roll 70
Auto Talkback switch 90
AutoMatch indicators 37
AutoMatch switch 80
AutoMatching automation 110
automation

AutoMatching 110

capturing 108, 109

enabling for plug-ins 52, 105

encoder mode indicator 32

modes 107

plug-ins 48, 58, 65

previewing 108, 109

snapshots 109

suspending 107
Automation controls 80

Actions switch 81

AutoMatch switch 80

Join 80, 110

Modes switch 82
Automation Enable controls 39

Mute 40

Pan 40

Plug-in 39

Send Level 40

Send Mute 40

Send Pan 40

Volume 40
Automation Mode controls 8, 44, 107

Latch 44

Off 44

Read 44

Touch 44

Trim 44

Write 44
Automation Mode indicators 37
Automation Mode switches 36
Automation Safe mode 48, 98, 105
Automation Safe switch (plug-ins) 58, 65

Automation Suspend switch 42
Automation switch (plug-ins) 58, 65
Automation Trim switch 36
Automation Write controls 39

Write to All 39

Write to All Enabled 39

Write to Current 39

Write to End 39

Write to Start 39

B
B/M/P (see Bypass/Mute/Pre)
Back and Play switch 71
Back switch 71
Bank Justification preference 24
bank size (Custom Faders) 101
Bank/Cycle switch
and Custom Fader mode 43
banking (tracks) 8
Broadcast mode (Monitor section) 89
Bypass/Mute switches (channel strips) 34
Bypass/Mute/Pre switch 98
Bypass/Mute/Pre switches (rotary encoders) 32
Show Values 40
Switch Info 40
Switch mode 40

Cc

calibration
faders 28
meters 28

Calibration Mode switch 91
capturing automation 108, 109
channel display modes 36
Channel Select switches
for channel strips 35
for Monitor section 88
for plug-ins 56, 63
Channel Strip Function controls 35
Automation Mode 36
Automation Trim 36
Channel Select 35
display modes 36
Input Monitor Mode 35
Mute 36
Record Enable 35
Record Safe mode 35
Solo 36
Channel Strip Mode controls 33, 35
Bypass/Mute 34
Inserts 33
Mic Pre mode 34
Pan 34
Sends 35
channel strips 31
Channel Select switch 35
fader section 36
channels
focusing 36, 69, 97, 98
selecting 35
Clear Clip switch 74
clipping indication 74
Compare switch (plug-ins) 58, 65
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connections

audio 19, 119

alt 121

control room 20

cue system 21, 119, 120

headphone 21

main 119, 120

solo outputs 121

stereo inputs 120

surround inputs 120

talkback/listenback 121
Ethernet 9, 10, 18, 23
footswitch 9, 18

Edit Controls

Edit Functions 77

Edit Modes 77

Edit Tools 77
Edit controls 77
Edit Function switches 77
Edit window

navigation 8

playback of selections 68
Edit/Timeline switch 45
Enable Parameters switch 48
Encoder preferences 26

power 17

Encoder Select switches 32
XMON 9, 12, 19, 121

End switch (automation) 39

Console Preferences 79 EQ (plug-ins) 8, 49, 60
Meter 79 EQ plug-in controls
Operation 79 High 62
User 79 . High-Mid 62

Current switch (automation) 39 High-Pass 61

Custom Fader Flip mode 106 Level 62

Custom Fader Hidden Tracks preference 25 Low Filter 61

Custom Fader Justification preference 25 Low-Mid 61

Custom Fader Map modes 43, 106 Low-Pass 62
and Custom Fader Plug-in mode 106 Mid 61
and Custom Groups mode 106

- . Escape switch 40
and Mix/Edit Groups mode 106 Ethernet 9, 10, 18, 23

Custom Fader Mode indicators 37 expansion options 3

Custom Fader modes 42, 100 External Key switch (Dynamics plug-ins) 58
Custom Groups 43, 101
Expanded Plug-In mode 105

Mix/Edit Groups 43, 102 F

Plug-In 104 Fader Module

Plug-in 43 attaching to Main Unit 16

Tracks 43, 104 back panel overview 10
Custom Faders 8 components 3

bank size 101 hardware 15

display 43 placement 15

displaying plug-ins 43 faders 36

Groups switch 43 calibration 28

locking plug-ins 43 Faders On/Off preference 24

plug-in view definitions 26, 105 Flip mode 38, 99
Custom Groups mode (Custom Fader) 43, 101 and Instrument tracks 38
Cycle switch (plug-ins) 58, 65 Flip switches 38

Focus Channel 43
D display 43
. Focus mode (Channel Select switch) 36

D-Command_ Units focusing

declaring 23 channels 36, 69, 97, 98

~_naming 24 plug-ins 50, 98

Dim function 90 footswitch 9, 18

Dim Level control 91
Display Brightness 116
Display Contrast 117
Display Mode switch 42

Footswitch settings 117
Forward and Play 71

Display preferences 26 G
Do To All switches 41 Gain/Hold/Input control 55
Do To Selected switches 41 Global Controls 8, 38
Dynamics (plug-ins) 8, 49, 53 Global Modifier controls 40
gain reduction display 59 Automation Suspend 42
Dynamics plug-in controls Display Mode 42
Attack 54 Do To All 41
External Key 58 Do To Selected 41
Filter Frequency 54 Escape 40
Gain 55 Select/Focus 41
Hold 55 Set To Default 42
Hysteresis 54 Solo Clear 42
Input 55 Suspend Groups 42
Key Listen 58 Go To End switch 71
Knee 54 Go To Start switch 71
output 55 Go To switch 74
Q54 Group Status indicators 37
Range 54 Group switch 76
Ratio 54 groups
Release 54 creating 103
Threshold 55 deleting 103

editing 103
Groups switch (Custom Faders) 43

H

Headphone/Cue controls 87

Output controls 87
High Filter controls (EQ plug-ins) 62
High-Mid Filter controls (EQ plug-ins) 62
High-Pass controls (EQ plug-ins) 61
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Input controls (Monitor section) 86
Input Level Trim controls (Monitor section) 86
Input Monitor Mode switches 35
Input Source Sum controls (Monitor section) 86
inputs

assigning 95, 96

making inactive 96
inputs (Monitor section)

main 86

selecting 86

stereo 86

summing 86

surround 86

trimming 86
inserts

assigning 95, 99

making inactive 96
Inserts switches 33
Instant Playback switch 71
Instrument tracks 31, 32, 33, 47
into Utility 111

J
Join switch 80, 110

K

Key Listen switch (Dynamics plug-ins) 58
keyboard modifiers 37

Knee/Hysteresis/Q control (Dynamics plug-ins) 54

L

Latch switch (automation) 44
latching
solos 36
transport controls 67
Level controls (EQ plug-ins) 62
levels
inputs (Monitor section) 86
output channels (Monitor section) 88
outputs (Monitor section) 86
Solo modes (Monitor section) 89
Link Edit and Timeline switch 45
Listen controls 91
listenback
connections 121
Locate switches 71
Back 71
Back and Play 71
Forward and Play 71
Go To End 71
Go To Start 71
Instant Playback 71
location display 93
Lock switch (Custom Fader Plug-in mode) 43
Lock switch (plug-ins) 56, 63
Loop Playback switch 70
Low Filter controls (EQ plug-ins) 61
Low-Mid Filter controls (EQ plug-ins) 61
Low-Pass controls (EQ plug-ins) 62

Machine Online switch 70
Main Counter switch 45
Main inputs (Monitor section) 86
Main outputs (Monitor section) 86
Main Unit
components 3
top panel overview 7
Utility mode 111
Make Inactive controls 47, 96
Inputs 47
Inserts 47
Outputs 47
Sends 47
Management controls 76
Map switch (Custom Fader mode) 43
Mark In switch 71
Mark Out switch 71
Master Bypass switch (plug-ins) 58, 65
Master Link switch (plug-ins) 57
Master Record Enable switch 69

Maximum Custom Fader Bank Size preference 25
Memory Location switch 78
Memory/MIDI controls
Memory Location 78
MIDI switch 78
meter display 93
Meter preferences 27
Meter switch 79
meters 8
calibration 28
plug-ins 65
reference levels 94
Mic Pre mode 34
Mic Select switches 91
Mid Filter controls (EQ plug-ins) 61
MIDI controls 33
MIDI switch 78
Mini (stereo) outputs (Monitor section) 86
Mix/Edit Groups mode (Custom Fader) 43, 102, 104
Modes switch (automation) 82
modifier switches 37
Monitor Output Mode controls
Calibration switch 91
Dim switch 92
Mono switch 91
Mute switch 92
Monitor section 85
Dim Level control 91
Headphone/Cue controls 87
Input controls 86
Input Level Trim controls 86
Input Source Sum controls 86
Output Channel Select switches 88
Output controls 86
Output Level Trim controls 86
Talkback/Listen controls 90
monitoring 8, 85
Mono switch 91
Mute switch (automation) 40
Mute switch (Monitor section) 92
Mute switches (channel strips) 36

Navigate Mode switch 72
navigation controls 8
Nudge/Bank switches 8, 72
nudging (tracks) 8

o

Off switch (automation) 44
opening sessions 78
Operation switch 79
Output Channel Select switches (Monitor section)
Mute 88
Solo 88
Output Channel Trim mode (Monitor section) 88
Output controls (Monitor section) 86
Output Level Trim controls (Monitor section) 86
Output meter (plug-ins) 59
outputs
assigning 95
making inactive 96
outputs (Monitor section)
Alt 86
calibrating 91
channels 88
main 86
Mini (stereo) 86
selecting 86
trimming 86, 88

P
Page switch (plug-ins) 58, 65
Page switches (channel strips) 33
Pan switch (automation) 40
Pan switches 34
pinout diagrams 119
Playlist switch 76
Plug-in Automation controls 48
plug-in controls
Dynamics 8, 49, 53
EQ 8, 49, 60
Plug-In mode (Custom Fader) 104
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Plug-in mode (Custom Fader) 43 S

Plug-in switch (automation) 39 Save As switch (plug:i i
. plug-in settings) 56, 63
plugins 8, 49, 53, 60 Save switch (plug-in settings) 56, 63

assigning 49 Save switch (sessions) 74
Automation Safe 48, 105 saving settinfgs 56 63)

Automation Safe switch 58, 65

Automation switch 58, 65 seroliig

) , Scrub/Shuttle wheel 68
bypassing 58, 65, 98, 105 Scrub switch 69
Channel Select switches 56, 63 Scrub/Shuttle controls 68
Compare switch 58, 65, 105 Scrub switch 69
copying settings 51 Scrub/Shuttle wheel 68
Custom Fader mode 104 Shuttle switch 69
Cycle switch 58, 65 Trim switch 69
Dynamics 53 Scrub/Shuttle wheel 68
enabling automation 48, 52, 105 moving windows 69
EQ 60

focusing 50, 98, 104 nudging tracks 69

scrolling 68

Lock switch 56, 63 se|ectingg 68
making inactive 51, 99 ;

o zooming 68
Master Bypass switch 58, 65 Select mode (Channel Select switch) 35
m:ts;(resr (legk switch 57 Select Switch Latch mode 25

” Select/Focus switch 41

multichannel 49, 57, 63, 64 Select/Link/Bypass Mode switch (plug-ins) 57, 64
multi-mono 49, 57, 63, 64, 105 selecting
multiple plug-in windows 51 Scrub/Shuttle wheel 68

opening plug-in windows 50, 58, 65

selections
Output meters 59

] playback from transport controls 68
Page switch 58, 65 Send Level switch (automation) 40

Save AS_SWitCh 56, 63 Send Mute switch (automation) 40
Save switch 56, 63 Send Pan mode 35

Select/Link/Bypass Mode switch 57, 64 Send Pan switch (automation) 40

targeting 51 sends

Window switch 58, 65 assigning 95, 99
Post-Roll switch 70 Automation Safe 48
Pre-Fader Listen (Monitor section) 89 making inactive 96
Preferences (D-Command) 24, 116 muting 99

Bank Justification 24 ;
h setting pre- or post-fader 99
Custom Fader Hidden Tracks 25 Sends switches 35

Custom Fader Justification 25 Session Management switches 8, 74

Display 26 All Notes Off 74
Display Brightness 116 Clear Clip 74
Display Contrast 117 Publish 74
Encoders 26
Redo 74

Faders On/Off 24 Save 74
Footswitch settings 117 Undo 74
MaX|mur2n7Custom Fader Bank Size 25 sessions

eters [ opening 78
Select Switch Latch mode 25 Set To Default switch 42

?Iee;r)] '\\;lolde szettings 117 Set Up switch (Monitor section) 88
ouch Value 25 Show Values switch 40

Pre-Roll switch 70 Show/Hide switch 78
previewing automation 108, 109 Shuttle switch 69

Pro Tools Online switch 70
Publish switch 74
Punch Capture command 109

slave tracks 33

Sleep Mode settings 117
Snapshot switch 76
snapshots 109

Q Soft Keys 8, 75

QuickPunch switch 70 Automation controls 80
Console Preferences 79
Edit controls 77

R Management controls 76

Ratio/Range/Frequency control (Dynamics plug-ins) 54 solo

Read switch (automation) 44 focusing tracks 98

Record Enable switches 35 latching 36

Record Safe mode 35 output connections 121

Redo switch 74 Solo Clear switch 42

reference level preference (meters) 94 Solo Mode controls (Monitor section) 89

Release/Frequency control (Dynamics plug-ins) 54 After-Fader Listen 89

requirements Broadcast 89
connections 4, 19, 119 Pre-Fader Listen 89
operational 4 Solo Safe mode 36

resetting D-Command units (Utility mode) 116 Solo switches 36

rotary encoders 31 Solo/Mute switch (Monitor section) 88
automation mode indicator 32 Start switch (automation) 39
Bypass/Mute/Pre Switch mode 40 Stereo inputs (Monitor section) 86
display color 32 Sum mode (Monitor section) 86

Surround inputs (Monitor section) 86
Suspend Groups switch 42

Switch Info switch 40

System Info (Utility mode) 112
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T

talkback 87
connections 121
Dim function 90
External level control 90
Level control (built-in) 90
microphone (built-in) 93
Talkback switch 44, 90
Talkback/Listen controls 90
Auto Talkback switch 90
Listen 91
Mic Select switches 91
Talkback switch 90
targeting plug-ins 51
Test pages (Utility mode) 113
Threshold/Output control 55
time scale display 8, 93
Touch switch (automation) 44
Touch Value preference 25
Track Size switches 83
Track switch 76
TrackPunch switch 70
tracks
Automation Safe 48
focusing 36, 69, 97, 98
making inactive 96
nudging 69
selecting 35, 97
Tracks mode (Custom Fader) 43, 104
transport controls 8, 67
latching behavior 67
Transport Mode switches 70
9-pin Remote 70
Loop Playback 70
Pro Tools Online 70
QuickPunch 70
TrackPunch 70
Trim mode (Monitor section) 88
Trim switch (automation) 44

Trim switch (Scrub/Shuttle controls) 69

u

Undo switch 74
Unit Name (Utility mode) 112
User switch 79
Utility mode 111
Reset Unit 116
System Info 112
Test pages 113
Unit Name 112
Utility switch 83

\')

VCA Master tracks 31, 32, 33, 34, 104

view definitions 26, 105
Volume switch (automation) 40

w

Window Management switches 8, 73

Window switch (Custom Fader Plug-in mode) 43

Window switch (plug-ins) 58, 65
windows

moving 69

opening 73, 76
Write switch (automation) 44
Write to All (automation) 39
Write to All Enabled (automation) 39
Write to Current (automation) 39
Write to End (automation) 39
Write to Start (automation) 39

X

XMON 119
back panel overview 12
components 3
connections 9, 12, 19, 121
front panel overview 11

Z

Zoom Mode switch 72
Zoom Preset switches 72
Zoom/Navigate section
Arrow switches 72
Navigate Mode switch 72
Zoom Mode switch 72
Zoom Preset switches 72
zooming
Scrub/Shuttle wheel 68
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